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DESCRIPCIÓN GENERAL ____________________________________  
Bienvenido a la guía de software del procesador de sistema P4800 de Shure. El objetivo de este documento es 
ayudarle a comprender el funcionamiento del P4800 mientras aprende a utilizar la interface del software. El equipo 
físico funciona por sí solo como un procesador de sistema de punto inicial y de punto final que puede controlarse por 
medios externos mediante una interface sencilla de usuario, y el software es la herramienta que configura la 
distribución interna de señales del dispositivo y el procesamiento de la señal de audio. Está diseñado para sistemas 
de sonido pequeños y medianos que requieren el poder y flexibilidad que ofrece un procesador digital de señales, 
pero que también requieren una unidad sencilla de usar que el instalador pueda configurar fácilmente.  

Estructura de este documento 
Puede hallar que la interface del software es tan intuitiva y fácil de usar que se sentirá tentado a pasar por alto la 
lectura de la documentación y empezar a programar la unidad de inmediato. No obstante, antes de hacerlo, le 
recomendamos por lo menos leer la descripción general y leer a fondo la Guía para el uso inicial en la página 13. Las 
preguntas que tenga en cuanto al uso del software se responden en las secciones siguientes del documento. 

�� Descripción general.......................... Presenta las características principales del procesador del 
sistema, y describe los modos de funcionamiento de la interface y la ventana principal. 

�� Guía para el uso inicial ..................... Describe los pasos básicos que hay que llevar a cabo con el 
software para configurar el procesador de sistema para una instalación determinada. 

�� Cómo crear una configuración ........ Describe los elementos de la configuración del flujo de la señal 
en el procesador de sistema, tales como la estructura de ganancia del dispositivo, la conexión de la 
señal entre entradas y salidas, cómo añadir procesadores a la trayectoria de la señal y cómo trabajar 
con ellos desde la ventana principal. 

�� Cómo guardar una configuración ... Explica cómo guardar una configuración en la computadora, cómo 
definir configuraciones prefijadas en el P4800, y cómo hacer copias de respaldo del contenido del 
dispositivo en la computadora. 

�� Características del procesador........ Describe las características comunes entre muchos de los 
módulos del procesador de señales, tales como los controles de nivel, la captura de imágenes 
instantáneas de los ajustes de los parámetros y cómo guardar y recuperar valores de ajuste de la 
computadora. 

�� Procesadores fijos ............................ Explica las características de los procesadores de ganancia de 
entrada y de salida y la matriz mezcladora. 

�� Procesadores modulares ................. Explica las características que son específicas de cada uno de 
los procesadores modulares de señales. 

�� Pines de control ................................ Describe la arquitectura interna del control por dispositivo 
externo del procesador de sistema y explica cómo configurar los pines de control del P4800 con el 
software, una vez que se ha conectado el equipo físico externo. 

�� Seguridad........................................... Describe las características de seguridad del procesador de 
sistema que restringen el acceso a los parámetros de ajuste de dispositivos. 

Características del procesador de sistema 
El P4800 es un procesador digital de audio con 4 entradas y 8 salidas cuya interface de software reemplaza por 
completo a los controles de una consola. Proporciona conversión de 24 bits, muestreo a 48 kHz y un rango dinámico 
de 100 dB. El procesamiento digital de señales Soundplex asegura un alto rendimiento y la estabilidad del sistema. 
El dispositivo almacena desde 16 hasta 128 configuraciones prefijadas por el usuario, dependiendo del nivel de 
complejidad de las mismas. 

Interface de software con funciones de arrastrar y colocar 
La interface de computadora del procesador de sistema imita los diagramas en bloques funcionales 
utilizados para el diseño de sistemas de sonido. Esto hace que el software sea sumamente fácil de 
aprender, puesto que la interface se hace inmediatamente familiar a los profesionales del sonido. Las 
configuraciones de los sistemas pueden construirse y modificarse completamente con sólo hacer clic en un 
elemento, arrastrarlo y colocarlo en el lugar deseado, con el Mouse. El procesamiento digital de la señal es 
sumamente configurable, puesto que utiliza procesadores modulares de señales que pueden disponerse en 
cualquier orden que lo desee el usuario.  
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Procesadores modulares de señales 
Cada módulo procesador de señales se representa gráficamente por un bloque que puede manipularse con 
el Mouse. Se pueden acceder a los ajustes del procesador haciendo doble clic en el bloque que lo 
representa para abrir su ventana de parámetros. Los valores de ajuste pueden guardarse y recuperarse de 
la computadora, y pueden copiarse a otros módulos similares. Los ajustes de los procesadores también 
pueden sincronizarse usando la función de enlace. El P4800 incluye la selección siguiente de módulos 
procesadores de señales. 

• El poderoso reductor digital de realimentación Shure • Compuerta/expansor 

• Control automático de ganancia y de nivel • Compresor/limitador monofónico y estereofónico con 
opción de articulación suave 

• Ecualizadores gráficos de 10 y 30 bandas con y sin 
combinación 

• Filtros atenuadores y limitadores independientes con 
atenuación de 24 dB por octava 

• Ecualizadores paramétricos de 3 a 10 bandas con 
filtros atenuadores y limitadores • Atenuador automático 

• Redes de cruce y bifurcadores de señales de 2 a 5 
vías • Limitador de tope de picos 

Control por dispositivo externo 
Después de haber instalado el procesador de sistema y de haberlo programado con el software, es posible 
controlarlo no sólo con una computadora y MIDI, sino también por medio de una interface de equipo físico para el 
usuario. Los pines de control del panel trasero de la unidad pueden conectarse a equipos externos que permiten 
al P4800 responder al cierre de contactos, a potenciómetros y a interruptores. Los pines de salida pueden 
configurarse para indicar el estado de una configuración prefijada y silenciamiento por medio de LED, relés de 
control y otros equipos. 

Seguridad 
La función de seguridad le da al instalador la tranquilidad de saber que el dispositivo no puede ser alterado sin 
autorización, después de haberlo instalado. El acceso puede restringirse completamente, al grado de que el 
usuario no pueda cambiar ajustes, o ni siquiera cambiar entre configuraciones prefijadas. Sólo se podría 
desplegar el ajuste de los parámetros de la configuración prefijada seleccionada a través del software. El nivel de 
control del usuario también puede personalizarse para otorgarle acceso a ciertos ajustes, pero no a otros. 

Requisitos mínimos del software del P4800 
Para la instalación y funcionamiento correctos, el software Versión 3 del P4800 requiere una computadora 
con las especificaciones siguientes: 

�� Disco duro con 20 MB de espacio disponible 
�� Unidad lectora de CD-ROM 
�� Pantalla VGA con nivel de definición 640 x 480/256 colores, o superior 
�� Mouse u otro dispositivo de selección 

La velocidad del procesador y la memoria requerida varían según la versión de Windows en uso y el número 
de programas que se ejecuten simultáneamente. Si se usa el software del P4800 simultáneamente con otros 
programas tales como Smaart™ o TEF™, puede ser necesario usar un procesador más veloz y tener más 
RAM instalada para un rendimiento óptimo. La tabla siguiente indica los requisitos mínimos para ejecutar el 
software del P4800 sin tener otros programas en ejecución, incluso los de protección contra virus, barreras 
de software, programas de mensajería y de correo electrónico. 

 

Versión de Windows Velocidad del 
procesador 

RAM 

95, 95B y 98 Pentium 166 MHz 32 MB 

98 Second Edition Pentium 166 MHz 48 MB 

NT Pentium 233 MHz 64 MB 

ME Pentium 300 MHz 64 MB 

2000 Professional Pentium 300 MHz 96 MB 

XP Professional, Home Pentium 300MHz 128 MB 
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Modos de interface 
La interface tiene dos modos principales de funcionamiento: Modo de diseño y modo en vivo. Esto le brinda la alternativa 
de crear configuraciones para el procesador de sistema, sin importar si la computadora está conectada al dispositivo o no 
lo está. Hay ciertas funciones que son específicas de cada modo, las cuales se explican en este manual. 

Modo de diseño 
Cuando se arranca el programa, siempre inicia en modo de diseño. Este es el modo que se utiliza para crear 
configuraciones prefijadas que luego se almacenan en el procesador de sistema.  En este modo no es 
necesario que la computadora esté conectada al dispositivo. Es posible guardar las configuraciones de flujo 
de señales creadas en archivos de escena en la computadora, los cuales posteriormente pueden 
recuperarse y enviarse al dispositivo a través de la conexión tipo RS-232. Esto le da la capacidad de diseñar 
configuraciones prefijadas en un lugar diferente de aquél en donde se ha instalado el equipo. Los archivos 
de escenas son análogos a las configuraciones prefijadas en todo sentido, salvo que se guardan en la 
computadora en lugar de guardarse en el dispositivo.  

Modo en vivo 
Este modo le permite hacer ajustes en tiempo real a las configuraciones prefijadas del equipo físico, 
mientras la computadora está conectada al procesador de sistema. Esto le permite escuchar 
instantáneamente los cambios hechos al procesamiento de la señal luego de haber modificado los ajustes, 
lo cual facilita el ajuste final de las configuraciones prefijadas en el sitio. Todo lo que se hace en el modo en 
vivo se escribe directamente en la configuración prefijada seleccionada en la actualidad. 

Modo de presentación preliminar 
Cuando se trabaja en el modo en vivo con un dispositivo que contiene varias configuraciones prefijadas, 
éstas pueden recuperarse de modo individual para modificarlas en tiempo real. Cuando se selecciona una 
configuración prefijada para cargarla en un diagrama de flujo de señal, la ventana pasa a modo de 
presentación preliminar para darle la oportunidad de verificar su selección antes de designarla como la 
siguiente configuración prefijada para uso en vivo. La interface retorna a modo en vivo cuando se carga la 
configuración prefijada, o si se anula la operación. 



Descripción general 

Guía de software de procesador de sistema SHURE P4800 Página 9 de 112 

La ventana principal 
Esta sección le familiarizará con los elementos de la ventana principal, y presentará parte de la terminología utilizada en el 
software. Esta ventana brinda el espacio principal de trabajo de la interface de software. Se puede modificar su tamaño, o 
ampliarla al máximo para que ocupe toda la pantalla. Si se cierra esta ventana, se sale del programa. 

1. Barra de títulos 
La información que aparece en la barra de títulos de esta ventana cambia según el modo de 
funcionamiento. En el modo de diseño, la barra de títulos indica: “P4800: Offline”, e indica el nivel de 
seguridad por omisión. En el modo en vivo, despliega información correspondiente a la unidad 
específica a la cual está conectado el sistema. 
 
 
 
 
 
 
 
 
El número de identificación del dispositivo se fija por medio de los interruptores DIP que están en la parte 
posterior de cada dispositivo; tanto el nombre de cada dispositivo como su nivel de seguridad se fijan a 
través del menú [Device] cuando el sistema está en modo en vivo. 

2. Menú principal 
Algunas funciones del menú corresponden a un modo específico, y en algunos casos quedan 
inaccesibles, según el modo en el cual se esté trabajando. También se pueden desplegar menús por 
contexto si se pulsa el botón derecho del Mouse cuando el cursor está colocado en el diagrama de flujo 
de la señal (número once más abajo). 

Figura 1 − Ventana principal

Fiígura 2 −Barra de títulos en modo vivo

No. de
identificación

del dispositivo
Nivel de  
seguridad 

Nombre del  
dispositivo 
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3. Barra de control 
Esta sección de la ventana cambia de apariencia y de función, según el modo de funcionamiento. 
Cuando se está en modo en vivo, la barra de control simula el funcionamiento de los medidores LED 
que están en el panel delantero del equipo físico. 

Los medidores pueden desplegarse y ocultarse haciendo clic sobre ellos con el botón izquierdo del 
Mouse, o seleccionando [View  > Enable I/O Meters] del menú principal. 

En el modo de presentación preliminar, la barra de control le brinda la opción de cargar la configuración 
prefijada que se ha seleccionado, o de anular la operación y retornar a la configuración prefijada anterior. 

4. Botón de modo en vivo 
Haga clic en este botón para cambiar al modo en vivo, el cual le permite ver una presentación preliminar 
y editar cualquiera de las configuraciones prefijadas guardadas en el dispositivo en la actualidad. La 
computadora deberá estar conectada al P4800 para poder entrar a este modo. 

5. Botón de modo de diseño 
Haga clic en este botón para cambiar al modo de diseño. La configuración prefijada con la cual se 
estaba trabajando en el modo en vivo permanece cargada en el diagrama de flujo de la señal, lo cual le 
permite usar la configuración prefijada actual como una plantilla básica, pudiéndose crear varias 
configuraciones prefijadas guardándolas por separado en el dispositivo. 

6. Cuadro de información 
Visualiza detalles acerca de la configuración prefijada o del archivo de escena que está cargado en la 
actualidad en la pantalla, incluyendo el nombre, la última fecha en la cual se guardó y su descripción. En 
el modo en vivo, aparece un menú en el campo del nombre, el cual ofrece una lista de todas las 
configuraciones prefijadas almacenadas en el dispositivo (vea la Figura 3, arriba). 

7. Guardar configuración prefijada 
Este botón aparece únicamente en el modo de diseño. Púlselo para guardar el ajuste del diagrama de 
flujo de señal actual como una configuración prefijada del equipo físico en el procesador de sistema. 

8. Recuperar configuración prefijada 
Este botón aparece únicamente en el modo de diseño. Púlselo para cargar una configuración prefijada 
guardada en el procesador del sistema en el diagrama de flujo de señales.  

9. Guardar como 
Pulse este botón para guardar la configuración y valores de ajuste del flujo de señales actuales en un 
archivo de escena. 

10. Abrir 
Este botón aparece únicamente en el modo de diseño. Púlselo para cargar el contenido de un archivo de 
escena en el diagrama de flujo de señales. 

Figura 3 −Barra de control en modo vivo

Figura 4 − Barra de control en modo de presentación  preliminar 
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11. Diagrama de flujo de señales 
El diagrama de flujo de señales representa cómo las señales de audio pasan a través de los diversos 
procesadores del equipo. Muestra el flujo de la señal de audio, avanzando de izquierda a derecha, a lo 
largo de los canales de entrada y de salida. Cada canal contiene componentes fijos que permiten 
ajustar la ganancia y la mezcla de canales. También contienen una serie de espacios vacíos que 
permiten añadir diferentes tipos de procesamiento. 

12. Fila de canal de entrada 
Las filas de canal de entrada corresponden a los cuatro canales de entrada del procesador de sistema. 
Cada fila acepta hasta cinco procesadores de señales diferentes. 

13. Rótulo de canal de entrada 
Aquí se despliega el rótulo dado al canal en la ventana de ganancia de entrada. 

14. Ganancia de entrada 
Esta es la etapa inicial de la estructura de ganancia del procesador del sistema. Si se hace doble clic en 
este bloque, se abre la ventana de ganancia de entrada, en la cual se brindan las alternativas de 
escalas de –10 dBV/+4 dBu, silenciamiento de canal, control de polaridad, y un control de nivel de ±30 
dB para cada canal de entrada. Aquí también se designa el nombre de cada canal de entrada. 

15. Indicador de modo 
Despliega el modo actual de funcionamiento del diagrama de flujo de señales, como se ilustra a 
continuación. 

Modo de diseño Modo en vivo Modo de presentación 
preliminar 

 

16. Selector de entrada 
Haga clic en estos selectores numerados de entrada, en el punto de mezcla de cada fila de salida, para 
conectarla automáticamente con el punto de mezcla del canal de entrada correspondiente. 

17. Matriz mezcladora 
Esta es la etapa intermedia de la estructura de ganancia del procesador del sistema. Cuando se hace doble 
clic en este bloque, se abre la ventana de la matriz mezcladora, la cual permite encaminar la señal de una fila 
de canal de entrada a cualquier fila de canal de salida, y ajustar los niveles relativos con los controles de 
nivel. Esta ventana tiene una ficha por cada fila de canal de salida que contiene controles de ganancia, 
polaridad y silenciamiento para cada canal de entrada conectado a su punto de mezcla. 

18. Números de canal 
Estos números corresponden a cada uno de los cuatro canales de entrada y ocho de salida del P4800. 

19. Puntos de mezcla 
Haga clic en estos puntos para encaminar la señal entre las filas de entrada y de salida. Se despliegan 
líneas entre los puntos conectados entre sí, las cuales representan el flujo de la señal. Cada fila de 
entrada puede estar conectada a un número arbitrario de filas de salida, o a todas. 

20. Espacios para procesador 
Estos espacios sirven como recipientes para los módulos procesadores. Pueden ocuparse ya sea 
usando el método de arrastre y colocación desde la caja de herramientas de procesadores, con la 
función [Add Processor] del menú principal, o con el menú contextual que se despliega si se hace clic 
con el botón derecho del Mouse. 
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21. Ganancia de salida 
Esta es la etapa final de la estructura de ganancia del procesador del sistema. Si se hace doble clic en 
este bloque, se abre la ventana de ganancia de salida, en la cual se brindan las alternativas de escalas de 
–10 dBV/+4 dBu, silenciamiento de canal, control de polaridad, un atenuador de –20 dB y un control de 
nivel de ±30 dB para cada canal de salida. En este lugar también se puede designar un nombre a cada 
canal de salida que corresponda con la configuración particular del mismo.    

22. Rótulo de canal de salida 
Visualiza el rótulo del canal que se designó en la ventana de ganancia de salida. 

23. Fila de salida 
Las filas de canal de salida corresponden a los ocho canales de salida del procesador de sistema. Cada 
fila acepta hasta seis procesadores de señales diferentes. 

24. Silenciar todas las entradas 
Haga clic en este control para silenciar automáticamente todos los canales de entrada. 

25. Silenciar todas las salidas 
Haga clic en este control para silenciar automáticamente todos los canales de salida. 

26. Medidor de utilización de DSP 
Indica el porcentaje de los recursos digitales de procesamiento de señal del P4800 que se encuentran 
en uso por la configuración actual de bloques procesadores colocados en el diagrama de flujo de 
señales. El medidor despliega una barra verde que se agranda según aumenta la utilización. 

27. Medidor de memoria de retardo 
Indica el porcentaje de memoria de retardo utilizado por los procesadores de retardo colocados en el 
diagrama de flujo de señales. El medidor despliega una barra azul que se agranda según aumenta la 
utilización. 

La caja de herramientas de procesadores 
La caja de herramientas de procesadores aparece junto a la ventana principal cuando el programa arranca. Esta 
ventana despliega la biblioteca de módulos procesadores que pueden arrastrarse y colocarse en los espacios vacíos 
del diagrama de flujo de señales. Su tamaño vertical puede ajustarse arrastrando el borde inferior hacia arriba o hacia 
abajo. Una barra de desplazamiento aparece en el lado derecho, la cual le permite acceder a todos los bloques 
procesadores, sin importar la altura de la ventana. 

Mostrar y ocultar 
La caja de herramientas de procesadores aparece delante de las demás ventanas abiertas del programa, a 
menos que se la cierre haciendo clic en la caja de control, en la esquina derecha de su barra de título. Para que 
aparezca nuevamente, seleccione [View > Show Processor Toolbox] del menú principal. Aparece una marca de 
verificación junto a esta función del menú cuando la ventana está visible; si se la 
selecciona cuando la caja de herramientas de procesadores está abierta, la ventana se 
cierra.  

Botones de menús desplegables 
Un botón de menú desplegable aparece sobre cada categoría 
de procesadores en la caja de herramientas de procesadores. 
Haga clic en un botón para ocultar o desplegar todos los 
bloques procesadores de la categoría correspondiente. 

Bloques procesadores 
Los bloques procesadores son representaciones gráficas de los 
módulos procesadores. Después de haberlos colocados en el diagrama de flujo de 
señales, se puede acceder a los ajustes haciendo doble clic en cada bloque para abrir su 

ventana de parámetros. 
 

Botón de menú 
desplegable  

Bloques 
procesadores

Figura 5 − Caja de herramintas de 
procesador 
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GUÍA PARA EL USO INICIAL__________________________________  
La guía para el uso inicial describe los pasos básicos requeridos para la configuración completa del procesador del 
sistema. Antes de intentar seguir estas instrucciones, familiarícese con la sección Descripción general, la cual 
presenta algunas funciones básicas de la interface de software. 

Muchos de estos pasos pueden llevarse a cabo sin tener la computadora conectada al dispositivo, guardando sus 
configuraciones en la computadora y transfiriéndolas posteriormente al equipo físico. Para familiarizarse completamente 
con las funciones del procesador de sistema, estas instrucciones se han redactado suponiendo que se satisfacen las 
condiciones siguientes: 

�� Se está trabajando con la computadora conectada al dispositivo. 
�� La instalación incluye el control por dispositivos externos. 
�� Se requiere seguridad para los dispositivos. 

Estas instrucciones incluyen pasos que pueden no corresponder a su instalación particular. No obstante, sugerimos 
que lea toda la Guía para el uso inicial con el fin de familiarizarse con el proceso recomendado de configuración del 
dispositivo, para referencia futura. 

Instalación del software 
Si no se ha instalado el software previamente, siga estas instrucciones para instalar el programa 
contenido en el disco de CD-ROM. 

Para instalar el software del disco de CD-ROM: 
1. Inserte el CD-ROM en la unidad lectora correspondiente de la computadora. 
2. El programa de instalación arranca automáticamente. Siga las indicaciones dadas en la pantalla. 

 — Si el programa de instalación no se inicia automáticamente — 

1. Haga clic en el botón [Inicio] de la barra de tareas de Windows, y seleccione [Ejecutar...] del menú 
que aparece. 

2. Escriba “D:\setup” (en donde D es la letra que identifica a la unidad lectora de CD-ROM). 
3. Haga clic en [Aceptar] y siga las instrucciones dadas por el programa de instalación. 

Si ha descargado una copia del software, ubique el archivo con extensión “.exe” usando el 
Explorador de Windows, y ábralo. Siga las instrucciones dadas por el programa de instalación. 

Establecimiento de comunicaciones 
Este es el procedimiento que debe usarse cuando se conecta la computadora inicialmente al dispositivo. 
Es su primera oportunidad para verificar que la computadora se comunica correctamente con el P4800. 
Para más información en cuanto a la conexión de su computadora con el dispositivo y la designación del 
número de identificación del dispositivo, vea la sección Conexiones de la computadora, en la guía de 
instalación del equipo. 

1. Conecte la computadora al procesador de sistema 
Conecte el puerto COM de su computadora al puerto serial RS-232 que se encuentra en el panel 
delantero o trasero del P4800.  

2. Inicie el programa de software 

3. Seleccione el puerto COM 
a) Seleccione [Devices>Select COM Port] del menú principal 
b) Se despliega el cuadro de diálogo de selección de puerto COM. 
c) Seleccione el puerto COM al cual se ha conectado el cable 

RS-232 y haga clic en [OK]. 

Figura 6 – Cuadro de Diálogo de 
Selección de Puerto COM 
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4. Inicie el modo en vivo del procesador de sistema 
a) Haga clic en el botón [Live Mode] de la barra de control de la 

ventana principal. 

b) El cuadro de diálogo de selección de dispositivos aparece, e 
indica todos los dispositivos disponibles. El número de 
identificación indicado en el lado izquierdo de la lista se fija 
por medio de los interruptores DIP en la parte trasera del 
dispositivo.  

c) Seleccione el procesador de sistema con el cual se estará 
trabajando, y haga clic en [Connect]. 

d) El software pasa a modo en vivo, lo cual se indica por el color 
azul en el diagrama de flujo de señales y en los medidores de 
señales desplegados en la barra de control. 

5. Designe el nombre del dispositivo 
a) Seleccione [Devices>Name Device] del menú principal. 

b) Se visualiza el cuadro de diálogo de designación de dispositivos. 

c) Escriba un nombre para el dispositivo, de hasta quince 
caracteres de largo, y haga clic en [Name]. 

d) El nombre del dispositivo aparece en la barra de títulos de la 
ventana principal cuando se está en modo en vivo, y se indica 
en el menú [Devices]. 

Configure los controles externos 
Si hay dispositivos externos de control conectados a los pines de control, es necesario configurar el 
dispositivo para que los reconozca. Esta configuración se almacena a nivel del dispositivo y debe definirse 
antes de crear configuraciones prefijadas. Si no está conectado al dispositivo, se puede crear una 
configuración y guardarla en la computadora para transferirla posteriormente al P4800 por medio de la 
conexión RS-232. Consulte la sección Pines de control en la página 81 para instrucciones completas. 

1. Entre al modo de diseño 
Es necesario estar en el modo de diseño para configurar los controles externos. Si está en modo en 
vivo, haga clic en el botón [Design Mode] de la barra de control de la ventana principal. 

2. Configure los pines de control 
Seleccione [Devices>Control Pin Configuration] del menú principal, lo cual abre la ventana de pines de 
control. Empiece seleccionando el número de configuraciones prefijadas entre las cuales se cambiará y 
el tipo de cifrado que el dispositivo utilizará para los números predefinidos; después especifique las 
demás conexiones de los controles. 

3. Guarde la configuración en el dispositivo o en la computadora 
Seleccione la función [Configuration>Store to Device] o [Configuration>Save to PC] del menú.  

Nota: Si es necesario cambiar la configuración prefijada seleccionada en la computadora 
después de haber configurado las conexiones de entradas de control, será necesario 
desactivar las conexiones de la ventana de pines de control antes de proseguir. 

Figura 8 − Cuadro de Diálogo 
de Designación de Dispositivo 

Figura 7 − Cuadro de Diálogo de 
Selección de Dispositivo  
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Confeccione una plantilla de flujo de señales 
Esto puede hacerse en modo en vivo o en modo de diseño. Cuando se guardan varias configuraciones prefijadas 
en el procesador de sistema, se ahorra mucho tiempo si se confecciona una plantilla de flujo de señales que 
contiene las características comunes de las mismas. Esta plantilla entonces puede recuperarse del dispositivo, o 
abrirse desde un archivo de escena en la computadora, modificarse según sea necesario, y guardarse en el 
dispositivo como una configuración prefijada nueva. 

1. Designe los canales de entrada y salida 
Haga doble clic en los bloques de entrada y de salida para abrir las ventanas de parámetros del 
procesador, y edite los rótulos de canales que aparecen debajo de los controles de ganancia. Para más 
información, consulte la sección Rotulación de entradas y salidas en la página 18. 

2. Llene el diagrama de flujo de señales 
Arrastre y coloque bloques procesadores de señales de la caja de herramientas de procesadores en el 
diagrama de flujo de señales. Si está usando redes de cruce, éstos deberán ser el primer tipo de 
procesador que se coloque en la configuración, seguidos de limitadores, para evitar dañar los altavoces. 
Para más información, consulte la sección Adición de procesadores en la página 21. 

3. Forme los grupos de enlace 
Pulse la tecla CTRL y haga clic para seleccionar varios procesadores del mismo tipo con el fin de 
controlarlos como un solo grupo, por ejemplo, para pares de canales estereofónicos, grupos de 
altavoces, zonas, etc. También se pueden enlazar bloques de ganancia para controlar el nivel total del 
sistema. Para más información, consulte la sección Enlace en la página 25. 

4. Ajuste los niveles de salida 
Haga doble clic en los bloques de ganancia de salida para abrir la ventana de ganancia de salida. 
Reduzca la ganancia de salida de cada canal por –30 dB para evitar que una señal intensa pase por el 
sistema. Si los canales de salida están enlazados entre sí, sólo es necesario ajustar un control de nivel 
para regular todos los canales enlazados a un mismo nivel. 

5. Encamine las señales de los canales de entrada a los de salida 
Haga clic en los puntos de conexión de las filas de entrada y arrástrelos hasta los puntos de conexión de las 
filas de salida para encaminar la señal a través de la matriz mezcladora. Para más información, consulte la 
sección Encaminamiento de señales en la página 18. 

6. Ajuste los parámetros del procesador 
Haga doble clic en cada uno de los bloques procesadores para abrir su ventana de parámetros. Si se 
trabaja desconectado de la unidad, en modo de diseño, se pueden fijar niveles preliminares para luego 
ajustarlos cuando se tiene el dispositivo conectado. Para más información en cuanto a cómo trabajar 
con los procesadores, consulte Características del procesador en la página 32, al igual que la sección 
de referencia de cada procesador. 

7. Asigne procesadores a las conexiones de los controles 
Cada configuración prefijada deberá contener una leyenda de las conexiones de pines de control para 
que el equipo físico pueda reconocer los dispositivos externos cuando la configuración prefijada ha 
sido activada. Abra la ventana de pines de control y seleccione las casillas junto a los canales de 
entrada y de salida que cada conexión de control regulará. Para más información, consulte la sección 
Pines de control en la página 81. 

8. Enclave los procesadores para acceso de sólo lectura 
Este paso se usa sólo cuando se está personalizando el nivel de seguridad para el usuario. Este tipo de 
seguridad se guarda con cada procesador, al nivel predefinido. Seleccione los procesadores que el 
usuario no deberá poder modificar, y seleccione [Security>Level 2>Lock Selected] del menú principal. 
Para una explicación completa y más instrucciones, consulte la sección Seguridad de procesadores 
individuales en la página 92. 
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9. Designe el nombre de la configuración prefijada 
Haga clic una vez con el botón izquierdo del Mouse en cualquier 
punto del cuadro de información, en la parte central de la barra de 
control, para abrir el cuadro de diálogo de información de la 
configuración prefijada. Escriba el nombre de la configuración 
prefijada, de hasta 15 caracteres de largo, y una descripción, y 
luego haga clic en [OK]. Para más información, consulte la sección 
Designación de una configuración prefijada o archivo de escena en 
la página 20. 

10. Guarde la configuración prefijada en el dispositivo 
Si se está trabajando en el modo en vivo, la configuración prefijada 
ya ha sido guardada en el dispositivo. Si está trabajando en modo de diseño, haga clic en el botón 
[Store Preset] de la barra de control de la ventana principal. Para más información, consulte la sección 
Administración de configuraciones prefijadas en la página 29. Para crear un duplicado de esta 
configuración prefijada, es necesario estar en modo de diseño. Sencillamente continúe haciendo clic en 
el botón [Store Preset] para crear y guardar tantos duplicados de la configuración prefijada como se 
requieran en el dispositivo. 

11. Active el control externo 
Una vez que se ha terminado de crear y editar las configuraciones prefijadas, si previamente se habían 
desactivado las conexiones de control para controlar el procesador de sistema desde la computadora, 
abra la ventana de pines de control y actívelas. 

Establezca los controles de seguridad 
Este es el paso final de la configuración del dispositivo. Antes de continuar, lea detenidamente la sección 
Seguridad en la página 90. Estas instrucciones tienen el propósito de dar una descripción general del proceso. 

1. Inicie el modo en vivo del procesador de sistema. 
Es necesario activar el modo en vivo para fijar los controles de seguridad del dispositivo. Si está en 
modo de diseño, haga clic en el botón [Live Mode] de la barra de control de la ventana principal. 

2. Fije una contraseña 
Seleccione [Security>Set Password] del menú principal, lo cual abre el cuadro de diálogo de creación de 
contraseña. Escriba una contraseña, pulse TAB, y vuelva a escribir la contraseña para confirmarla. Haga 
clic en [OK]. 

3. Fije el nivel de acceso del usuario 
Seleccione [Security>Set Level] del menú principal, lo cual abre el cuadro de diálogo de fijación de nivel 
de seguridad. Seleccione el nivel de acceso que se desea otorgar al usuario. Haga clic en [OK]. 

Figura 9 − Cuadro de diálogo de 
información de configuraciones prefijadas
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CÓMO CREAR UNA CONFIGURACIÓN _________________________  
Una configuración es una combinación individual de conexiones de señales, junto con la selección y colocación de 
procesadores modulares y la fijación de sus parámetros de ajuste. La configuración se crea usando el diagrama de 
flujo de señales de la ventana principal, y se guarda ya sea como una configuración prefijada en el dispositivo, como 
un archivo de escena en la computadora, o ambos. El procesador de sistema inicialmente viene cargado 
sencillamente con una configuración prefijada en blanco, lo cual significa que no se han hecho conexiones de 
encaminamiento de las señales, ni se hace procesamiento alguno de las señales. 

Configuración del flujo de señales 
Para que las señales de audio puedan pasar por el dispositivo, es necesario encaminar la señal desde las entradas 
hasta las salidas, por medio de la conexión de los puntos de mezcla. En esta sección se explican los fundamentos 
del diseño del flujo de señales usando la interface del usuario del procesador de sistema. 

Estructura de ganancia 
El procesador de sistema ofrece controles de ganancia en tres etapas del flujo de la señal: ganancia de 
entrada, matriz mezcladora y ganancia de salida. Es imprescindible comprender esta estructura de ganancia 
antes de hacer pasar señales de audio por la unidad, para evitar dañar el equipo conectado posteriormente 
al procesador de sistema, debido a niveles excesivos de ganancia. La ilustración siguiente brinda una vista 
general de la estructura de ganancia del P4800. 

Ganancia de entrada  
Si se hace doble clic en uno de los bloques de ganancia de entrada, se abre la ventana de ganancia de 
entrada, la cual despliega los controles para los cuatro canales. Actúa como un amplificador de 
preprocesamiento y ofrece controles de cambio de escala, ganancia y polaridad para canal, y le permite 
designar las filas de canales de entrada con nombres personalizados.  

Nota: Si los niveles de la señal de entrada exceden el umbral de limitación del procesador de 
sistema, será necesario ajustarlos con medios externos para evitar la distorsión por 
limitación en los convertidores A/D.  

Este es el punto de entrada de una señal al diagrama de flujo de señales. Después del procesador de 
ganancia de entrada, la señal pasa en orden por los espacios para procesador de la fila de canal de entrada. 
Al final de la fila de canal, la señal llega a un punto de mezcla, desde donde puede encaminarse a un 
número arbitrario de salidas, o a todas las salidas, por medio de la matriz mezcladora.  

Matriz mezcladora 
Una vez que la señal ha sido encaminada al punto de mezcla de un canal de salida, entra a la etapa de 
matriz mezcladora de la estructura de ganancia. Si se hace doble clic en cualquiera de los bloques de 
mezcla se abre la ventana del procesador de la matriz mezcladora, la cual muestra una sección por cada 
canal de salida. Cuando se colocan redes de cruce sobre varios canales de salida, las secciones de esos 

Figura 10 − Estructura de ganancia 

Ajuste la ganancia de la señal 
despues de haberla convertido a  
representacion digital y antes de 
que sea procesada por la fila del 
canal de entrada. 

Encamina la señal de la 
entrada a la salida, y ajusta 
su ganancia antes de que 
sea procesada por el canal 
de salida. 

Ajuste final de ganancia de 
la señal digital procesada 
antes de convertirla a 
representacion analogica en 
la salida del dispositivo. 

Conexión para encaminamiento  de señales 

1. Ganancia de entrada 2. Matriz mezcladora 3. Ganancia de salida 
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canales se combinan entre sí para reflejar dicha configuración. Usar esta ventana para ajustar la polaridad y 
niveles relativos de todas las señales de entrada encaminadas hacia el canal de salida deseado. 

Después de la matriz mezcladora, la señal pasa en orden por los espacios para procesador de la fila del 
canal de salida elegido. Al final de la fila del canal, la señal llega al bloque de ganancia de salida. 

Ganancia de salida 
Esta es la etapa final de controles de ganancia del procesador de sistema. Haga doble clic en cualquiera de 
los bloques de ganancia de salida para abrir la ventana de ganancia de salida. Actúa como un amplificador 
de posprocesamiento que ofrece controles de cambio de escala, ganancia, polaridad y un atenuador opcional 
de 20 dB para cada canal. Esta ventana también le permite designar a cada fila de canal de salida con un 
nombre personalizado. Después del procesador de ganancia de salida, la señal pasa por el convertidor de D/A 
y es enviada a la salida de audio. 

Silenciamiento de canales 
Hay varias formas de silenciar los canales de entrada y de salida del procesador de sistema. Los canales 
silenciados se identifican en el diagrama de flujo de señales, de la forma indicada en la tabla siguiente. 

Bloque de ganancia Entradas 3 y 4 a 
matriz mezcladora 

Salida de la matriz 
mezcladora 

Canales de salida 
de redes de cruce 

    

Silenciamiento de todos los canales de entrada o salida 
�� Haga clic en los controles de silenciar todas las entradas o de silenciar todas las salidas, 

ubicados en la parte inferior de la ventana principal. 
�� Seleccione las funciones [Processor>Mute All Inputs] o [Processor>Mute All Outputs] 

del menú. 
�� Apague el dispositivo para silenciar automáticamente todas las salidas. 

Silenciamiento de canales individuales 
1. Abra la ventana de ganancia de entrada, matriz mezcladora, o ganancia de salida haciendo doble clic 

en el bloque correspondiente de ganancia o de mezcla. 
2. Haga clic en el botón de silenciamiento del canal deseado. 
3. El bloque se identifica por medio de una “M” roja para indicar que está silenciado. 

Rotulación de entradas y salidas 
Los canales de entrada y salida no tienen rótulo cuando se crea un archivo de escena nuevo, pero los rótulos 
pueden cambiarse fácilmente usando las ventanas de ganancia de entrada y/o ganancia de salida. Los rótulos de 
canales se guardan junto con la configuración prefijada o el archivo de escena, de modo que se pueden crear 
rótulos especializados para las entradas y salidas de todas las configuraciones del sistema. 

Para cambiar el rótulo de un canal: 
1. Haga doble clic en el bloque de ganancia del canal. 
2. En la ventana del procesador, ubique el cuadro de rótulo del canal. 
3. Haga clic y arrastre el Mouse sobre el texto para seleccionarlo. 
4. Escriba un rótulo nuevo de no más de quince caracteres. 
5. Aplique las modificaciones hechas haciendo clic sobre otro control o cerrando la ventana. 

Encaminamiento de señales 
El procesador de sistema le permite encaminar una señal de cualquiera de los cuatro canales de entrada a 
varios, o a los ocho canales de salida. Para que la señal pase de las filas de los canales de entrada a las 
filas de los canales de salida, es necesario encaminarla a través de la matriz mezcladora. Los canales de 
entrada pueden conectarse a los de salida usando cualquiera de los métodos descritos a continuación. 
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Establecimiento de conexiones en el diagrama de flujo de señales 
Para un sistema con configuraciones sencillas, la forma más fácil de conectar los canales de entrada a los 
de salida es utilizar el Mouse en el diagrama de flujo de señales. 

Haga clic en los puntos de mezcla 
1. Haga clic en un punto de mezcla de entrada. 
2. El cursor cambia de forma para indicar que se encuentra en espera de que designe una conexión de 

salida. 
3. Haga clic en un punto de mezcla de salida. 

Sugerencia Se puede usar la tecla ESC para interrumpir la función de conexión si cambia de 
parecer después de haber hecho clic en un punto de entrada de mezcla, pero 
antes de hacer clic en el punto de salida de mezcla. 

Haga clic y arrastre el Mouse entre puntos de mezcla 
1. Haga clic en un punto de mezcla de entrada y arrastre el Mouse hasta un punto de salida de mezcla.  
2. Se dibuja una línea de conexión a lo largo de la trayectoria de la señal. Se torna verde cuando la 

conexión es válida. 
3. Suelte el botón del Mouse para establecer la conexión. 

Haga clic en los selectores de entrada 
1. Haga clic en el selector de entrada de un canal de salida cuyo número corresponda al canal de entrada 

deseado. 
2. Se dibuja una línea de conexión en el diagrama de flujo de señales, entre los puntos de mezcla, y el 

selector numerado de entrada se muestra resaltado.  

Establecimiento de conexiones en la ventana de la matriz mezcladora 
Para configuraciones más complejas con muchas líneas de conexión que se entrecruzan entre sí, la 
ventana de la matriz mezcladora proporciona un método más preciso para conectar los canales de 
entrada a los de salida. 
1. Haga doble clic en el bloque mezclador del canal de salida que se desea conectar. 
2. En el lado izquierdo de la ventana de la matriz mezcladora, haga clic en el botón de entrada de cada 

conexión de canal de entrada. 
3. Se dibuja una línea de conexión en el diagrama de flujo de señales, entre los puntos de mezcla, y el 

selector numerado de entrada de cada conexión activa se muestra resaltado.  

Eliminación de conexiones 
�� Haga clic en una línea de conexión y pulse la tecla SUPR.  
�� Haga clic en el selector de entrada que corresponde a la conexión deseada. Esto desactiva la 

conexión. 
�� Haga clic en una línea de conexión con el botón derecho del Mouse para desplegar el menú 

contextual. 
�� Se pueden seleccionar varias conexiones si se mantiene pulsada la tecla CTRL mientras se 

hace clic en las mismas. 
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Designación de una configuración prefijada o archivo de escena 
Puesto que es posible guardar hasta 128 configuraciones diferentes en el procesador de sistema, es útil 
distinguirlas por medio de un nombre y una descripción breve. El cuadro de información que aparece en el 
centro de la barra de control de la ventana principal despliega estos detalles. 

El nombre que se introduce aquí se convierte en el nombre de la configuración prefijada al guardarla en el 
dispositivo, y en el nombre del archivo de escena al guardarlo en la computadora. La descripción también se 
despliega en todos los cuadros de diálogo que presentan listas de configuraciones prefijadas o archivos de 
escena. Esta información puede modificarse en cualquier momento, ya sea en modo en vivo o en modo de 
diseño. 

Para designar una configuración prefijada o archivo de escena: 
1. Haga clic una vez con el botón izquierdo del Mouse en cualquier 

punto del cuadro de información. 
2. El cuadro de diálogo de información aparece.  
3. Escriba un nombre con un máximo de 15 caracteres, y una 

descripción con un máximo de 80 caracteres. 
4. Haga clic en [OK]. 
5. El cuadro de información se actualiza para reflejar los cambios 

hechos. 

Configuración de procesadores 
Hay dos niveles de trabajo con los procesadores: al nivel de configuración, en el diagrama de flujo de señales, y a 
través de la ventana de parámetros de cada procesador individual, al cual se accede haciendo doble clic en el 
bloque procesador.  En esta sección se describe el manejo de los procesadores en el diagrama de flujo de señales y 
se explican las diferencias entres las dos categorías principales de procesador. 

Tipos de procesador 
Se utilizan dos tipos principales de procesador en el diagrama de flujo de señales: fijos y modulares. La diferencia 
principal entre ellos es que los procesadores fijos forman parte de la estructura de ganancia del P4800, y por lo 
tanto forman parte de todas las configuraciones de flujo de señales. Los procesadores modulares son bloques 
procesadores que se seleccionan y se colocan en la forma que se desee, según los requisitos del sistema 
particular. 

Procesadores fijos 
Los bloques de ganancia y de mezcla se denominan procesadores fijos porque sus posiciones en las filas 
de canal son permanentes. No es posible eliminarlos, moverlos, copiarlos ni pegarlos. Sin embargo, es 
posible enlazarlos, y sus parámetros de ajuste pueden guardarse y recuperarse. 

Procesadores modulares 
Los bloques procesadores se denominan modulares porque pueden colocarse en cualquier espacio vacío 
(salvo las redes de cruce y bifurcadores), y pueden desplazarse, copiarse, pegarse y eliminarse sin 
restricciones. Cada bloque procesador del diagrama de flujo de señales funciona de modo completamente 
autónomo. Cuando se abre la ventana de parámetros de un procesador modular, se cambian los parámetros 
de ajuste de ese procesador solamente, salvo en las condiciones siguientes: 

�� Forma parte de un par estereofónico. 
�� Ha sido asignado a un grupo enlazado. 

Figura 11 − Cuadro de información 

Cuadro de información 

Figura 12 − Cuadro de diálogo de 
información de escenas 
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Adición de procesadores 
Cada canal tiene una fila de espacios vacíos que pueden contener cualesquiera de los bloques 
procesadores modulares. Salvo en el caso de las redes de cruce y bifurcadores, no existen restricciones en 
cuanto a la posición en la cual se pueden colocar procesadores en el diagrama de flujo de señales, ni sobre 
las veces que un procesador particular puede ser utilizado en la fila de un mismo canal. Los espacios vacíos 
entre bloques procesadores no afectan el flujo de la señal, de modo que no es necesario que los 
procesadores estén adyacentes uno al otro en la fila del canal.  

Cuando los bloques procesadores se añaden por primera vez al diagrama de flujo de señales, sus 
parámetros están ajustados a los valores predeterminados en fábrica. Los parámetros de cada procesador 
individual pueden modificarse abriendo su ventana de parámetros. Los bloques retienen los valores de sus 
parámetros aun si se los copia o desplaza a un espacio diferente. 

Llenado de espacios vacíos 
Se pueden añadir bloques procesadores al diagrama de flujo de señales ya sea usando la caja de 
herramientas de procesadores, o con las funciones de menú. Cada uno de estos métodos se describe a 
continuación. 

Con la caja de herramientas de procesadores 
Se puede usar el Mouse para seleccionar un bloque procesador de la caja de herramientas. El cursor del 
Mouse cambia de forma para indicarle que su siguiente acción colocará el bloque seleccionado en el 
diagrama de flujo de señales. La apariencia del cursor depende de su posición, según se ilustra en la tabla 
siguiente. 

 

Posición en la cual se puede 
colocar el procesador 

 

Posición no apropiada para el 
procesador seleccionado. 

Para añadir un bloque procesador de la caja de herramientas de procesadores: 
�� Haga clic con el botón izquierdo del Mouse sobre un bloque procesador de la caja de 

herramientas y manténgalo pulsado mientras se lo arrastra hacia el diagrama de flujo de 
señales. Suelte el botón del Mouse para colocar el bloque en la posición actual del cursor. 
- O - 

�� Haga clic una vez en el bloque procesador en la caja de herramientas, y luego haga clic en un 
espacio vacío apropiado del diagrama de flujo de señales.  

Sugerencia Si cambia de parecer después de haber hecho clic en el bloque procesador de la 
caja de herramientas, utilice la tecla ESC para anular esta operación antes de 
colocar el procesador en el diagrama de flujo de señales. 

Con un comando de menú 
Se pueden añadir procesadores al diagrama de flujo de señales sin necesidad de abrir la caja de 
herramientas, usando ya sea el menú principal o el menú contextual de acceso por clic con el botón derecho 
del Mouse, de la forma descrita a continuación. 

Para añadir un bloque procesador usando el menú: 
1. Haga clic en un espacio vacío para seleccionarlo. 
2. Haga clic con el botón derecho del Mouse para seleccionar un procesador. 

- O - 

3. Utilice la función [Processor>Add] del menú principal. 

Otra ventaja que ofrece el uso del comando de menú para colocar bloques procesadores es que permite 
colocar un mismo tipo de procesador en varios espacios, con ejecutar el comando del menú una sola vez. 
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Para añadir varios bloques procesadores: 
1. Mantenga pulsada la tecla CTRL y haga clic en varios espacios vacíos para seleccionarlos. 
2. Utilice el menú contextual de acceso por clic con el botón derecho para colocar el mismo tipo de 

procesador en todos los espacios seleccionados. 
- O - 

3. Utilice la función [Processor>Add] del menú principal. 

Procesadores estereofónicos 
Los procesadores estereofónicos se colocan en el diagrama de flujo de señales del mismo modo que se 
hace con los otros bloques procesadores modulares. Sin embargo, cada uno de los canales estereofónicos 
se despliega como un bloque separado. Si se hace doble clic en uno de los bloques, se abre la ventana de 
parámetros de ambos canales. 

Cada uno de los procesadores dinámicos siguientes funciona como un par estereofónico: 
Nombre del bloque Descripción 

�� ST COMP Compresor estereofónico 
�� SFT ST COMP Compresor estereofónico – Con opción de articulación suave 
�� ST LIM Limitador estereofónico 
�� SFT ST LIM Limitador estereofónico – Con opción de articulación suave 

Para añadir un bloque procesador estereofónico de la caja de herramientas de procesadores: 

1. Haga clic en un bloque procesador 
Cuando se selecciona un procesador estereofónico de la caja de herramientas, el cursor adquiere una 
apariencia ligeramente diferente que en el caso de otros procesadores, según se indica en la tabla 
siguiente. 

 
Posición en la cual el primer canal del 
procesador estereofónico puede colocarse. 

 
Posición en la cual el segundo canal del 
procesador estereofónico puede colocarse. 

2. Añada el primer canal del par estereofónico. 
�� Haga clic con el botón izquierdo del Mouse sobre un bloque procesador de la caja de 

herramientas y manténgalo pulsado mientras se lo arrastra hacia el diagrama de flujo de 
señales. Suelte el botón del Mouse para colocar el primer canal del procesador en la posición 
actual del cursor. 
- O - 

�� Haga clic una vez en el bloque procesador en la caja de herramientas, y luego haga clic en un 
espacio vacío apropiado del diagrama de flujo de señales.  

3. El cursor cambia de forma para indicar que es necesario colocar el segundo canal del procesador. 
�� Haga clic en el espacio apropiado para añadir el segundo canal estereofónico. 

Para añadir un procesador estereofónico usando el menú: 
1. Mantenga pulsada la tecla CTRL y haga clic para seleccionar espacios vacíos en dos canales diferentes. 
2. Utilice el menú contextual de acceso por clic con botón derecho para colocar los dos canales del par 

estereofónico. 
- O - 

3. Utilice la función [Processor>Add] del menú principal. 
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Redes de cruce y bifurcadores 
Puesto que son procesadores de salida exclusivamente, las redes de cruce sólo pueden colocarse en canales 
de salida. Pueden añadirse a las filas de salida como cualquier otro bloque procesador, pero es necesario 
tomar en cuenta los factores siguientes: 

�� Una red de cruce se extiende hacia abajo para abarcar el número especificado de salidas, por 
lo tanto hay que seleccionar una fila de salida que tenga un número suficiente de filas de salida 
debajo suyo. 

�� Un bloque de red de cruce sólo puede abarcar canales de salida consecutivos. 
�� Redes de cruce diferentes no pueden quedar traslapadas sobre una misma fila de salida. 
�� Los puntos de mezcla desaparecen de todos los canales de salida abarcados por una red de 

cruce, salvo por la fila del canal que está en posición superior. 
�� Los espacios para procesador que se encuentran a la izquierda de la red de cruce desaparecen 

de los canales de salida que están debajo del canal de posición superior. 
�� Los bifurcadores tienen las mismas limitaciones y condiciones de flujo de señales que las redes 

de cruce. 

Debido a estos factores, si la configuración utiliza redes de cruce, éstas deben añadirse al diagrama de 
flujo de señales antes de conectar los puntos de mezcla o de añadir otros procesadores a las filas de los 
canales de salida. 

Atenuador automático (Ducker) 
El atenuador automático debe colocarse únicamente en el canal de entrada que lleva la señal de 
buscapersonas. El sistema no permite colocar un atenuador automático en un canal de salida. 

Sustitución de procesadores 
Sólo un bloque procesador puede ocupar un espacio particular a la vez. Para sustituir un bloque procesador 
existente por otro, elimínelo primero del espacio y después añada el procesador nuevo utilizando cualquiera de 
los métodos arriba descritos. 

Administración de recursos de DSP 
Aunque el P4800 tiene suficiente poder de procesamiento para muchas situaciones, es posible llenar el 
diagrama de flujo de señales con más bloques procesadores que los que los recursos de DSP (procesamiento 
digital de señales) del dispositivo pueden manejar. En esta sección se describe en términos generales cómo el 
procesador de sistema maneja los requisitos de procesamiento de señales de una configuración dada, y le 
presenta algunas sugerencias para obtener el provecho máximo de los recursos de DSP. 

Asignación de recursos 
Con sólo colocar un bloque procesador en la fila de un canal, se están asignando los recursos de DSP necesarios 
para que funcione a su capacidad máxima. Por esta razón es que se han provisto tantas variedades de un mismo 
tipo de bloque procesador, para que pueda seleccionar solamente la cantidad de procesamiento que realmente 
se necesitará para un módulo particular. Cuando se está diseñando una configuración sencilla, no es tan 
importante prestar atención a la cantidad de recursos de DSP en uso. Sin embargo, en configuraciones más 
complejas, es más importante seleccionar bloques procesadores que utilicen la cantidad mínima de recursos de 
procesamiento necesarios para cumplir la tarea deseada. 

Por ejemplo: cuando se coloca un ecualizador paramétrico de diez bandas en la fila de un canal, 
instantáneamente se asigna el poder de procesamiento requerido por los diez filtros, aun cuando sólo se 
vayan a utilizar cuatro de ellos. En este caso, la mejor alternativa sería usar el PEQ5. 

Memoria de retardo 
El procesador de sistema tiene un búfer que retiene hasta 20 segundos de retardo, los cuales pueden 
dividirse entre cualquier combinación de procesadores de retardo. Al igual que la asignación de recursos de 
DSP, la memoria de retardo se asigna al bloque procesador según el tiempo máximo de retardo indicado en 
el nombre que lo identifica.  

Por ejemplo: si sólo se necesita un retardo de cuarenta y cinco milisegundos, no utilice el retardo de 2 
segundos, ya que el de 150 ms le dará los mismos resultados. Aunque ambos procesadores pueden 
ajustarse para introducir un retardo igual, el bloque DLY 2s agota dos segundos completos de memoria 
de retardo. 
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Nota: La memoria de retardo no debe confundirse con los recursos del sistema de DSP. Cada 
retardo utiliza la misma cantidad de recursos de DSP, sin importar la duración de su 
retardo máximo. 

Medidores de utilización 
Estos medidores se encuentran en la parte inferior de la ventana principal, e indican la cantidad de recursos 
de DSP y de memoria de retardo que se utilizan en la configuración actual, permitiéndole ajustar los 
procesadores seleccionados de modo correspondiente, en caso de ser necesario. Cuando se añade o se 
quita un bloque procesador del diagrama de flujo de señales, el medidor de DSP instantáneamente calcula 
los resultados, e indica los recursos del sistema que están siendo utilizados en la configuración actual de 
procesadores. 

Nota: El medidor indica el porcentaje del total de los recursos que la configuración ocupa, en 
lugar de la cantidad de recursos que cada procesador individual consume. 

Debido a que el P4800 efectúa el DSP utilizando varios circuitos integrados procesadores, el medidor de DSP no 
siempre representa con precisión la cantidad de recursos disponibles. Si el medidor indica que resta un 20% de 
recursos disponibles, pero no es posible añadir un procesador, esto puede deberse a que los recursos 
disponibles se encuentran divididos entre los circuitos integrados procesadores, en lugar de estar disponibles en 
un solo lugar. Consulte la sección siguiente en cuanto a la optimización del DSP para algunas soluciones 
sugeridas. 

Nota: Las unidades P4800 con números de serie que inician con la letra N o una posterior le 
permiten almacenar cualquier escena creada en el modo de diseño. En las unidades 
antiguas (identificadas por los números de serie que inician con L o M), las escenas 
que utilizan menos del 87% de los recursos, según lo indica el medidor de DSP, 
deberán poder utilizarse. Sin embargo, debido a que los recursos se distribuyen entre 
varios circuitos procesadores, el medidor posiblemente no representa la capacidad 
disponible de DSP. Es posible que una unidad más antigua no sea capaz de utilizar 
una escena, aun si el medidor de DSP indica menos de 87%. Esto puede suceder si se 
utilizan varios bloques DFR5, DFR10 y/o GEQ30. Para asegurar que una escena 
particular pueda utilizarse en un P4800 con número de serie que inicia con L o M, 
conéctese a la unidad y colóquela en modo en vivo. En el modo en vivo, el medidor de 
DSP y los porcentajes de utilización de procesador indicados en la caja de 
herramientas de procesadores se gradúan para reflejar con precisión la capacidad de 
la unidad. 

Sugerencias para la optimización del DSP 
Si se despliega el cuadro ilustrado en la Figura 13 cuando se intenta 
añadir un procesador al diagrama de flujo de señales, se puede 
optimizar la configuración para liberar alguna parte de los recursos, y 
después añadir el procesador. Utilice las sugerencias siguientes para 
optimizar el consumo de DSP de su configuración. 

• Mueva los bloques procesadores de un lado de la matriz 
mezcladora al otro, empezando con los procesadores que 
utilizan el porcentaje más alto de recursos de sistema (vea 
Apéndice B en la página 107 para más detalles en cuanto a la 
utilización de DSP).  

Por ejemplo: si se tiene un DFR10 en el lado de salida del 
diagrama de flujo de señales, muévalo al lado de entrada, o viceversa. 

�� Reduzca varios ecualizadores que se encuentren en una misma trayectoria de señal a un solo 
módulo cuando sea posible. 

Por ejemplo: dos PEQ3 consumen más DSP que un PEQ7. Obsérvese también que todos los 
ecualizadores paramétricos (PEQ) se ofrecen con filtros atenuadores y limitadores, 
precisamente para ahorrar recursos de DSP. La única función específica del módulo de filtro 
ATENUADOR/LIMITADOR es la pendiente de 24 dB/octava. Si no se requiere esta función, no 
existe razón alguna para tener filtros atenuadores y limitadores en un módulo aparte de un 
ecualizador paramétrico que esté en la misma trayectoria de la señal. 

Figura 13 − Mensaje sobre recursos de DSP  
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�� Reduzca varios módulos de retardo que se encuentren en una misma trayectoria de señal a un 
solo módulo cuando sea posible. 

Aunque se conserva memoria de retardo utilizando dos módulos de retardo DLY5ms 
cuando se necesita un retardo de siete milisegundos, se está usando el doble de los 
recursos de DSP que si se utiliza un solo módulo de retardo DLY150ms. 

�� Añada los procesadores en el lado de entrada de la matriz mezcladora, en lugar del lado de salida, 
cuando sea posible. 

�� Quite los procesadores de todos los canales no utilizados. 

�� Utilice bifurcadores para aplicar procesos idénticos a varios canales de salida. 

�� Utilice un ecualizador paramétrico PEQ10 en lugar de un ecualizador GEQ30. En la mayoría de los 
casos no se utilizan los treinta filtros, y el PEQ10 utiliza menos de la mitad de los recursos de DSP 
que el otro dispositivo. 

�� Sustituya los DFR por ecualizadores paramétricos después de haber eliminado la realimentación en el 
sistema. 

Por ejemplo: en una configuración que requiere varios DFR en varios canales de entrada para 
obtener un mejor rendimiento de ganancia antes de la realimentación, se puede usar un DFR 
inicialmente en cada entrada para eliminar la realimentación. Después de haber colocado los filtros, 
copie los filtros DFR y péguelos en un PEQ, luego elimine el DFR. Esto puede repetirse en cada 
canal de entrada, y finalmente dejar sólo un DFR en la salida de altavoz que más problemas causa 
para la detección automática de realimentación posteriormente. 

Nota: Después de haber optimizado la configuración, el medidor de DSP puede no reflejar 
cambios, porque el total de recursos disponibles posiblemente sigue siendo el mismo. 
Los recursos sencillamente han sido reasignados, de modo que se los puede 
aprovechar mejor. 

Copiar y pegar 
Los comandos tradicionales de copiar, cortar y pegar funcionan únicamente con los bloques procesadores 
modulares. Esta es una forma conveniente de duplicar bloques procesadores, junto con sus valores de 
ajuste, en varios canales. 

Para copiar y pegar un bloque procesador: 
1. Seleccione un bloque procesador haciendo clic una vez sobre el mismo con el botón izquierdo del 

Mouse. 
2. Seleccione el comando de copiar usando uno de los métodos siguientes. 

�� Utilice el menú contextual haciendo clic con el botón derecho del Mouse 
�� Seleccione [Edit>Copy] del menú principal 
�� Pulse CTRL+C en el teclado 

3. Seleccione un espacio vacío. 
4. Seleccione el comando de pegar usando cualquiera de los menús o pulsando CTRL+V. 

Nota: Estos comandos no funcionan con selecciones múltiples.  

Eliminación de bloques 
Los bloques procesadores modulares pueden quitarse fácilmente de una configuración sin afectar los demás 
aspectos del flujo de la señal.  

Para eliminar un bloque procesador: 
1. Seleccione el bloque procesador haciendo clic una vez sobre el mismo con el botón izquierdo 

del Mouse. 
2. Seleccione el comando de eliminar usando uno de los métodos siguientes. 

�� Utilice el menú contextual haciendo clic con el botón derecho del Mouse. 
�� Seleccione [Edit>Delete] del menú principal. 
�� Pulse la tecla SUPR. 
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Enlace 
Se pueden enlazar varios bloques procesadores del mismo tipo para controlarlos como si fueran uno solo. Las 
modificaciones hechas en la ventana de parámetros de cualquier bloque de un grupo de enlace modifican 
simultáneamente los parámetros de todos los bloques que pertenecen al grupo. No obstante, hay algunas 
actividades que todavía funcionan de modo independiente en bloques enlazados: 

�� Eliminar, copiar, cortar y pegar, 
�� Desplazar el bloque a un espacio diferente en la fila de canal, 
�� Designar el nombre en la ventana de parámetros del procesador. 

Los procesadores fijos de una misma etapa de la estructura de ganancia también pueden agruparse, lo cual 
sincroniza los controles de nivel de todos los canales agrupados. Por ejemplo, se pueden agrupar los 
bloques de ganancia de dos canales de entrada para controlarlos como un par estereofónico. También se 
pueden enlazar todos los bloques de ganancia de salida para poder ajustar los niveles de todos los canales 
de salida con un solo control. 

Nota: Solamente es posible enlazar procesadores de precisamente el mismo tipo. 

Creación de un grupo de enlace 
Al crear un grupo de enlace, todos los procesadores de ese grupo se sincronizarán a los mismos ajustes. Si 
ya se han especificado valores de ajuste de uno de los procesadores antes de crear el grupo de enlace, es 
posible designarlo como fuente cuando se crea el grupo, lo cual hace que los demás bloques procesadores 
adopten esos valores de ajuste. Como alternativa, si se desea eliminar los valores de ajuste existentes en el 
procesador, se puede seleccionar los valores pretederminados en fábrica como fuente. Después de haber 
creado el grupo de enlace, las modificaciones hechas a los valores de ajuste de uno de los bloques 
enlazados afectan a todos los bloques de ese grupo. 

Para crear un grupo de enlace: 

1. Mantenga pulsada la tecla CTRL y haga clic en varios 
bloques procesadores para seleccionarlos. 

2. Seleccione [Processor >Link>New Link Group] del menú 
principal, o [Link>New Link Group] del menú contextual de 
acceso por clic con el botón derecho. 

3. El cuadro de diálogo de creación de grupo de enlace 
aparece. 

4. Introduzca un nombre de dos caracteres para identificar al 
grupo. 

5. Elija una fuente que defina los valores de ajuste iniciales 
del grupo de enlace. 

6. Haga clic en [OK] para aceptar los valores. 

El nombre de dos caracteres del grupo aparece tanto en el bloque 
procesador, en el diagrama de flujo de señales, como en el 
indicador de enlace en la esquina inferior derecha de la ventana de 
parámetros del procesador, de la forma ilustrada en la tabla siguiente. 

Ventana de parámetros del procesador Diagrama de flujo de señales 

  

Nota: Un procesador sólo puede pertenecer a un grupo de enlace a la vez. 

Adición de elementos a un grupo de enlace 
Se pueden añadir bloques procesadores a un grupo de enlace existente, siempre y cuando sean 
procesadores exactamente del mismo tipo y no formen parte de ningún grupo de enlace. Los procesadores 
añadidos a un grupo de enlace adoptan los valores de ajuste vigentes del grupo. 

Para añadir bloques a un grupo de enlace existente: 

Figura 14 − Cuadro de diálogo de 
grupos de enlace 
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1. Haga clic sobre un bloque procesador para seleccionarlo, 
o mantenga pulsada la tecla CTRL y haga clic sobre 
varios bloques para seleccionarlos. 

2. Seleccione [Processor>Link>Add To] del menú principal, 
o [Link>Add To] del menú contextual de acceso por clic 
con el botón derecho. 

3. El cuadro de diálogo de añadir a grupo de enlace aparece. 
Indica sólo los grupos de enlace que contienen 
procesadores del mismo tipo que el bloque seleccionado. 

4. Seleccione un grupo de enlace. 

5. Haga clic en [OK]. 

Desenlace de bloques procesadores 
Un bloque procesador puede retirarse de un grupo de enlace sin afectar los demás bloques enlazados. 
También se puede eliminar un grupo de enlace desenlazando todos los bloques incluidos en el grupo.  

Para quitar bloques de un grupo de enlace existente: 
1. Haga clic sobre un bloque procesador para seleccionarlo, o mantenga pulsada la tecla CTRL y haga clic 

sobre varios bloques para seleccionarlos. 
2. Seleccione [Processor>Link>Unlink] del menú principal, o del menú contextual de acceso por clic con el 

botón derecho. 

Nota: Un grupo de enlace deberá contener por lo menos dos bloques procesadores. Si 
se retiran todos los bloques menos uno de un grupo de enlace, se elimina el grupo 
por completo. 

Derivación 
Es posible derivar un bloque procesador modular de la ventana 
principal. Esto le permite evaluar la trayectoria de la señal, 
mientras se excluye ese procesador particular de la misma. Los 
bloques derivados se denotan en el diagrama de flujo de 
señales por medio de una marca amarilla. 

Para activar o desactivar la derivación: 
1. Haga clic sobre un bloque procesador para seleccionarlo, o 

mantenga pulsada la tecla CTRL y haga clic sobre varios bloques para seleccionarlos. 
2. Active la derivación usando cualquiera de los métodos siguientes: 

�� Pulse CTRL+B en el teclado. 
�� Seleccione [Processor>Bypass Selected] del menú principal. 
�� Utilice el menú contextual haciendo clic con el botón derecho del Mouse. 

Nota: No es posible derivar las redes de cruce ni los bifurcadores.  

Figura 16 − Bloque procesador 
derivado 

Bloque procesador derivado

Figura 15 − Cuadro de diálogo para añadir 
elementos a grupos de enlace 



Cómo guardar una configuración 

Guía de software de procesador de sistema SHURE P4800 Página 28 de 112 

CÓMO GUARDAR UNA CONFIGURACIÓN ______________________  
Después de haber creado una configuración, es posible guardarla en la computadora como un archivo de escena, o 
en el dispositivo como una configuración prefijada, dependiendo de si se está conectado al P4800 ó no. En el modo 
en vivo, la configuración que se está creando se escribe directamente a la configuración prefijada vigente. Es posible 
guardarla en la computadora en cualquier momento haciendo clic en el botón [Save As] de la barra de control de la 
ventana principal. 

Archivos de escena 
Es posible diseñar una biblioteca completa de configuraciones de flujo de señales con el software del procesador de 
sistema, sin necesidad de tener la computadora conectada al dispositivo. Las configuraciones que se guardan en la 
computadora son archivos de escena que posteriormente pueden recuperarse, modificarse y luego enviarse al 
dispositivo como configuraciones prefijadas. Los archivos de escena se guardan con la extensión de archivo “.scn”. 

Cómo guardar una escena nueva 
Si la computadora no está conectada al dispositivo, cada configuración nueva de flujo de señales se guarda 
en la computadora como un archivo de escena.  

Para guardar un archivo de escena nuevo: 
1. En la ventana principal, seleccione [File>Save As Scene File] del menú principal, o haga clic en el botón 

[Save As] de la barra de control. 
2. Se visualiza el cuadro de diálogo de guardar escena como. 
3. Seleccione la unidad de disco y el directorio en donde se desea guardar el archivo nuevo. 
4. Escriba el nombre y, si se desea, una descripción. 
5. Haga clic en [Save]. 

Nota: Los archivos de escena de otros dispositivos procesadores de señales digitales de 
Shure, tales como el DFR11EQ o DP11, crean archivos con la misma extensión “.SCN”. 
Es buena idea guardar los archivos de escena de dispositivos diferentes en directorios 
diferentes para ayudar a distinguirlos.  

Uso del campo de descripción 
El campo opcional de descripción ayuda a identificar los archivos de escena al abrirlos. La descripción del 
archivo de escena se copia a la descripción de la configuración prefijada cuando el archivo se guarda en el 
dispositivo.  

Modificación de archivos de escena 
Cuando se modifica un archivo de escena existente, se puede guardarlo en un archivo con nombre 
diferente, o sobreescribir la versión anterior del archivo. 

Para modificar un archivo de escena nuevo: 
1. En la ventana principal, seleccione [File>Open Scene File] del menú principal, o haga clic en el botón 

[Open] de la barra de control. 
2. Se visualiza el cuadro de diálogo de abrir escena. 
3. Seleccione la unidad de disco y el directorio que contiene el archivo de escena que se desea abrir. 
4. Haga clic en el archivo para seleccionarlo, y luego haga clic en el botón [Open]. 
5. Haga las modificaciones que sean necesarias. 
6. Seleccione [File>Save As Scene] del menú principal, o haga clic en el botón [Save As] de la barra de 

control. 
7. Se visualiza el cuadro de diálogo de guardar escena como. 
8. Haga clic en el nombre del archivo original para seleccionarlo, y después haga clic en [Save]. 
9. Aparece un cuadro de diálogo que solicita verificación de que se desea sobreescribir el archivo de 

escena anterior. 
10. Haga clic en [Yes] para sobreescribir el archivo. 
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Administración de configuraciones prefijadas 
El procesador de sistema puede almacenar al menos 16 y hasta 128 configuraciones prefijadas en su memoria, 
dependiendo de su grado de complejidad. Una vez que se han guardado las configuraciones prefijadas en el 
dispositivo, éstas pueden redesignarse, borrarse o guardarse en una copia de respaldo. 

Cómo guardar una configuración prefijada en el dispositivo 
Cuando se está conectado al dispositivo, el modo de diseño le permite 
almacenar configuraciones nuevas del flujo de señales en el dispositivo 
como configuraciones prefijadas, o abrir archivos de escena nuevos y 
guardarlos en el dispositivo. 

Para guardar una configuración prefijada en el dispositivo: 
1. En la ventana principal, seleccione [File>Store As Preset] del menú 

principal, o si está en modo de diseño, también se puede hacer clic 
en el botón [Store Preset] de la barra de control. 

2. Se visualiza el cuadro de diálogo de selección de dispositivos. 
3. Seleccione el dispositivo de la lista y haga clic en [Connect]. 
 

Figura 18 − Cuadro de diálogo de guardar 
configuración prefijada  

Figura 17 − Cuadro de diálogo de 
seleccion de dispositivos  

4. Se visualiza el cuadro de diálogo de 
guardar configuración prefijada. 

5. Escriba un nombre nuevo para la 
configuración prefijada de no más de 
quince caracteres. 

6. Escriba el número de la configuración 
prefijada, o acepte el dado por omisión.

7. Escriba una descripción (opcional) que 
le ayude a identificar el contenido de la 
configuración prefijada para 
operaciones futuras. 

8. Haga clic en [Store]. 
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Redesignación de una configuración prefijada 
Después de haber guardado una configuración prefijada en el dispositivo, se puede cambiar su 
nombre y su descripción en el modo en vivo. 

Para redesignar una configuración prefijada: 
1. Haga clic en el botón [Live Mode] de la barra de control. 
2. Seleccione la configuración prefijada cuyo nombre se 

desea redesignar del menú que aparece en el cuadro 
de información de la barra de control. 

3. La ventana principal entra en modo de presentación 
preliminar para la configuración prefijada que se ha 
seleccionado. 

4. Haga clic en el botón [Load] de la barra de control para 
cargar la configuración prefijada al modo en vivo. 

5. Haga clic una vez en cualquier punto del cuadro de 
información. 

6. Se visualiza el cuadro de diálogo de redesignación de configuración prefijada. 
7. Escriba el nombre y/o descripción nuevos. 
8. Haga clic en [OK]. 

Eliminación de una configuración prefijada 
En el modo de diseño se pueden 
eliminar del dispositivo configuraciones 
prefijadas que ya no estén en uso. 

Para eliminar una configuración 
prefijada: 

1. Haga clic en el botón [Design 
Mode] de la barra de control. 

2. Seleccione [File>Delete Preset]. 
3. Se visualiza el cuadro de diálogo 

de selección de dispositivos. 
4. Seleccione el dispositivo de la lista 

y haga clic en [Connect]. 
5. Se visualiza el cuadro de diálogo 

de eliminación de configuración 
prefijada. 

6. Seleccione la configuración 
prefijada que se desea eliminar, o 
mantenga pulsada la tecla MAYÚS 
y haga clic para seleccionar más 
de una configuración prefijada. 

7. Haga clic en [Delete]. 
 

 

Nota: La configuración prefijada que está activa en el modo en vivo no se presenta para 
eliminarla. Si es necesario eliminar esta configuración prefijada, primero hay que 
seleccionar una configuración diferente en vivo. 

Figura 19 − Cuadro de diálogo para 
redesignar una configuracion prefijada

Figura 20 − Cuadro de diálogo para 
eliminar una configuración prefijada  
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Copias de respaldo del dispositivo 
Se pueden hacer copias de respaldo de todas las configuraciones prefijadas guardadas en el dispositivo en un solo 
archivo, y se puede restaurar esta copia de respaldo en el dispositivo en una fecha posterior. Es necesario estar en 
modo de diseño para confeccionar una copia de respaldo o para restaurarla. 

Para hacer una copia de respaldo de todas las 
configuraciones prefijadas del dispositivo: 
1. Haga clic en el botón [Design Mode] de la 

barra de control. 
2. Seleccione [File>Backup Device] del menú 

principal. 
3. Se visualiza el cuadro de diálogo de 

selección de dispositivos. 
4. Seleccione el dispositivo de la lista y haga 

clic en [Connect]. 
5. Se visualiza el cuadro de diálogo de copia de 

respaldo del dispositivo. 
6. Haga clic en [Backup Device]. 
7. Se visualiza el cuadro de diálogo de guardar 

copia de respaldo como, el cual se ilustra en 
la Figura 22. 

8. Seleccione el directorio deseado y escriba el 
nombre deseado del archivo. 

9. Haga clic en [Save]. 

Para restaurar una copia de respaldo en el 
dispositivo: 
1. Seleccione [File>Restore Device] del menú 

principal. 
2. Se visualiza el cuadro de diálogo de abrir copia de 

respaldo, el cual es similar al de guardar copia de 
respaldo ilustrado en la Figura 22. 

3. Seleccione el directorio correcto y la copia de 
respaldo apropiada de la lista. 

4. Haga clic en [Open]. 
5. Se visualiza el cuadro de diálogo de selección de 

dispositivos. 
6. Seleccione el dispositivo de la lista y haga clic en 

[Connect]. Esto envía la copia de respaldo al 
dispositivo. 

 

Figura 21 − Cuadro de diálogo para hacer una 
copia de respaldo del dispositivo  

Figura 22 − Cuadro de diálogo para guardar la 
copia de respaldo con nombre nuevo 
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Figura 23 −Controles estándar 

Fila graduada de control de nivel 

Perilla de control 
de nivel 

Botones de flecha

Cuadro de valores 

CARACTERÍSTICAS DEL PROCESADOR _______________________  
En esta sección se describen funciones del software que son comunes entre muchas de las ventanas de parámetros 
de procesadores. Para las características que son específicas de procesadores individuales, consulte la sección 
Procesadores fijos en la página 35, y la sección Procesadores modulares en la página 41. 

Controles de nivel 
Los controles de nivel aparecen en muchas de las ventanas de procesadores, como en el ejemplo ilustrado en la 
Figura 23. Le permiten ajustar el nivel de ganancia moviendo el Mouse hacia arriba o hacia abajo, tal como se 
desliza un control de ganancia en una consola mezcladora. También se puede especificar el nivel escribiendo un 
número en el cuadro de valores. Primero seleccione el control de nivel, después ajuste el nivel usando cualquiera de 
los métodos descritos a continuación. 

Selección 
Seleccione un control de nivel colocando el cursor del Mouse sobre la perilla del control y haciendo clic con 
el botón izquierdo del Mouse, o haciendo clic en el cuadro de valores ubicado debajo del control de nivel. La 
perilla de control de nivel se resalta para indicar que ha sido seleccionada. Si la ventana contiene varios 
controles de nivel, es posible avanzar entre ellos de izquierda a derecha usando la tecla TAB, y de derecha a 
izquierda usando la combinación de teclas MAYÚS+TAB. 

 
Control de nivel seleccionado 

 
Control de nivel no seleccionado 

Ajuste del nivel 

Para ajustar el nivel con el Mouse: 
�� Haga clic sobre la perilla del control de nivel 

y mantenga oprimido el botón del Mouse para 
arrastrarla hacia arriba o hacia abajo. 

�� Haga clic en las graduaciones del control al nivel que se 
desea fijar.  

�� Haga clic con el botón derecho del Mouse sobre la 
perilla del control de nivel para fijarla en 0 dB. 

Para ajustar el nivel con el teclado: 

1. Seleccione el control de nivel que se desea ajustar.  

2. Utilice cualquiera de las teclas siguientes para ajustar el valor.  

 

Tecla Resultado 

Flecha arriba Aumentar 0,5 dB 

Flecha abajo Disminuir 0,5 dB 

Re Pág Aumentar 3 dB 

Av Pág  Disminuir 3 dB 

Barra espaciadora Fija el valor en 0 dB 

Cuadro de valores 
El cuadro de valores le permite especificar el nivel con una precisión de una décima de decibelio. Todos los 
controles de nivel tienen un cuadro de valores correspondiente. En la mayoría de las ventanas de 
procesador, cada control de nivel tiene un cuadro de valores directamente debajo del mismo. Las dos 
excepciones son las ventanas de GEQ10 y GEQ30, las cuales tienen un solo cuadro de ganancia para todo 
el juego de controles de nivel. En este caso, seleccione primero la perilla del control de nivel que se desea 
ajustar y luego escriba un valor en el cuadro. 
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Botones de flecha 
Hay botones de flecha a la izquierda de todos los cuadros de valores. Proporcionan un medio cómodo de 
aumentar el valor sin tener que escribir un valor específico. 

Para modificar el valor con los botones de flecha: 
�� Haga clic en el botón con flecha arriba o flecha abajo para variar el nivel en ±0,5 dB. 
�� Mantenga un botón de flecha pulsado para aumentar o reducir el nivel de modo continuo. Si se 

mantiene pulsado por más tiempo, la velocidad de cambio aumenta. 

Cómo guardar y recuperar valores de ajuste 
Los valores de ajuste de cualquier ventana de parámetros de procesador pueden guardarse en un archivo de 
computadora y recuperarse la siguiente vez que se necesite una configuración similar para un procesador del 
mismo tipo. Esto le permite crear valores de ajuste personalizados o para una instalación específica para 
procesadores comúnmente utilizados. Si se van a guardar muchos valores de ajuste en la computadora, es 
buena idea crear un directorio específicamente para los valores de ajuste de procesadores o para una 
instalación particular. 

Para guardar los valores de ajuste de un procesador: 
1. Haga doble clic en el bloque procesador para abrir su ventana de parámetros. 
2. Seleccione [File>Save Settings] del menú o pulse la combinación CTRL+S en el teclado. 
3. Escriba un nombre para el archivo. 
4. Haga clic en [Save]. 
5. El programa agrega una extensión al archivo que identifica el tipo de procesador que lo creó. 

Para recuperar valores de ajuste de un procesador: 
1. Haga doble clic en el bloque procesador para abrir su ventana de parámetros. 
2. Seleccione [File>Recall Settings] del menú o pulse la combinación CTRL+R en el teclado. 
3. Seleccione el archivo de valores de ajuste apropiado. 
4. Haga clic en [Open]. 

Nota: Sólo es posible recuperar los valores de ajuste correspondientes a un procesador 
idéntico al que creó el archivo de valores. 

Designación de ventanas de procesador 
La ventana de parámetros de cada bloque procesador modular en el diagrama de flujo de señales puede 
recibir un nombre individual, lo cual es útil cuando se abren varias ventanas simultáneamente. Los títulos de 
ventanas de procesador predeterminados incluyen el nombre de la categoría general de procesador, y el 
rótulo de la fila del canal en el cual ha sido colocado. 

Para distinguir entre procesadores similares, es posible personalizar el nombre de la ventana para reflejar la 
función particular o los valores de ajuste del procesador. El nombre nuevo de la ventana aparece tanto en la 
barra de títulos de la ventana de parámetros del procesador, como en la barra de tareas de Windows, 
cuando se minimiza la ventana de parámetros. 

Para redesignar una ventana de parámetros de procesador: 
1. Haga doble clic en el bloque para abrir su ventana de parámetros. 
2. Seleccione [Options>Name] del menú. 
3. Escriba un nombre nuevo, de hasta quince caracteres. 
4. Haga clic en [OK]. 

Nota: Esto solamente cambia el nombre de la ventana de parámetros del procesador. El título 
del bloque procesador en el diagrama de flujo de señales no cambia.  
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Imágenes instantáneas 
La función de imágenes instantáneas se ofrece para todas las ventanas de parámetros de procesador que muestran 
la gráfica de una curva de respuesta o de transferencia. Le permite capturar una imagen de la curva actual para 
luego desplegarla con fines de referencia cuando se modifican los valores de ajuste del procesador. El procesador 
guarda esta imagen instantánea en memoria hasta que se capture una imagen nueva de la misma ventana de 
procesador, o hasta que se salga del programa. 

Las curvas de respuesta siguientes son ejemplos tomados de la ventana de parámetros de un ecualizador 
paramétrico de cinco bandas con filtros atenuadores y limitadores (PEQ5+CS). 

Para usar la función de imágenes 
instantáneas: 

1. Haga clic en el botón [TAKE]. 
Esto captura la curva actual de 
respuesta o de transferencia. 

2. Haga clic en el botón  
[SHOW]. Esto despliega 
la imagen instantánea 
detrás de la curva actual.  

El botón se ilumina en 
verde cuando se 
despliega la imagen instantánea. 

Figura 25 − Modificación de la  curva de respuesta 

3. Modifique los valores de 
ajuste del procesador. A 
medida que se modifica la 
curva, es possible 
compararla con la imagen 
instantánea de la curva 
anterior, la cual aparece en 
el fondo. 

Figura 24 − Captura de una imagen instantánea 

4. Haga click en el boton  
[SHOW] nuevamente para 
ocultar o mostrar la 
imagen instantánea. 

Figura 26 − Ocultando de la imagen instantánea 

NOTA:  Cuando se muestra la imagen instantánea antes de haber modificado los ajustes del 
procesador, ésta se hallará oculta detrás de la curva actual.  La imagen  instantánea queda 
visible tan pronto se modifica la forma de la curva, al cambiar los valores de ajuste.  
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PROCESADORES FIJOS _____________________________________  
Estos procesadores componen las tres etapas diferentes de Estructura de ganancia de procesadores del sistema 
(vea la página 17 para más información sobre este tema). Se les denomina procesadores fijos por los bloques de 
ganancia y de mezcla del diagrama de flujo de señales no pueden moverse ni eliminarse. 

Ganancia de entrada 
El procesador de ganancia de entrada contiene controles individuales para los cuatro canales de entrada. Haga 
doble clic en el bloque de ganancia que se encuentra en el extremo izquierdo de la fila de cualquier canal de entrada 
para abrir esta ventana. 

Alternativas de cambio de escala 
Utilice estos botones para fijar la escala de un canal de entrada de modo correspondiente al nivel de salida 
del equipo conectado antes del procesador de sistema. Haga clic para seleccionar entre los niveles de –10 
dBV ó +4 dBu. El valor por omisión es +4 dBu. 

 
+4 dBu seleccionado 

 
-10 dBV seleccionado 

Polaridad de la señal 
Haga clic en este botón para invertir la polaridad de la señal que entra por el canal de entrada. El valor por 
omisión es el de polaridad normal. 

 Polaridad normal 

 Polaridad inversa 

Controles de ganancia 
Utilice estos controles para ajustar el nivel de la señal de cada canal de entrada. Primero seleccione la 
perilla del control y luego ajuste el nivel con el Mouse, con las teclas de flecha, o escriba el nivel deseado en 
el cuadro de valores. Para instrucciones completas en cuanto a su funcionamiento, vea la sección Controles 
de nivel en la página 32. La gama de ajuste oscila de +30 dB a –30 dB, y el valor por omisión es de 0 dB, o 
ganancia unitaria. 

Figura 27 − Ventana de ganancia de entrada 

Alternativas de 
cambio de escala

Polaridad ded la señal 

Controles
de ganacia

Silenciamiento de canales

Rótulo de canal

Indicador de enlace
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Nota: Los controles de ganancia de entrada regulan el nivel de la señal después que la 
misma ha sido convertida a formato digital por el procesador de sistema. Las señales 
cuyo nivel excede el umbral de entrada del procesador de sistema deben ajustarse por 
medios externos.  

Silenciamiento de canales 
Haga clic en este botón para silenciar el canal. El valor por omisión es el de desactivado. 

 
Silenciamiento 
activado 

 
Silenciamiento 
desactivado 

Rótulo de canal 
Utilice este cuadro de texto para personalizar el rótulo del canal de entrada en el diagrama de flujo de 
señales. El valor por omisión es el rótulo “Untitled In” (Entrada sin título) para cada canal de entrada. 

Indicador de enlace 
Visualiza el estado de enlace del canal de entrada. Todo valor de ajuste que se modifique en un canal 
enlazado afecta a todos los demás canales que pertenezcan al mismo grupo de enlace. Para una 
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 25. 

 Canal enlazado 

 Canal no enlazado 
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Matriz mezcladora 
El procesador de la matriz mezcladora contiene controles para las conexiones de los puntos de mezcla del diagrama 
de flujo de señales, los cuales se organizan por medio de fichas diferentes para cada punto de mezcla de salida. 
Haga doble clic en cualquiera de los bloques procesadores para abrir esta ventana. 

Fichas de ventana 
La ventana se abre con el enfoque colocado en la sección 
de salida correspondiente al bloque en donde se hizo 
doble clic. Haga clic en cualquier ficha para acceder a 
los controles de un punto de mezcla diferente. 

Las fichas de ventana corresponden a los puntos 
de mezcla de salida del diagrama de flujo de 
señales. Si se están usando redes de cruce 
en la configuración, los títulos de las 
fichas reflejan la gama de canales de 
salida que abarca cada red de cruce. 

Controles de entrada 
Haga clic en este 
botón para activar 
una conexión del 
punto de mezcla del 
canal de entrada 
correspondiente. Los 
controles de las 
entradas desactivadas 
aparecen en gris. El 
valor por omisión es el de 
desactivado. 

Figura 28 − Ventana de matriz mezcladora
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Figura 29 − Fichas de mezcladora con redes de cruce  
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Selector de entrada 
Haga clic en este botón para activar una conexión del punto de mezcla del canal de entrada 
correspondiente. Los controles de las entradas desactivadas aparecen en gris. El valor por omisión es el de 
desactivado. 

 Conexión activada 

 Conexión desactivada 

Polaridad de la señal 
Haga clic en este botón para invertir la polaridad de la señal. El valor por omisión es el de polaridad normal. 

 Polaridad normal 

 Polaridad inversa 

Controles de ganancia 
Utilice estos controles para ajustar el nivel de la señal de cada canal. Primero seleccione la perilla del control 
y luego ajuste el nivel con el Mouse, con las teclas de flecha, o escriba el nivel deseado en el cuadro de 
valores. Para instrucciones completas en cuanto a su funcionamiento, vea la sección Controles de nivel en 
la página 32. La gama de ajuste oscila de +10 dB a -infinidad, y el valor por omisión es de 0 dB, o ganancia 
unitaria. 

Silenciamiento de canales 
Haga clic en este botón para silenciar el canal. El valor por omisión es el de desactivado. 

 Silenciamiento activado 

 Silenciamiento desactivado 

Rótulo de canal 
Aquí se despliega el rótulo dado al canal en las ventanas de ganancia de entrada o ganancia de salida. 

Indicador de enlace 
Despliega el estado de enlace del control de salida de la ficha de la ventana actual. Todo valor de ajuste que 
se modifique en un control de salida enlazado afecta a todas las demás salidas de la mezcladora que 
pertenezcan al mismo grupo de enlace. Cuando se cambia a otra ficha de ventana, este indicador cambia 
para indicar el estado de enlace de la ficha actual. Para una explicación completa del enlace y los grupos de 
enlace, consulte la sección Enlace en la página 25. 

Nota: Cuando se enlazan bloques de mezcla, sólo se están enlazando los controles de salida 
de la matriz mezcladora. Los controles de entrada siguen siendo independientes. 
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Ganancia de salida 
El procesador de ganancia de salida contiene controles individuales para los ocho canales de salida. Haga doble clic 
en el bloque de ganancia que se encuentra en el extremo derecho de la fila de cualquier canal de salida para abrir 
esta ventana. 

 

Alternativas de cambio de escala 
Utilice estos botones para fijar la escala de un canal de entrada de modo correspondiente al nivel de salida 
del equipo conectado antes del procesador de sistema. Haga clic para seleccionar entre los niveles de –10 
dBV ó +4 dBu. El valor por omisión es +4 dBu. 

 
+4 dBu seleccionado 

 
-10 dBV seleccionado 

Polaridad de la señal 
Haga clic en este botón para invertir la polaridad de la señal de salida. El valor por omisión es el de 
polaridad normal. 

 
Polaridad normal 

 
Polaridad inversa 

 

Figura 30 −Ventana de ganancia de salida 
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Controles de ganancia 
Utilice estos controles para ajustar el nivel de la señal de cada canal de salida. Primero seleccione la perilla 
del control y luego ajuste el nivel con el Mouse, con las teclas de flecha, o escriba el nivel deseado en el 
cuadro de valores. Para instrucciones completas en cuanto a su funcionamiento, vea la sección Controles 
de nivel en la página 32. La gama de ajuste oscila de +30 dB a -30 dB, y el valor por omisión es de 0 dB, o 
ganancia unitaria. 

Atenuador de salida 
Haga clic en este botón para atenuar la señal de salida en -20 dB El valor por omisión es el de desactivado. 

 
Atenuador activado 

 
Atenuador desactivado 

Silenciamiento de canales 
Haga clic en este botón para silenciar el canal. El valor por omisión es el de desactivado. 

 
Silenciamiento activado 

 
Silenciamiento desactivado 

Rótulo de canal 
Utilice este cuadro de texto para personalizar el rótulo del canal de salida en el diagrama de flujo de señales. 
El valor por omisión es el rótulo “Untitled Out” (Salida sin título) para cada canal de salida. 

Indicador de enlace 
Visualiza el estado de enlace del canal de salida. Todo valor de ajuste que se modifique en un canal 
enlazado afecta a todos los demás canales que pertenezcan al mismo grupo de enlace. Para una 
explicación completa del enlace y los grupos de enlace, consulte la sección Enlace en la página 25. 

 Canal enlazado 

 Canal no enlazado 
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PROCESADORES MODULARES _______________________________  
En esta sección se describen las características y controles específicos de las ventanas de parámetros de 
cada uno de los bloques procesadores. En algunos casos, varios bloques procesadores comparten controles 
casi idénticos, tales como el expansor de atenuación y la compuerta. En estos casos, los procesadores se 
describen como un grupo, utilizando una sola ventana de parámetros como el ejemplo que se ilustra. Los 
ajustes que sólo corresponden a un procesador del grupo se identifican como tales en las descripciones de los 
controles. 

Control automático de ganancia/nivel (AGC) 
El AGC/nivel crea un nivel de volumen más consistente para los casos en los cuales el programa sonoro 
tiende a variar de intensidad. Actúa como un expansor ascendente y compresor combinados, aumentando la 
ganancia de la señal de entrada cuando su nivel es bajo y reduciéndola cuando su nivel es muy alto. 

Nombre del bloque Descripción 
�� AGC Control automático de ganancia 

Función 
Utilice el control de nivel en situaciones en las cuales se desea mantener un nivel de volumen 
constante, tal como el caso de los micrófonos de podio y de atril, en los cuales la distancia del 
conferenciante al micrófono varía. El control de nivel compensa los puntos más silenciosos 
aumentando la ganancia gradualmente. Si el conferenciante entonces habla fuertemente por el 
micrófono, el AGC gradualmente reduce la ganancia. 

Figura 31 − Ventan de control automático
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Características de la ventana de parámetros 
Gráfica de curva de transferencia 
La gráfica de la curva de transferencia muestra el nivel de umbral y relación de compresión como 
elementos gráficos cuya posición puede ajustarse con el Mouse. La curva de transferencia resultante 
representa el cambio en el nivel de salida de la señal. 

Línea de ganancia máxima 
La cantidad máxima de amplificación que el AGC dará a la señal es +12 dB, según lo indica la línea de 
ganancia máxima. Esto evita la modulación no deseada a causa del ruido y los problemas por 
realimentación acústica que pueden ocurrir si se amplifican excesivamente las señales de poca 
intensidad. La línea de ganancia máxima sólo aparece en la gráfica de la curva de transferencia cuando 
la combinación de los valores de umbral, articulación y relación hace que el AGC imponga el límite de 
amplificación de +12 dB. 

Medidor de curva de transferencia 
Cuando se está en modo en vivo, este medidor despliega el nivel de entrada de la señal y el nivel 
relativo de salida, permitiéndole supervisar el efecto que el procesador tiene sobre el material sonoro 
actual. Esta característica puede desactivarse y activarse seleccionando la función [Options>Transfer 
Curve Meter] del menú. Su valor por omisión es de activado. 

Nota: Se puede perjudicar el rendimiento del software si se tiene una cantidad grande de 
medidores activos en el procesador de sistema. Se puede desactivar el medidor de la 
curva de transferencia, o el medidor de reducción de ganancia, o ambos, con el 
menú [Options]. 

Control de umbral 
La posición del control de umbral corresponde con el valor de ajuste del control de umbral. Este 
control puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde superior 
de la gráfica de curva de transferencia, para cambiar el valor umbral. 

Control de relación 
La posición del control de relación corresponde con el valor de ajuste del control de relación. Este 
control puede arrastrarse con el Mouse hacia arriba y abajo, a lo largo del borde derecho de la gráfica 
de curva de transferencia, para cambiar el valor de relación. 

Control de articulación 
La posición del control de articulación corresponde con el valor de ajuste del control de articulación. 
Este control puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde 
inferior de la gráfica de curva de transferencia, para cambiar el valor de articulación. 

Medidor de reducción de ganancia 
Este medidor indica el aumento o reducción total en la ganancia que se logra sobre la señal de 
entrada con los valores de ajuste actuales del procesador. Esta característica puede desactivarse y 
activarse seleccionando la función [Options>Gain Reduction Meter] del menú. Su valor por omisión es 
de activado. 

Controles de ganancia 
Utilice los controles de ganancia para ajustar los niveles de ganancia de entrada y de salida. La gama 
de valores disponibles oscila entre –12 dB y +12 dB, en incrementos de 0,5 dB; el valor por omisión 
es de 0 dB. El valor puede cambiarse siguiendo las convenciones que se explican en la sección 
Controles de nivel de la página 32. 
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Indicador de umbral excedido 
Este indicador aparece iluminado en amarillo cuando la señal que entra al bloque procesador excede 
el umbral especificado. 

 El nivel de la señal ha excedido el umbral 

 El nivel de la señal no ha alcanzado el umbral 

Umbral 
Indica el nivel de ganancia que la señal debe alcanzar antes que el procesador la amplifique. Las 

señales cuyo nivel es inferior al umbral pasan por el procesador con ganancia 
unitaria. El valor puede cambiarse por medio de los botones de flecha, escribiendo un 
valor específico, o usando el control de umbral que está en la parte superior de la 

gráfica de la curva de transferencia. La gama de valores disponibles oscila de -60 VU a +20 VU en 
incrementos de 0,5 VU, con un valor por omisión de 0 VU. 

Relación 
Indica la cantidad de reducción de ganancia que se obtiene en la salida del procesador, 
en relación con el nivel de entrada que excede el valor de articulación. Un ajuste de 4:1, 
por ejemplo, significa que un aumento de 4 dB en el nivel del material sonoro produce un 

aumento de 1 dB en el nivel de salida del procesador. El valor puede cambiarse por medio de los 
botones de flecha, escribiendo un valor específico, o usando el control de relación que está en el lado 
derecho de la gráfica de la curva de transferencia. La gama de valores disponibles oscila de 1:1 a 10:1 
en incrementos de una décima, con un valor por omisión de 2:1. 

Ataque 
Indica el tiempo que el procesador espera antes de responder a un aumento o 
disminución en los niveles de entrada, una vez que la señal de entrada excede el nivel 
de umbral. Los valores disponibles oscilan de 0,2 a 3 s, y el valor por omisión es de 2 

segundos. 

Extinción 
Indica el tiempo que el procesador espera antes de retornar a ganancia unitaria, una 
vez que el nivel de entrada aumenta o disminuye acercándose al valor de articulación. 
Los valores disponibles oscilan de 0,5 a 5 s, y el valor por omisión es de 5 segundos. 

Articulación 
El valor de articulación es el nivel de salida deseado para el AGC. Es un punto de 
transición que determina si la señal de entrada se amplifica o se reduce. Las señales 
cuyo nivel es menor que el de articulación (pero mayores que el valor de umbral) son 

amplificadas, mientras que las señales menores son atenuadas. El valor puede cambiarse por medio 
de los botones de flecha, escribiendo un valor específico, o usando el control de articulación que está 
en la parte inferior de la gráfica de la curva de transferencia. La gama de valores disponibles oscila de 
-60 VU a +20 VU en incrementos de 0,5 VU, con un valor por omisión de 0 VU. 

Ajuste en fábrica 
Haga clic en este botón para reposicionar el procesador a sus valores de ajuste en fábrica. 

Derivación 
Haga clic en este botón para que la señal pase sin ser afectada por el procesador. Cuando se activa 
la derivación, el botón se ilumina en rojo. El valor por omisión es el de desactivado. 

 Derivación activada 

 Derivación desactivada 
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Imagen instantánea 
Esta característica le permite capturar una imagen de la curva de respuesta actual 
haciendo clic en el botón [Take], y luego desplegarla en el fondo de la imagen para 
fines de comparación haciendo clic en el botón [Show]. El botón [Show] se ilumina en 
verde cuando se despliega la imagen instantánea. Para una descripción más detallada 
de la característica de imagen instantánea, vea la sección Imágenes instantáneas en la 
página 34. 
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Compresor/Limitador 
Los compresores y limitadores reducen el nivel de salida de la señal en relación con el nivel de entrada, una 
vez que el nivel de entrada excede cierto valor umbral. El procesador de sistema ofrece los tipos siguientes de 
compresores y limitadores. 

Nombre del bloque Descripción 
��COMP Compresor 
��SFT COMP Compresor de articulación suave 
��LIM Limitador 
��SFT LIM Limitador de articulación suave 
��ST COMP 
��ST SFT COMP 
��ST LIM 
��ST SFT LIM 

Igual que el anterior, para uso en dos canales que 
forman un par estereofónico. 

��PEAK LIM  Limitador de tope de picos (de respuesta anticipada) 

Función 
Utilice el compresor para ajustar la escala de salida de una señal de modo que la misma quede 
adecuada para equipos cuyo rango dinámico es más estrecho, tales como un amplificador, grabadora 
de cinta, o altavoz. Utilice el limitador para proteger el sistema contra descargas repentinas de 
sonidos intensos que pudieran dañar los altavoces. Al retardar la señal 1 ms, el limitador de tope de 
picos tiene un tiempo de acometida de 0 que le permite tener un control aun más preciso sobre los 
picos transitorios. El compresor y limitador funcionan de modo similar; sin embargo, el limitador 
típicamente se ajusta para un tiempo de ataque más rápido y una relación de compresión más alta. 
Los tipos siguientes de procesadores se encuentran disponibles como limitadores y compresores. 

�� Articulación suave – Estos procesadores proporcionan una transición gradual de la señal 
sin compresión a la señal con compresión. Estos procesadores consumen un porcentaje 
mayor de recursos de DSP que los que no tienen la opción de articulación suave. 

Figura 32 − Ventana de limitador de articulacion suave (SFT LIM)
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�� Estéreo – Estos procesadores le permiten preservar la imagen sonora estereofónica 
colocando dos bloques que funcionan como un solo procesador en dos canales 
diferentes. Los dos canales procesadores reaccionan con reducciones idénticas en su 
ganancia cuando la señal de entrada de uno de los canales excede el valor umbral. Estos 
procesadores consumen un porcentaje más alto de recursos de DSP que los procesadores 
monofónicos. 

Características de la ventana de parámetros 
En esta sección se explican las características y controles de parámetros de los compresores y 
limitadores usando el SFT LIM a manera de ejemplo, como se ilustra en la Figura 32. Todos los 
procesadores descritos en esta sección funcionan de modo muy similar. Las diferencias entre sus 
características y sus funciones se indican, según corresponda. 

Gráfica de curva de transferencia 
La gráfica de la curva de transferencia muestra el nivel de umbral y relación de compresión como 
elementos gráficos cuya posición puede ajustarse con el Mouse. La curva de transferencia resultante 
representa el cambio en el nivel de salida de la señal. 

Medidor de curva de transferencia 
Cuando se está en modo en vivo, este medidor despliega el nivel de entrada de la señal y el nivel 
relativo de salida, permitiéndole supervisar el efecto que el procesador tiene sobre el material sonoro 
actual. Esta característica puede desactivarse y activarse seleccionando la función [Options>Transfer 
Curve Meter] del menú. Su valor por omisión es de activado. 

Nota: Se puede perjudicar el rendimiento del software si se tiene una cantidad 
grande de medidores activos en el procesador de sistema. Se puede 
desactivar el medidor de la curva de transferencia, o el medidor de reducción 
de ganancia, o ambos, con el menú [Options]. 

Control de umbral 
La posición del control de umbral corresponde con el valor de ajuste del control de umbral. Este 
control puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde superior 
de la gráfica de curva de transferencia, para cambiar el valor umbral. 

Control de relación 
La posición del control de relación corresponde con el valor de ajuste del control de relación. Este 
control puede arrastrarse con el Mouse hacia arriba y abajo, a lo largo del borde derecho de la gráfica 
de curva de transferencia, para cambiar el valor de relación. 

Medidor de reducción de ganancia 
Este medidor indica la reducción total en la ganancia que se logra sobre la señal de entrada con los 
valores de ajuste actuales del procesador. Esta característica puede desactivarse y activarse 
seleccionando la función [Options>Gain Reduction Meter] del menú. Su valor por omisión es de 
activado. 

Controles de ganancia 
Utilice los controles de ganancia para ajustar los niveles de ganancia de entrada y de salida. La gama 
de valores disponibles oscila entre –12 dB y +12 dB, en incrementos de 0,5 dB; el valor por omisión 
es de 0 dB. El valor puede cambiarse siguiendo las convenciones que se explican en la sección 
Controles de nivel de la página 32. 
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Indicador de umbral excedido 
Este indicador aparece iluminado en amarillo cuando la señal que entra al bloque procesador excede 
el umbral especificado. 

 El nivel de la señal ha excedido el umbral 

 El nivel de la señal no ha alcanzado el umbral 

Umbral 
Indica el nivel de ganancia que la señal debe alcanzar antes que el procesador le 
aplique compresión. El valor puede cambiarse por medio de los botones de flecha, 
escribiendo un valor específico, o usando el control de umbral que está en la parte 

superior de la gráfica de la curva de transferencia. La gama de valores disponibles oscila de -60 VU a 
+20 VU en incrementos de 0,5 VU, con un valor por omisión de 0 VU. 

Relación 
Indica la cantidad de reducción de ganancia que se obtiene en la salida del 
procesador, en relación con el nivel de entrada. Un ajuste de 4:1, por ejemplo, 
significa que un aumento de 4 dB en el nivel del material sonoro produce un aumento 
de 1 dB en el nivel de salida del procesador. El valor puede cambiarse por medio de 

los botones de flecha, escribiendo un valor específico, o usando el control de relación que está en el 
lado derecho de la gráfica de la curva de transferencia. La gama de valores disponibles oscila de 1:1 a 
infinidad:1 en incrementos de una décima, con un valor por omisión de 2:1 para los compresores y de 
10:1 para los limitadores. El limitador de tope de picos tiene una relación fija de infinito:1. 

Ataque 
Indica el tiempo que el procesador espera antes de empezar a reducir la ganancia, 
una vez que el nivel de la señal de entrada excede al nivel de umbral. La gama de 
valores disponibles oscila de 1 ms a 200 ms, con un valor por omisión de 5 ms para 
los compresores y 2 ms para los limitadores. El limitador de tope de picos tiene un 

tiempo de acometida fijo de 0 ms. 

Extinción 
Indica el tiempo que el procesador espera antes de volver a ganancia unitaria, una 
vez que el nivel de la señal de entrada cae por debajo del nivel de umbral. La gama 
de valores disponibles oscila de 50 ms a 1000 ms, con un valor por omisión de 100 

ms para los compresores y 50 ms para los limitadores. 

Articulación 
En los procesadores “suaves”, este control despliega una lista que permite seleccionar una 
compresión “suave” o “fuerte” en la articulación. El valor por omisión es el de suave. En los 
compresores y limitadores estándar, este control se encuentra desactivado. 

Procesador de 
articulación suave 

Seleccione “soft” (suave) o “hard” (fuerte) de 
la lista del menú. 

Procesador 
estándar El control está desactivado. 

Ajuste en fábrica 
Haga clic en este botón para reposicionar el procesador a sus valores de ajuste en fábrica. 
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Derivación 
Haga clic en este botón para que la señal pase sin ser afectada por el procesador. Cuando se activa 
la derivación, el botón se ilumina en rojo. El valor por omisión es el de desactivado. 

 Derivación activada 

 Derivación desactivada 

Imagen instantánea 
Esta característica le permite capturar una imagen de la curva de respuesta actual 
haciendo clic en el botón [Take], y luego desplegarla en el fondo de la imagen para 
fines de comparación haciendo clic en el botón [Show]. El botón [Show] se ilumina en 
verde cuando se despliega la imagen instantánea. Para una descripción más detallada 
de la característica de imagen instantánea, vea la sección Imágenes instantáneas en la 
página 34. 
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Procesadores de articulación suave  
Los ejemplos siguientes ilustran la diferencia entre el ajuste de articulación fuerte y articulación suave 
de compresión. Los demás parámetros en este ejemplo permanecen ajustados a valores idénticos. 

La articulación suave es útil cuando se trabaja con relaciones de 
compresión elevadas. La articulación suave aumenta gradualmente la 
relación de compresión de 1:1, a aproximadamente 12 dB por debajo 
del umbral, hasta la relación especificada, a 
aproximadamente 20 dB por encima del 
umbral. Este aumento gradual en la relación 
hace que el efecto de la compresión sea 
menos notorio que el ajuste de articulación 
fuerte.` 

El ajuste de articulación fuerte inmediatamente 
activa la relación de compresión especificada, 
una vez que el nivel de la señal excede el valor 
umbral.  Este ajuste es particularmente útil para 
un limitador, porque evita que los picos 
transitorios excedan el valor umbral sin afectar 

        los niveles de señal por debajo del umbral. 

Procesadores estereofónicos 
Los procesadores estereofónicos tienen las mismas características y funciones que los monofónicos, 
e incluyen algunas características adicionales. 

�� Las modificaciones hechas a uno de los dos canales de un procesador afectan al otro canal 
también. 

�� Los dos canales procesadores reaccionan con reducciones idénticas en su ganancia cuando 
la señal de entrada de uno de los canales excede el valor umbral. 

�� Los medidores dobles de curva de transferencia despliegan el nivel de entrada del canal A en 
rojo y el del canal B en azul. 

�� Los selectores de medidor le permiten desplegar el medidor de curva de transferencia del 
canal A, del canal B, de ambos canales, o ninguno. 

�� Los dos canales A y B tienen indicadores de nivel umbral excedido. 

Figura 33– Compresión 
con articulación suave  

Figura 34 − Compresión con 
articulación fuerte  

NOTA:   Si la situación requiere el uso de la articulación fuerte, se pueden 
conservar recursos de DSP si se usa un procesador stándar en lugar de 
un procesador de articulación suave. 
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Red de cruce/bifurcador 
Las redes de cruce y bifurcadores dividen una señal de entrada en varias señales de salida. Las redes de 
cruce dividen el espectro de frecuencias de la señal de entrada en varias bandas y encaminan cada banda a 
un canal de salida diferente. Los bifurcadores sencillamente distribuyen la señal de entrada a varios canales 
de salida. 

Nombre del bloque Descripción 

�� XOVER 2 Red de cruce de 2 vías 
�� XOVER 3 Red de cruce de 3 vías 
�� XOVER 4 Red de cruce de 4 vías 
�� XOVER 5 Red de cruce de 5 vías 

Nombre del bloque Descripción 

�� SPLIT 2 Bifurcador de 2 vías 
�� SPLIT 3 Bifurcador de 3 vías 
�� SPLIT 4 Bifurcador de 4 vías 
�� SPLIT 5 Bifurcador de 5 vías 

Función 
Utilice una red de cruce para dividir la gama de frecuencias de la señal de entrada utilizando varios filtros 
de paso de banda, y luego distribuir cada banda a un canal de salida separado para diferentes tipos de 
altavoces. Utilice el bifurcador para enviar una misma señal a varias salidas diferentes. Los bifurcadores 
no tienen ventana de parámetros, puesto que sencillamente distribuyen la señal con ganancia unitaria, sin 
añadir procesamiento alguno. Las redes de cruce y bifurcadores son sólo para procesar canales de salida, 
y no pueden colocarse en las filas de los canales de entrada. Ver la sección Adición de procesadores: 
Redes de cruce y bifurcadores, in la página 23, para más información encuanto a la colocación de bloques 
de red de cruce y bifucadores en el diagrama de flujo deá señales.  

Figura 35 −Ventana de red de cruce  XOVER 4 

Controles de
banda de paso

Rotulos de
canales de salida

Graficador de
respuesta

Puntos de  control de 
frequencias de corte 

Punto de control 
de ganacia  

Banda 
de paso 

Punto de control de red
de cruce
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Figura 36 – Niveles de ganancia de la banda de paso 

Figura 37 – Gráfica normalizadat 

Características de la ventana de parámetros 
En esta sección se explican las características y controles de parámetros de las redes de cruce usando el 
XOVER 4 a manera de ejemplo, como se ilustra en la Figura 35. Las características de las demás redes 
de cruce son idénticas, salvo el número de filtros de banda de paso. 

Graficador de respuesta 
Esta zona de la ventana despliega una representación gráfica de los filtros de banda de paso y puntos 
de cruce, los cuales pueden manipularse haciendo clic y arrastrándolos con el Mouse. 

Bandas de paso 
Cada banda tiene puntos de control en sus esquinas de ambos lados que pueden 
arrastrarse hacia la izquierda o la derecha para ajustar las frecuencias de corte 
superior e inferior de modo individual. También hay un punto de control de ganancia 

en el centro de cada banda que puede arrastrarse hacia arriba o hacia abajo para ajustar el nivel de 
salida de la banda de paso. Cuando se selecciona un punto de control, el círculo que lo representa se 
llena con una bola de color para indicar que es el control activo. Las pendientes de los filtros superior e 
inferior se definen con los controles de banda de paso que están en la sección inferior de la ventana. 

Punto de control de red de cruce 
Este punto de control indica la frecuencia del punto de cruce entre dos 
bandas de paso. Se puede arrastrarlo hacia la izquierda y la derecha para 
ajustar simultáneamente las frecuencias de corte de los filtros cuyas 
pendientes se intersecan. Cuando se selecciona el punto de control de una 
red de cruce, se representa en verde para indicar que es el control activo, y 
los puntos de control de las frecuencias de corte correspondientes se llenan 

para indicar que están seleccionados. Los puntos de control de las frecuencias de corte mantienen 
sus posiciones relativas cuando se desliza el punto de control de la red de cruce. 

Rótulos de canales de salida 
Los rótulos que aparecen en la parte superior de las columnas de los controles de las bandas de paso 
están codificados por colores que corresponden a las curvas de paso de bandas en el graficador de 
respuesta. Indican a cuál canal de salida se encamina cada banda de paso.  

Ajuste y despliegue de ganancias/normalización de gráfica 
Estos botones se seleccionan para desplegar de 
modo alternativo las bandas de paso con sus 
niveles reales de ganancia, y con una 
representación normalizada. El valor por omisión 
es [Set and Show Gains on Plot] (ajuste y 
despliegue de ganancias en gráfica). 
Cuando los niveles de ganancia de las bandas de 
paso son muy diferentes entre sí, el punto de cruce 
aparece desplazado de su posición real, como lo 
ilustra la Figura 36 a la derecha. Utilice el modo de 
gráfica normalizada cuando es necesario ver la 
posición precisa del punto de cruce, como lo 
ilustra la Figura 37, abajo a la derecha. 
• Haga clic en el botón [Set and Show Gains 

on Plot] para desplegar y ajustar los niveles 
de ganancia de las bandas de paso. En este 
modo, los niveles de los filtros se representan 
en el graficador de respuesta y los puntos de 
control de ganancia quedan visibles en las 
bandas de paso. 

• Haga clic en el botón [Normalize Plot] para 
representar las bandas de paso con ganancia 
unitaria con el graficador de respuesta. Este 
modo no afecta los niveles reales de ganancia. 
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Ajuste en fábrica 
Haga clic en este botón para reposicionar el procesador a sus valores de ajuste en fábrica. 

Silenciamiento 
Haga clic en este botón para silenciar el canal de salida. Cuando se activa el silenciamiento, el botón 
se ilumina en rojo. El valor por omisión es el de desactivado. 

 Silenciamiento activado 

 Silenciamiento desactivado

Polaridad 
Haga clic en este botón para invertir la polaridad de la señal que entra al canal de salida. El valor por 
omisión es el de polaridad normal. 

 Polaridad normal 

 Polaridad inversa 

Frecuencia de corte inferior 
Indica el valor de ajuste de la frecuencia de corte inferior de la banda de paso. La 
gama de valores disponibles depende del valor al cual se ha ajustado la frecuencia de 
corte superior, puesto que estas dos frecuencias no pueden traslaparse entre sí. El 

valor puede cambiarse haciendo clic en los botones de flecha, usando el teclado, o escribiendo un 
valor específico. Los valores por omisión de las diferentes bandas de paso se indican a continuación 
para cada tipo de red de cruce. 

Tipo de red de cruce 2 vías 3 vías 4 vías 5 vías 

Banda 1 Desactivado Desactivado Desactivado Desactivado 

Banda 2 2,0 kHz 200 Hz 150 Hz 60 Hz 

Banda 3 − 2,0 kHz 1,5 kHz 150 Hz 

Banda 4 − − 5,0 kHz 1,0 kHz 

Banda 5 − − − 6,0 kHz 

Tipos de filtros inferior/superior 
Esto indica la pendiente de atenuación del filtro correspondiente a la frecuencia de corte 
de la banda de paso. Seleccione un valor del menú, como se indica a continuación. El 

valor por omisión es un filtro Linkwitz-Riley de 24 dB/octava. 

Abreviatura Descripción 

6 Butt Butterworth de 6 dB/oct 

12 Butt Butterworth de 12 dB/oct 

12 Bess Bessel de 12 dB/oct 

12 L-R Linkwitz-Riley de 12 dB/oct 

18 Butt Butterworth de 18 dB/oct 

24 Butt Butterworth de 24 dB/oct 

24 Bess Bessel de 24 dB/oct 

24 L-R Linkwitz-Riley de 24 dB/oct 



Procesadores modulares 

Guía de software de procesador de sistema SHURE P4800 Página 53 de 112 

Nota: Si se usan filtros de 12 dB/octava en bandas adyacentes, se crea un efecto 
supresor en la frecuencia de corte, si se suman las señales de salida entre sí.  
Cuando se alinean los altavoces, procure que la respuesta acústica no tenga 
este efecto supresor.  De ser necesario, utilice el botón de polaridad para invertir 
la polaridad de una de las bandas. 

Frecuencia de corte superior 
Indica el valor de ajuste de la frecuencia de corte superior de la banda de paso. La 
gama de valores disponibles depende del valor al cual se ha ajustado la frecuencia de 

corte inferior, puesto que estas dos frecuencias no pueden traslaparse entre sí. El valor puede 
cambiarse haciendo clic en los botones de flecha, usando el teclado, o escribiendo un valor 
específico. Los valores por omisión de las diferentes bandas de paso se indican a continuación para 
cada tipo de red de cruce. 

Tipo de red de cruce 2 vías 3 vías 4 vías 5 vías 

Banda 1 2,0 kHz 200 Hz 150 Hz 60 Hz 
Banda 2 Desactivado 2,0 kHz 1,5 kHz 150 Hz 
Banda 3 − Desactivado 5,0 kHz 1,0 kHz 
Banda 4 − − Desactivado 6,0 kHz 
Banda 5 − − − Desactivado 

Ganancia 
Indica el valor de ajuste actual de la ganancia del filtro de banda de paso. La gama de valores 
disponibles oscila entre –18 dB y +12 dB, en incrementos de 0,5 dB; el valor por omisión es de 0 dB. 
El valor puede cambiarse siguiendo las convenciones descritas en la sección Controles de nivel de la 
página 32. 

Teclas de control 
Se pueden usar teclas especiales para hacer ajustes finos a la posición de los puntos de control del 
graficador de respuesta. Haga clic en un punto de control para seleccionarlo, y después utilice las 
combinaciones de teclas siguientes. 

Tecla 
Puntos de control de 

red de cruce y 
frecuencias de corte 

Punto de control de ganancia 

← 
Reduce la frecuencia el 
equivalente de un pixel 

en la pantalla 
− 

→ 
Aumenta la frecuencia el 
equivalente de un pixel 

en la pantalla 
− 

↑ − Aumenta la ganancia en 0,5 dB 

↓ − Reduce la ganancia en 0,5 dB 

MAYÚS con ← 
Reduce la frecuencia por 

1/3 octava 
− 

MAYÚS con → Aumenta la frecuencia 
por 1/3 octava 

− 

MAYÚS con ↑ o  
AV PÁG 

− Aumenta la ganancia en 3 dB 

MAYÚS con ↓ o  
RE PÁG − Reduce la ganancia en 3 dB 

BARRA ESPACIADORA  
o clic con botón derecho − Ajusta la ganancia a 0 dB 

Nota: Si se modifica la frecuencia por el equivalente de un pixel en la pantalla, el valor 
de la misma cambia en aproximadamente 1/100 de octava, ó 1%. 
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Filtros atenuadores y limitadores 
Los filtros atenuadores y limitadores son un tipo de ecualizador paramétrico que amplifica o atenúa la 
respuesta general de un sistema a frecuencias altas y bajas, y atenúa progresivamente los extremos superior 
e inferior del espectro de frecuencias. 

Nombre del bloque Descripción 
�� CUT/SHELF Filtros atenuadores/limitadores de frecuencias altas y bajas 

Función 
Utilice este procesador cuando sea necesario combinar filtros atenuadores con ecualización de 
frecuencias altas y bajas de amplio espectro para la sala. Los filtros atenuadores de frecuencias altas 
y bajas ofrecen una amplia variedad de alternativas de pendiente que oscilan entre los –6 dB/octava y 
los –24 dB/octava. También se puede ajustar la pendiente de la frecuencia de corte de los filtros 
limitadores a ya sea 6 dB/octava ó 12 dB/octava. 

Características de la ventana de parámetros 
Graficador de respuesta 
Esta zona de la ventana de parámetros despliega una representación gráfica de los puntos de control 
de los filtros atenuadores y limitadores, los cuales pueden manipularse haciendo clic y arrastrándolos 
con el Mouse. Cuando se abre la ventana de parámetros inicialmente, los puntos de control del filtro 
aparecen en sus posiciones especificadas en fábrica, en los límites extremos superior e inferior del 
espectro. Haga clic en un punto de control para ver su curva de respuesta y ajustar sus parámetros. 

Figura 38 − Ventana de filtro atenuador/limitador 
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Gráfica de respuesta 
Esta curva es una representación gráfica del resultado que producen las posiciones de los puntos de 
control de filtro fijadas en el graficador de respuesta. 

Nota: La curva no representa el efecto cumulativo de los diferentes bloques 
procesadores colocados en la trayectoria de la señal. 

Filtros atenuadores 
Los filtros atenuadores se representan por medio de puntos de control en el borde inferior del 
graficador de respuesta y líneas punteadas verticales dibujadas sobre sus frecuencias centrales. El 
valor determinado en fábrica es “OUT” (desactivado) y el tipo de filtro determinado en fábrica es 
Butterworth de 6 dB/octava. 

Filtros limitadores 
Los filtros atenuadores/limitadores de frecuencias altas y bajas aparecen a lo largo de un eje 
horizontal que está en el centro del graficador de respuesta. El valor determinado en fábrica es “OUT” 
(desactivado) y el tipo de filtro determinado en fábrica es de 6 dB/octava. 

Frecuencia 
Indica la frecuencia del punto de filtro elegido. El valor puede cambiarse 
haciendo clic en los botones de flecha, usando el teclado, o escribiendo un 

valor específico. La gama de frecuencias oscila de 25 Hz a 20 kHz, y el valor determinado en fábrica 
es “OUT” (desactivado). 

Tipo 
Indica el tipo de pendiente del filtro seleccionado. Los valores 
ofrecidos por el menú varían según si el filtro es atenuador o limitador, 
como se indica a continuación. 

Limitador Atenuador 

6 dB/octava* 
12 dB/octava 

Butterworth de 6 dB* 
Butterworth de 12 dB 
Bessel de 12 dB 
Linkwitz-Riley de 12 dB 

Butterworth de 18 dB 
Butterworth de 24 dB 
Bessel de 24 dB 
Linkwitz-Riley de 24 dB 

* Indica el valor fijado en fábrica 

Ganancia 
Indica el valor de ajuste actual de la ganancia del filtro limitador seleccionado. 
La gama de valores disponibles oscila entre –18 dB y +18 dB, en incrementos 

de 0,5 dB; el valor por omisión es de 0 dB. El valor puede cambiarse siguiendo las convenciones 
descritas en la sección Controles de nivel de la página 32.  Cuando se trabaja con un filtro atenuador, 
este control queda desactivado y despliega la palabra “CUT”. 

Suprimir 
Haga clic en este botón para volver a ajustar el filtro a los valores determinados en fábrica. 
Se abre el cuadro de diálogo de opciones para suprimir (Figura 48 en la página 68), el cual 
le brinda la alternativa de suprimir los ajustes de todos los filtros, o suprimir sólo los ajustes 
del filtro seleccionado. 
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Derivación 
Haga clic en este botón para que la señal pase sin ser afectada por el procesador. Cuando se activa 
la derivación, el botón se ilumina en rojo. El valor por omisión es el de desactivado. 

 Derivación activada 

 Derivación 
desactivada 

Imagen instantánea 
Esta característica le permite capturar una imagen de la curva de respuesta actual 
haciendo clic en el botón [Take], y luego desplegarla en el fondo de la imagen para 
fines de comparación haciendo clic en el botón [Show]. El botón [Show] se ilumina en 
verde cuando se despliega la imagen instantánea. Para una descripción más 
detallada de la característica de imagen instantánea, vea la sección Imágenes 
instantáneas en la página 34. 

Importación de archivos ASCII 
Vea la página 79 para una descripción de cómo importar datos en la gráfica usando 
SIA Smaart y Gold Line TEF en la gráfica de respuesta. 

 
Ajuste fino de los parámetros 
Los parámetros del filtro seleccionado pueden ajustarse con precisión usando cualquiera de los 
métodos siguientes: 

�� Escriba un número en cualquiera de los cuadros de valores de parámetros 
�� Utilice los botones de flecha (o el menú) junto a los cuadros de valores de parámetros 
�� Utilice las teclas de control 

Teclas de control 
Se pueden usar las combinaciones de teclas siguientes para hacer ajustes finos al filtro seleccionado. 

Tecla Resultado 

← Reduce la frecuencia el equivalente de un pixel en la pantalla 

→ Aumenta la frecuencia el equivalente de un pixel en la pantalla 

↑ Aumenta la ganancia en 0,5 dB 

↓ Reduce la ganancia en 0,5 dB 

MAYÚS con ← Reduce la frecuencia por 1/3 octava 

MAYÚS con → Aumenta la frecuencia por 1/3 octava 

MAYÚS con ↑ o  
AV PÁG 

Aumenta la ganancia en 3 dB 

MAYÚS con ↓ o  
RE PÁG 

Reduce la ganancia en 3 dB 

BARRA ESPACIADORA  
o clic con botón 

derecho 
Ajusta la ganancia a 0 dB 

SUPR Reposiciona el o los filtros seleccionados a sus valores de ajuste 
en fábrica 

Nota: Si se modifica la frecuencia por el equivalente de un pixel en la pantalla, el valor 
de la misma cambia en aproximadamente 1/100 de octava, ó 1%.  
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Copiar y pegar 
Los valores de ajuste de los puntos de control del filtro pueden copiarse y pegarse entre ventanas 
de filtros atenuadores y limitadores.  

Para copiar y pegar filtros: 
1. Haga clic en un filtro para seleccionarlo, o seleccione varios filtros usando uno de los 

métodos siguientes: 
�� CTRL+clic. 
�� Utilice el comando [Edit>Select All] del menú. 

2. Seleccione el comando [Edit>Copy] del menú. 
3. Abra la ventana del filtro atenuador y limitador en donde se desea pegar los valores. 
4. Seleccione el comando [Edit>Paste] del menú. 

Nota: Cuando varios filtros forman parte de un grupo seleccionado, se resaltan en 
rosado y los valores de sus parámetros quedan enclavados. Para quitar una 
selección de unidades múltiples seleccionadas, haga clic en cualquier control de 
la ventana de parámetros, o en un filtro que no forme parte del grupo 
seleccionado. 
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Retardo 
El procesador de retardo almacena la señal temporalmente en la memoria de retardo, y la deja pasar luego de 
transcurrido el intervalo especificado. El procesador de sistema ofrece los tipos siguientes de retardo: 

Nombre del bloque Descripción 
�� DLY5ms  Retardo de 5 milisegundos máximo 
�� DLY150ms  Retardo de 150 milisegundos máximo 
�� DLY500ms  Retardo de 500 milisegundos máximo 
�� DLY2s Retardo de 2 segundos máximo 

Función 
Utilice los bloques de retardo para alinear las señales sonoras reproducidas por altavoces diferentes 
de modo que lleguen simultáneamente a los oídos de los miembros de la audiencia. Los bloques de 
retardo también pueden usarse para eliminar problemas de cancelación de fase entre altavoces 
instalados. El retardo puede calcularse por tiempo, por distancia y en incrementos de la temperatura 
ambiente.  

Nota: Cada tipo de bloque de retardo consume la cantidad máxima de memoria de retardo 
que indica el nombre del bloque, sin importar cuánto sea el retardo que se utiliza en 
realidad. Para conservar los recursos del procesador de sistema, seleccione el 
bloque de retardo cuyo tiempo se aproxime más al tiempo de retardo requerido. 

Características de la ventana de parámetros 
En esta sección se explican las características de los procesadores de retardo usando el DLY150 a 
manera de ejemplo, como se ilustra en la Figura 39. Las características de los demás bloques de 
retardo son idénticas, salvo el tiempo máximo de retardo que ofrecen. 

Unidades 
Utilice este control para especificar si los parámetros 
deben expresarse en unidades del sistema inglés o 

métrico. El valor por omisión es inglés. 

Tiempo 
Utilice este control para especificar el retardo en milisegundos. La gama de 
valores oscila entre 0 y el tiempo máximo de retardo del bloque, en este 
caso, 150 ms. El valor por omisión es 0. 

Figura 39 −Ventana de unidades  de retardo
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Distancia 
Utilice este control para especificar el retardo según la distancia. La gama de 
valores varía, dependiendo del tiempo máximo de retardo; el valor por omisión 
siempre es cero. Seleccione la unidad de medida apropiada con los botones 

que están a la derecha del control. Se puede seleccionar pulgadas, pies o metros: La unidad de 
medida por omisión es pulgadas. Cuando se seleccionan unidades del sistema inglés, se puede 
seleccionar entre pulgadas y pies. Cuando se seleccionan unidades métricas, la distancia se expresa 
en metros. El valor por omisión es pulgadas. 

Temperatura de aire 
Utilice este control cuando se fija el retardo según la 
distancia, puesto que la velocidad del sonido se ve 

afectada por la temperatura del aire. La gama de valores oscila de -13°F a 122°F, ó -25°C a 50°C. 
Seleccione la unidad de medida apropiada con los botones que están a la derecha del control. La 
unidad de medida por omisión es grados Fahrenheit. Cuando se seleccionan unidades del sistema 
inglés, la temperatura se expresa en grados Fahrenheit. Cuando se seleccionan unidades del sistema 
métrico, la temperatura se expresa en grados Celsius. El valor por omisión es Fahrenheit. 

Derivación 
Haga clic en este botón para que la señal pase sin ser afectada por el procesador. Cuando se activa 
la derivación, el botón se ilumina en rojo. El valor por omisión es el de desactivado. 

 Derivación activada 

 Derivación desactivada 

Suprimir 
 Haga clic en este botón para reposicionar el procesador a sus valores de ajuste en fábrica. 
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Reductor digital de realimentación (DFR) 
El DFR utiliza el algoritmo de filtro supresor adaptable patentado por Shure para detectar la realimentación 
automáticamente e instalar filtros supresores de banda estrecha. El procesador de sistema ofrece los tipos 
siguientes de DFR: 

Nombre del bloque Descripción 
�� DFR5  Reductor digital de realimentación de 5 bandas 
�� DFR10  Reductor digital de realimentación de 10 bandas 

Función 
Utilice el DFR como el procesador inicial de cualquier canal de entrada que reciba la señal de un 
micrófono, en donde la realimentación causa problemas. Cada vez que el DFR detecte 
realimentación, activa un filtro dinámico. Empieza insertando un filtro supresor de –3 dB, 1/10 de 
octava centrado en la frecuencia de realimentación. Después aumenta la profundidad de supresión 
del filtro en incrementos de 3 dB, hasta –18 dB, hasta que se elimine la realimentación. También se 
pueden definir filtros fijos en frecuencias características de la sala. Cuando el DFR detecta 
realimentación a la frecuencia de un filtro fijo, aumenta su nivel de atenuación por medio de un filtro 
dinámico.  

Características de la ventana de parámetros 
En esta sección se explican las características y controles de parámetros del reductor digital de 
realimentación usando el DFR10 a manera de ejemplo, como se ilustra en la Figura 40. Las 
características del DFR son idénticas, salvo el número de filtros supresores que tiene disponibles.  

Gráfica de respuesta 
Esta curva es una representación gráfica del efecto combinado de los filtros supresores activos en el 
procesador (resaltados en amarillo). 

Nota: La curva no representa el efecto cumulativo de los diferentes bloques 
procesadores colocados en la trayectoria de la señal. 

Figura 40 − Ventana de reductor de realimentación DFR10  

Gráfica de respuesta 
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Frecuencia 
Indica la frecuencia del filtro elegido. El valor puede cambiarse haciendo clic 
en los botones de flecha, usando el teclado, o escribiendo un valor específico. 

La gama de frecuencias oscila de 25 Hz a 20 kHz, y el valor determinado en fábrica es “OUT” 
(desactivado). 

Profundidad 
Indica la reducción en la ganancia que introduce el filtro elegido. La gama de 
valores disponibles de ganancia oscila entre 0 dB y –18 dB, en incrementos de 
0,5 dB; el valor por omisión es de 0 dB. 

Tipo 
Indica el tipo de ancho de banda del filtro elegido. Seleccione “High Q” (Q 
alto) o “Low Q” (Q bajo) del menú. El valor por omisión es “Low Q”. 

Filtros supresores de realimentación 
Los controles de los filtros supresores de realimentación se despliegan por 
medio de una hilera de indicadores tipo LED. Se puede especificar el 
número de filtros fijos y dinámicos deslizando los corchetes rojos hacia la 
izquierda o la derecha con el Mouse. Los filtros activos se representan en 
amarillo y aparecen en la gráfica de respuesta. Consulte la sección 
Designación de filtros en la página 63 para más explicaciones. 

FIXED Estos filtros permanecen en sus frecuencias actuales, sin 
importar si se detecta realimentación. 

DYNAMIC El DFR automáticamente coloca estos filtros cuando detecta 
realimentación. 

Bloquear 
Haga clic en este botón para evitar tanto la colocación de filtros nuevos como el aumento en la 
atenuación de filtros existentes. Utilice esta función para impedir que el DFR coloque filtros nuevos, 
para material sonoro que contenga realimentación deseada, o sonidos muy semejantes a la 
realimentación (tales como efectos de guitarra, tonos sintetizados, y órganos de tubos). 

 Bloqueo activado 

 Bloqueo desactivado 

Suprimir 
Haga clic en este botón para volver a ajustar el filtro a los valores determinados en fábrica. 
Se abre el cuadro de diálogo de opciones para suprimir (Figura 44 en la página 60), el cual 
le brinda la alternativa de suprimir los ajustes de todos los filtros, o suprimir sólo los ajustes 
del filtro seleccionado. 

Derivación 
Haga clic en este botón para que la señal pase sin ser afectada por el procesador. Cuando se activa 
la derivación, el botón se ilumina en rojo. El valor por omisión es el de desactivado. 

 Derivación activada 

 Derivación desactivada 
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Imagen instantánea 
Esta característica le permite capturar una imagen de la curva de respuesta actual 
haciendo clic en el botón [Take], y luego desplegarla en el fondo de la imagen para 
fines de comparación haciendo clic en el botón [Show]. El botón [Show] se ilumina en 
verde cuando se despliega la imagen instantánea. Para una descripción más detallada 
de la característica de imagen instantánea, vea la sección Imágenes instantáneas en la 
página 34. 

Configuración básica del DFR 
Hay dos métodos básicos que permiten configurar el DFR para reducir la realimentación: el método de 
identificación de frecuencias de realimentación y el método de funcionamiento seguro, descritos a 
continuación. Ambos tienen validez en situaciones distintas. 

Nota: El DFR (o cualquier otro sistema de filtros supresores) ayuda a reducir la 
realimentación, pero no puede eliminarla por completo. En un sistema típico, 
después de haber instalado de 4 a 8 filtros de supresión se llega a un punto en 
el cual el rendimiento empieza a perjudicarse. Se puede anticipar una mejora de 
6 a 9 dB en la ganancia antes del punto de realimentación en un sistema típico. 
Para mejorar el rendimiento del sistema de sonido más allá de estos niveles, 
posiblemente será necesario mejorar el entorno acústico. 

�� Método de identificación de frecuencias de realimentación − Con este método se 
utiliza el DFR como medida preventiva contra la realimentación en canales de entrada 
que funcionan cerca del punto de realimentación y que requieren un margen adicional de 
estabilidad. Al usar este método, se eleva la ganancia del canal de entrada más allá de 
su nivel normal para provocar la realimentación en el sistema. El DFR entonces activa los 
filtros apropiados. Después, cuando se reduce la ganancia de entrada a su nivel 
apropiado, el sistema queda estable y utilizable. 

�� Método de funcionamiento seguro − Con este método se usa el DFR como medida 
adicional de prevención de la realimentación en un sistema que funciona de modo 
estable. Sencillamente se coloca el procesador DFR en la trayectoria de la señal, sin 
definir ninguno de sus parámetros. Este método se usa en sistemas que ya tienen 
suficiente ganancia antes del punto de realimentación, pero que requieren protección 
contra la realimentación que se produce ocasionalmente debido al uso de micrófonos no 
estacionarios o controles de ganancia ajustables por el usuario. 

Para identificar las frecuencias de realimentación del sistema:  
1. Suprima los filtros activos haciendo clic en el botón [Clear]. 
2. Active todos los micrófonos.  
3. Observe la ventana del DFR mientras se aumenta lentamente la ganancia del sistema. Cuando el 

DFR detecta realimentación acústica, coloca filtros nuevos, los cuales se representan en la 
ventana del DFR como puntos amarillos.  

4. Continúe aumentando la ganancia de 3 a 6 dB más allá del nivel que normalmente se usa en el 
sistema, o hasta que se hayan colocado de 4 a 8 filtros. Reduzca la ganancia de 3 a 6 dB hasta el 
valor deseado para estabilizar el sistema.  

5. Configure los filtros colocados como “fijos” (consulte Designación de filtros fijos y dinámicos, más 
adelante). Los filtros dinámicos restantes se colocarán según se los necesite cuando el sistema 
se encuentre en uso.  

Nota: Los filtros fijos pueden copiarse a un bloque de ecualizador paramétrico (PEQ) 
para permitir la colocación de un número mayor de filtros dinámicos en la 
ventana del DFR. 
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Modo de retención 
El DFR retiene el estado de todos sus filtros cuando se cambia de configuración prefijada, o al 
desconectar y volver a conectar la alimentación. Sin embargo, es posible configurar el DFR para 
borrar ciertos filtros cuando se desconecta la alimentación o si se cambia la configuración prefijada. 
Después de haber fijado todos los filtros que se desea configurar como permanentes, active el modo 
de retención. Los filtros colocados después de haber seleccionado el modo de retención serán 
borrados cuando se cambie la configuración prefijada o si se desconecta la alimentación. 

Para activar el modo de retención: 
1. Identifique las frecuencias de realimentación del sistema de la forma descrita en la sección 

anterior. 
2. Seleccione el comando [Options>Hold Mode] del menú. 

Designación de filtros 
El DFR utiliza dos métodos para designar los filtros, los cuales se describen a continuación. 

�� Fijos – Se pueden especificar las frecuencias específicas de los filtros supresores, o 
designar como fijos los filtros dinámicos colocados automáticamente por el DFR. 
Permanecen fijos sin importar si se detectan otras frecuencias de realimentación. Sin 
embargo, si el DFR detecta realimentación adicional a esa misma frecuencia, se coloca un 
filtro dinámico para aumentar la profundidad de supresión. 

�� Dinámicos – Las frecuencias y el nivel de supresión son completamente automáticos. Un 
filtro supresor dinámico aumenta su nivel de atenuación como respuesta a un aumento 
en la realimentación, y a medida que se detectan frecuencias de realimentación nuevas, 
el DFR cambia la posición de los filtros dinámicos, avanzando de los más antiguos a los 
más nuevos. 

El DFR le permite seleccionar cuántos filtros del número total disponible permanecerán fijos y cuántos 
se designarán dinámicamente según se detecte la realimentación. Utilice un número mayor de filtros 
fijos en canales de entrada conectados a micrófonos estacionarios. En esta situación, las 
características acústicas de la sala definen las frecuencias dominantes de realimentación, las cuales 
no cambian de modo significativo. Utilice un número mayor de filtros dinámicos en canales de entrada 
conectados a micrófonos inalámbricos o de mano. En esta situación, las frecuencias de 
realimentación cambian significativamente cuando el usuario del micrófono se desplaza por la sala o 
por el escenario.  

Se puede designar la cantidad de filtros fijos y dinámicos utilizando una de las dos técnicas que se 
explican a continuación:  

Para usar el cuadro de diálogo de opciones de filtros 
fijos/dinámicos: 

1. Seleccione [Options>Fixed filters allocation] del menú de la 
ventana del DFR. 

2. Se despliega el cuadro de diálogo de opciones de filtros 
fijos/dinámicos. 

3. Escriba el número de filtros fijos que se desea designar. El 
número de filtros dinámicos se ajusta de modo 
correspondiente. 

4. Haga clic en [OK]. 

Para cambiar la designación de filtros con el Mouse: 
1. Coloque el cursor entre los corchetes rojos, como se 

indica en la Figura 42. 
2. El cursor se visualiza como el símbolo de ajuste de 

tamaño horizontal: 

Figura 41 − Opciones de filtros 
fijos/dinámicos 

Figura 42 − Cambio de designación 
de filtros con el mouse  

Coloque el cursor aqui… 

…o  aqui 
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3. Haga clic y arrastre hacia la izquierda para aumentar el número de filtros dinámicos, o hacia la 
derecha para aumentar el número de filtros fijos. 

Filtros de factor Q alto vs. factor Q bajo 
El DFR ofrece filtros supresores de dos anchos diferentes, como 
se ilustra a continuación en la Figura 43. Los filtros con factor Q 
alto permanecen estrechos a medida que se aumenta su nivel de 
atenuación, suprimiendo de esta manera una cantidad mínima de 
la señal. Esto mantiene alta la calidad del sonido, y es apropiado 
para la mayoría de los casos, incluyendo la reproducción de 
música. 

En el caso de los filtros de factor Q bajo, la banda suprimida 
retiene su forma a medida que se aumenta el nivel de atenuación, 
lo cual atenúa una banda más amplia de frecuencias. Este ajuste 
aumenta la estabilidad del sistema, pero perjudica ligeramente la 
calidad del sonido. Esta configuración es adecuada para 
situaciones con conferencistas. 

�� Para modificar el ajuste de un filtro existente, haga clic en el filtro para seleccionarlo y 
utilice el menú [Type]. 

�� Utilice el menú [Options] para seleccionar el factor Q alto o bajo para todos los filtros 
dinámicos nuevos que se coloquen. 

Adición, modificación y eliminación de filtros 

Para colocar o modificar manualmente un filtro supresor fijo: 
1. Haga clic en un filtro fijo activo (resaltado en amarillo) o, para activar un filtro nuevo, seleccione el 

filtro inmediatamente a la derecha del último filtro activo. 
2. Ajuste la frecuencia suprimida, la profundidad y el tipo según sea necesario. 
3. Las modificaciones hechas se reflejan en la gráfica de respuesta. 

Nota: Sólo se puede seleccionar un filtro activo, o el filtro inactivo adyacente, avanzando 
de izquierda a derecha. 

Para eliminar todos los filtros supresores activos: 
1. Haga clic en el botón [Clear]. 
2. Se visualiza el cuadro de diálogo de opciones para 

suprimir. 
3. Seleccione [Clear All Filters] y haga clic en [OK]. 
4. Esto elimina todos los filtros supresores y deja la gráfica de 

respuesta horizontal. 

– OR– 

1. Seleccione el comando [Edit>Select All] del menú. 
2. Todos los filtros colocados se resaltan en rosado para 

indicar que han sido seleccionados. 
3. Pulse la tecla SUPR. 

Para eliminar filtros supresores específicos 
1. Haga clic en el indicador de un filtro para seleccionarlo, o mantenga pulsada la tecla CTRL y haga 

clic en varios filtros para seleccionarlos. 
2. Pulse la tecla SUPR – O – 

Figura 43 − Opciones de ancho de 
banda de suspension  

Q alto 

Q bajo

Figura 44 − Cuadro de diálogo de 
opciones para suprimir  
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Haga clic en el botón [Clear] para abrir el cuadro de diálogo de opciones para suprimir y 
seleccione la opción [Clear One Filter], la cual también actúa sobre varios filtros seleccionados. 

Copiar y pegar 
Los filtros supresores pueden copiarse y pegarse entre ventanas de procesadores DFR.  

Para copiar y pegar filtros: 
1. Haga clic en un filtro para seleccionarlo, o seleccione varios filtros usando uno de los métodos 

siguientes: 
�� CTRL+clic. 
�� Utilice el comando [Edit>Select All] del menú. 

2. Seleccione el comando [Edit>Copy] del menú. 
3. Abra la ventana del procesador de DFR en donde se desea pegar los valores del filtro. 
4. Seleccione el comando [Edit>Paste] del menú. 

Nota: Cuando varios filtros forman parte de un grupo seleccionado, se resaltan en rosado y 
los valores de sus parámetros quedan enclavados. Para quitar una selección de 
unidades múltiples seleccionadas, haga clic en cualquier control de la ventana de 
parámetros, o en un filtro que no forme parte del grupo seleccionado. 

El software del procesador de sistema también ofrece la capacidad exclusiva de copiar y pegar cualquier 
filtro activo de la ventana del DFR a la ventana de un ecualizador paramétrico (PEQ o PEQ + CS).  Al 
desplazar los filtros fijos a la ventana de un PEQ, se pueden designar más filtros dinámicos con el 
bloque de DFR.  

Nota: Los filtros de DFR que se copian a un bloque de PEQ posiblemente no serán 
idénticos al filtro original, sino que utilizan un ancho de banda que mejor se aproxime 
al del filtro original. 
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Compuerta/expansor de atenuación 
La compuerta y el expansor de atenuación reducen el nivel de salida de la señal, en relación con el de 
entrada, una vez que el nivel de la señal de entrada cae por debajo de un umbral determinado. 

Nombre del bloque Descripción 
�� DOWN EXP Expansor de atenuación 
�� GATE Compuerta 

Función 
Utilice estos procesadores para reducir o eliminar los ruidos de fondo no deseados. La compuerta 
silencia la señal de entrada una vez que su nivel cae por debajo de un umbral determinado. El 
expansor de atenuación reduce gradualmente la ganancia una vez que el nivel de la señal de entrada 
cae por debajo de un umbral determinado, proporcionando una reducción menos perceptible que la 
compuerta. La compuerta es ideal para eliminar ruidos de nivel bajo que de otro modo causarían 
distracciones durante el programa. Seleccione el expansor de atenuación para reducir el ruido de 
fondo en situaciones en las cuales la compuerta interrumpiría el programa. 

Características de la ventana de parámetros 
En esta sección se explican las características y controles de parámetros del expansor de atenuación 
y la compuerta usando el DOWN EXP a manera de ejemplo, como se ilustra en la Figura 45. Estos 
dos procesadores funcionan de modo muy similar. Las diferencias entre sus características y sus 
funciones se indican, según corresponda. 

Gráfica de curva de transferencia 
La gráfica de la curva de transferencia muestra el nivel de umbral y relación de compresión como 
elementos gráficos cuya posición puede ajustarse con el Mouse. La curva de transferencia resultante 
representa el cambio en el nivel de salida de la señal. 

Figura 45 − Ventana de Expansor de Atenuación  

Controles de  
ganancia  Gráfica de curva de 

transferencia 

Control de umbral  

Control de relación  

Medidor de reducción  
de ganancia  

Medidor de curva de transferencia  
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Medidor de curva de transferencia 
Cuando se está en modo en vivo, este medidor despliega el nivel de entrada de la señal y el nivel 
relativo de salida, permitiéndole supervisar el efecto que el procesador tiene sobre el material sonoro 
actual. Esta característica puede desactivarse y activarse seleccionando la función [Options>Transfer 
Curve Meter] del menú. Su valor por omisión es de activado. 

Nota: Se puede perjudicar el rendimiento del software si se tiene una cantidad grande 
de medidores activos en el procesador de sistema. Se puede desactivar el 
medidor de la curva de transferencia, o el medidor de reducción de ganancia, o 
ambos, con el menú [Options]. 

Control de umbral 
La posición del control de umbral corresponde con el valor de ajuste del control de umbral. Este 
control puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde superior 
de la gráfica de curva de transferencia, para cambiar el valor umbral. 

Control de relación 
La posición del control de relación corresponde con el valor de ajuste del control de relación. Este 
control puede arrastrarse con el Mouse hacia la izquierda y la derecha, a lo largo del borde inferior de 
la gráfica de curva de transferencia, para cambiar el valor de relación. 

Medidor de reducción de ganancia 
Este medidor indica el aumento o reducción total en la ganancia que se logra sobre la señal de 
entrada con los valores de ajuste actuales del procesador. Esta característica puede desactivarse y 
activarse seleccionando la función [Options>Gain Reduction Meter] del menú. Su valor por omisión es 
de activado. 

Controles de ganancia 
Utilice los controles de ganancia para ajustar los niveles de ganancia de entrada y de salida. La gama 
de valores disponibles oscila entre –12 dB y +12 dB, en incrementos de 0,5 dB; el valor por omisión 
es de 0 dB. El valor puede cambiarse siguiendo las convenciones que se explican en la sección 
Controles de nivel de la página 32. 

Indicador de umbral excedido 

 El nivel de la señal ha excedido el umbral 

 El nivel de la señal no ha alcanzado el umbral 

Este indicador aparece iluminado en amarillo 
cuando la señal que entra al bloque 
procesador excede el umbral especificado. 

Umbral 
Indica el nivel debajo del cual debe caer la señal de entrada antes que el procesador la atenúe. El valor 

puede cambiarse por medio de los botones de flecha, escribiendo un valor específico, o 
usando el control de umbral que está en el borde superior de la gráfica de la curva de 
transferencia. La gama de valores oscila de –80,0 VU a 0 VU en incrementos de 0,5 VU, y 

su valor por omisión es de –65,0 VU para la compuerta y –40,0 VU para el expansor de atenuación. 

Relación 
Indica la cantidad de reducción de ganancia que se obtiene en la salida del procesador, en relación 

con el nivel de entrada. Un ajuste de 4:1, por ejemplo, significa que una reducción de 1 
dB en el nivel del material sonoro produce una reducción de 4 dB en el nivel de salida 
del procesador. El valor puede cambiarse por medio de los botones de flecha, 
escribiendo un valor específico, o usando el control de relación que está en el borde 

inferior de la gráfica de la curva de transferencia. La gama de valores disponibles oscila de 1:1 a 
infinidad:1 en incrementos de una décima, con un valor por omisión de infinidad:1 para la compuerta y 
de 4:1 para el expansor de atenuación. 
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Ataque 
Indica el tiempo que el procesador espera antes de volver a ganancia unitaria, una 
vez que el nivel de la señal de entrada excede el nivel de umbral. La gama de valores 
disponibles oscila de 1 ms a 200 ms, con un valor por omisión de 2 ms para la 

compuerta y 20 ms para el expansor de atenuación. 

Extinción 
Indica el tiempo que toma el procesador para alcanzar el nivel de reducción de 
ganancia especificado. El valor puede cambiarse haciendo clic en los botones de 
flecha o escribiendo un valor específico. La gama de valores disponibles oscila de 50 

ms a 1000 ms, con un valor por omisión de 100 ms para la compuerta y 50 ms para el expansor de 
atenuación.  

Retención 
Indica el tiempo que el procesador espera antes de empezar a reducir la ganancia, una 
vez que el nivel de la señal de entrada cae por debajo del nivel de umbral. El valor 
puede cambiarse haciendo clic en los botones de flecha o escribiendo un valor 

específico. Los valores disponibles oscilan de 0 a 500 ms, y el valor por omisión es de 0. 

Ajuste en fábrica 
Haga clic en este botón para reposicionar el procesador a sus valores de ajuste en fábrica. 

Derivación 
Haga clic en este botón para que la señal pase sin ser afectada por el procesador. Cuando se activa 
la derivación, el botón se ilumina en rojo. El valor por omisión es el de desactivado. 

 Derivación activada 

 
Derivación 
desactivada 

Imagen instantánea 
Esta característica le permite capturar una imagen de la curva de respuesta actual 
haciendo clic en el botón [Take], y luego desplegarla en el fondo de la imagen para 
fines de comparación haciendo clic en el botón [Show]. El botón [Show] se ilumina en 
verde cuando se despliega la imagen instantánea. Para una descripción más detallada 
de la característica de imagen instantánea, vea la sección Imágenes instantáneas en la 
página 34. 
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Ecualizador gráfico 
Los ecualizadores gráficos distribuyen un conjunto fijo de filtros de banda ancha y de factor Q constante a lo 
largo del espectro de frecuencias, cada uno de los cuales tiene controles individuales de 
amplificación/atenuación. El procesador de sistema ofrece los tipos siguientes de ecualizadores gráficos: 

Nombre del bloque Descripción 
�� GEQ10  Ecualizador gráfico de 10 bandas 
�� GEQ30  Ecualizador gráfico de 30 bandas 

Función 
Utilice este procesador para la ecualización de banda ancha de una sala. El ancho de banda total del 
procesador y el ancho de banda de los filtros individuales dependen del tipo de ecualizador gráfico 
que se seleccione. El GEQ10 tiene diez filtros de una octava entre 31,5 Hz y 16 kHz, mientras que el 
GEQ30 tiene treinta filtros de 1/3 de octava entre 25 Hz y 20 kHz.  

Características de la ventana de parámetros 
En esta sección se explican las características y controles de parámetros del ecualizador paramétrico 
usando el GEQ10 a manera de ejemplo, como se ilustra en la Figura 46. Las características del 
GEQ30 son idénticas, salvo el número de bandas que tiene disponibles y la gama total de frecuencias 
que cubren.  

Controles de nivel de bandas de frecuencias 
Los controles de nivel de cada banda de frecuencias pueden ajustarse arrastrando sus perillas hacia arriba 
o hacia abajo con el Mouse o haciendo clic en el punto de la escala graduada correspondiente al nivel 
deseado. Se puede amplificar o atenuar cualquier banda entre –18 dB y +12 dB en incrementos de 0,5 dB. 
Para más información en cuanto al ajuste de los controles de nivel, consulte la sección Controles de nivel  
en la página 32. 

Gráfica de respuesta 
Esta curva presenta una representación gráfica de los resultados que producen los ajustes de las 
bandas de frecuencias, y el tipo de factor Q seleccionado para el filtro. 

Figura 46 − Ventana de equalizador GEQ10

Figure 46 − GEQ10 Window
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Nota: La curva no representa el efecto cumulativo de los diferentes bloques 
procesadores colocados en la trayectoria de la señal. 

Frecuencia 
Indica la banda de frecuencias actual que se está ajustando. Se puede 
seleccionar una banda de frecuencias diferente haciendo clic en los botones de 
flecha. Por omisión, la selección es la banda de frecuencias más bajas. 

Ganancia 
Indica el valor de ajuste actual de la ganancia de la banda de frecuencias 
seleccionada. La gama de valores disponibles oscila entre –18 dB y +12 dB, en 
incrementos de 0,5 dB; el valor por omisión es de 0 dB. El valor puede 
cambiarse siguiendo las convenciones que se explican en la sección Controles 
de nivel de la página 32. 

Tipo de factor Q del filtro 
Indica el tipo de factor Q que se ha designado para todas las bandas de 
frecuencias. Utilice la lista del menú para cambiar el valor. El valor por 
omisión es “combining” (combinador). 

Combining Calcula un promedio de las pendientes entre las bandas de 
frecuencias, creando una curva de ecualización uniforme. 

Non-Combining Aísla el resultado del control de cada banda de frecuencias, 
proporcionando un ajuste más independiente de la ganancia. 

Derivación 
Haga clic en el botón de derivación para activarla o desactivarla. Cuando se activa la derivación, el 
botón se ilumina en rojo. El valor por omisión es el de desactivado. 

 Derivación activada 

 Derivación desactivada 

Respuesta plana 
Haga clic en este botón para fijar la ganancia de todas las bandas de frecuencias en 
cero. 

Importación de archivos ASCII 
Consulte la página 79 para una descripción de cómo importar datos en la gráfica de 
respuesta usando SIA Smaart y Gold Line TEF. 

 

Imagen instantánea 
Esta característica le permite capturar una imagen de la curva de respuesta actual 
haciendo clic en el botón [Take], y luego desplegarla en el fondo de la imagen para 
fines de comparación haciendo clic en el botón [Show]. El botón [Show] se ilumina en 
verde cuando se despliega la imagen instantánea. Para una descripción más detallada 
de la característica de imagen instantánea, vea la sección Imágenes instantáneas en la 
página 34. 

Copiar y pegar 
Se puede usar el menú [Edit] para copiar y pegar valores de ajuste de bandas de frecuencias entre 
ecualizadores gráficos del mismo tipo. 

Nota: No es posible pegar valores de ajuste entre procesadores GEQ10 y GEQ30. 
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Ecualizador paramétrico 
Los ecualizadores paramétricos le permiten especificar la colocación, tipo y ancho de banda de varios filtros en 
cualquier parte del espectro de frecuencias entre 25 Hz y 20 kHz. El procesador de sistema ofrece los tipos 
siguientes de ecualizadores paramétricos: 

Nombre del bloque Descripción 

��PEQ3 
��PEQ5 
��PEQ7 
��PEQ10 

Estos procesadores ofrecen filtros de picos/supresores 
solamente. 

��PEQ3+CS 
��PEQ5+CS 
��PEQ7+CS 
��PEQ10+CS 

Estos procesadores ofrecen filtros de picos/supresores, y 
además un filtro atenuador o limitador de frecuencias bajas 
y otro filtro atenuador o limitador de frecuencias altas. 

Nota: El número que aparece en el nombre del bloque indica el número máximo de filtros 
de picos/supresores que ese procesador ofrece.   

Función 
Utilice este procesador para una ecualización precisa de la respuesta de la sala, sin necesariamente 
afectar las frecuencias cercanas. Seleccione el ecualizador paramétrico según el número de bandas 
de frecuencias que es necesario ajustar, y según si hay que incluir filtros atenuadores o limitadores en 
el bloque procesador. Se pueden conservar los recursos de DSP si se selecciona la cantidad menor 
de filtros que llene sus necesidades. 

Figura 47 − Ventana de ecualilzador PEQ3+CS 

Punto cuadrado de  
control de filtro 

Graficador de
 respuesta 

Control de umbral  Punto circular de filtro  

Gráfica de 
respuesta 



Procesadores modulares 

Guía de software de procesador de sistema SHURE P4800 Página 72 de 112 

Características de la ventana de parámetros 
En esta sección se explican las características y controles de parámetros de los procesadores tipo 
ecualizador paramétrico usando el PEQ3+CS a manera de ejemplo, como se ilustra en la Figura 47. 
Las características de los demás ecualizadores paramétricos varían únicamente en el número de 
bandas que ofrecen y en la disponibilidad de filtros atenuadores/limitadores. 

Graficador de respuesta 
Esta zona de la ventana de parámetros es en donde se colocan y ajustan los filtros paramétricos. 
Representa gráficamente a los filtros de picos/supresores con puntos de control circulares y a los filtros 
atenuadores/limitadores con puntos de control cuadrados. Cuando se abre inicialmente la ventana del 
procesador, el graficador de respuesta no contiene puntos de filtro y, si corresponde, los filtros 
atenuadores/limitadores aparecen en sus posiciones de ajuste en fábrica. Haga clic en un punto de 
control de filtro para ver su curva de respuesta y ajustar sus parámetros. Consulte la sección 
Trabajando con filtros en la página 73 para las instrucciones referentes a cómo añadir puntos de filtro. 

Gráfica de respuesta 
Esta curva es una representación gráfica del resultado que producen las posiciones de los puntos de 
control de filtros fijadas en el graficador de respuesta. 

Nota: La curva no representa el efecto cumulativo de los diferentes bloques 
procesadores colocados en la trayectoria de la señal. 

Puntos de filtro 
Los filtros de picos/supresores se despliegan en el graficador de respuesta como puntos con controles 
ajustables del ancho de banda a sus lados. Haga clic una vez en el punto de control del filtro para 
seleccionarlo, y luego ajustar sus valores con el Mouse, el teclado, o con los cuadros de valores. 
Cuando se selecciona un punto de filtro, su curva de respuesta se despliega en verde en el graficador 
de respuesta, respecto a cero. 

Filtros atenuadores/limitadores 
Los filtros atenuadores/limitadores de frecuencias altas y bajas se representan por medio de puntos 
cuadrados. Cada punto cuadrado puede usarse como un filtro atenuador o limitador, dependiendo de 
su posición vertical en el graficador de respuesta. Cuando se abre la ventana de parámetros por 
primera vez, los puntos cuadrados funcionan como filtros limitadores de frecuencias altas y bajas, 
ajustados en fábrica con una ganancia de 0 dB a 20 kHz y 20 Hz, respectivamente. Se convierten en 
filtros atenuadores cuando se les arrastra hasta el borde inferior del graficador de respuesta.  

Frecuencia 
Indica la frecuencia del punto de filtro elegido. El valor puede cambiarse 
haciendo clic en los botones de flecha, usando el teclado, o escribiendo un 
valor específico. La gama de frecuencias válidas oscila de 25 Hz a 20 kHz, 
con un valor por omisión de 1 kHz cuando se añade un punto nuevo de filtro. 

Ancho/Pendiente/Tipo 
La función de este control varía según el tipo de filtro que se encuentre seleccionado, como se indica 
más adelante. En un filtro atenuador, hay dos alternativas de pendiente que pueden seleccionarse del 
menú. Cuando se selecciona un filtro de picos/supresor, se puede usar el menú con valores 
predeterminados, o especificar el ancho de banda con una precisión de una milésima de octava 
escribiendo el valor deseado. Este control no permite ajustar filtros limitadores. 

Tipo de filtro Apariencia Gama de valores 
Picos/supresor 

 

 

De 1/70 de octava a 4 octavas; valor por omisión: 2/3 de 
octava  
De Q = 100,99 a Q = 0,27, valor por omisión: Q = 2,14 

Atenuador 
 –6 dB/oct y –12 dB/oct, valor por omisión: –6 dB/oct 

Limitador 
 Ninguno 
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Ganancia 
Indica el valor de ajuste actual de la ganancia del filtro seleccionado. La gama 
de valores disponibles oscila entre –18 dB y +18 dB, en incrementos de 0,5 
dB; el valor por omisión es de 0 dB.  Cuando se trabaja con un filtro 
atenuador, este control queda desactivado y despliega la palabra “CUT”. 

Nuevo 
Haga clic en este botón para añadir un filtro nuevo de picos/supresor al graficador de 
respuesta. Cuando se abre la ventana por primera vez, el número que aparece debajo del 
botón indica la cantidad de puntos circulares de filtro que el ecualizador paramétrico 

seleccionado ofrece, y este número disminuye según se añaden puntos de filtro al graficador de 
respuesta. Cuando se ha utilizado el número máximo de filtros del procesador, este botón queda 
inactivo. 

Suprimir 
Haga clic en este botón para suprimir los ajustes de los filtros. Se abre el cuadro de 
diálogo de opciones para suprimir, el cual le brinda la alternativa de suprimir los 
ajustes de todos los filtros, o suprimir sólo los ajustes del filtro seleccionado. Consulte 
la sección Trabajando con filtros en la página siguiente para más información. 

Derivación 
Haga clic en el botón de derivación para activarla o desactivarla. Cuando se activa la derivación, el 
botón se ilumina en rojo. El valor por omisión es el de desactivado. 

 Derivación activada 

 Derivación desactivada 

Imagen instantánea 
Esta característica le permite capturar una imagen de la curva de respuesta actual 
haciendo clic en el botón [Take], y luego desplegarla en el fondo de la imagen para 
fines de comparación haciendo clic en el botón [Show]. El botón [Show] se ilumina en 
verde cuando se despliega la imagen instantánea. Para una descripción más detallada 
de la característica de imagen instantánea, vea la sección Imágenes instantáneas en la 

página 34. 

Importación de archivos ASCII 
Consulte la página 79 para una descripción de cómo importar datos en la gráfica de 
respuesta usando SIA Smaart y Gold Line TEF. 

 

Trabajando con filtros 
Cuando se abre por primera vez la ventana de parámetros de un ecualizador paramétrico, el 
graficador de respuesta no muestra filtros de picos/supresores. Añada los filtros según los necesite, 
hasta el número máximo disponible en el bloque procesador 
seleccionado. 

Para añadir un punto circular de filtro nuevo: 
1. Haga clic en el botón [New]. 
2. Aparece un punto circular de filtro a 0 dB, con una frecuencia 

por omisión de 1 kHz y un ancho de banda de 2/3 de octava. 

Para eliminar todos los puntos de filtro: 
1. Haga clic en el botón [Clear] o seleccione [Edit>Clear Filters] 

de la barra de menús de la ventana de parámetros. Figura 48 −Cuadro de diálogo de 
opciones para suprimir 
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2. Se visualiza el cuadro de diálogo de opciones para suprimir. 
3. Seleccione [Clear All Filters] y haga clic en [OK]. 
4. Esto elimina todos los filtros del graficador de respuesta y retorna los filtros 

atenuadores/limitadores a sus valores por omisión. 

Para eliminar puntos de filtro específicos: 
1. Haga clic en el punto circular de un filtro para seleccionarlo, o mantenga pulsada la tecla 

CTRL y haga clic en varios filtros para seleccionarlos. 
2. Pulse la tecla SUPR – O – haga clic en el botón [Clear] para abrir el cuadro de diálogo de 

opciones para suprimir y seleccione la opción [Clear One Filter], la cual también actúa sobre 
varios filtros seleccionados. 

Nota: No es posible eliminar los puntos cuadrados de los filtros 
atenuadores/limitadores. Sin embargo, es posible retornarlos a sus ajustes 
en fábrica usando el botón [Clear] o la tecla SUPR. 

Ajuste de los filtros en el graficador de respuesta 
Los ajustes de un filtro pueden cambiarse arrastrando sus puntos de control con el Mouse. 

Para ajustar la ganancia y frecuencia: 
1. Coloque el cursor sobre el centro del punto de control circular o cuadrado del filtro. 
2. El cursor se visualiza como el símbolo de desplazamiento: 
3. Haga clic y arrastre el filtro hacia la izquierda o la derecha para ajustar su frecuencia, y hacia 

arriba o hacia abajo para ajustar su ganancia. 

Nota: El graficador de respuesta visualiza la curva sólo del filtro seleccionado. La 
curva del efecto combinado se visualiza en la gráfica de respuesta. 

Para ajustar el ancho de banda del punto de filtro: 
1. Coloque el cursor sobre cualquiera de los puntos de control de ancho de banda del filtro. 
2. El cursor se visualiza como el símbolo de ajuste de tamaño horizontal: 
3. Haga clic y arrastre el punto de control hacia la izquierda o la derecha para ajustar el ancho 

de banda. 

Ajuste fino de los parámetros 
Los parámetros del filtro seleccionado pueden ajustarse con precisión usando cualquiera de los 
métodos siguientes: 

�� Escriba un número en cualquiera de los cuadros de valores de parámetros 
�� Utilice los botones de flecha (o el menú) junto a los cuadros de valores de parámetros 
�� Utilice las teclas de control 
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Teclas de control 
Se pueden usar las combinaciones de teclas siguientes para hacer ajustes finos al filtro seleccionado. 

Tecla Resultado 

← Reduce la frecuencia el equivalente de un pixel en la pantalla 

→ Aumenta la frecuencia el equivalente de un pixel en la pantalla 

↑ Aumenta la ganancia en 0,5 dB 

↓ Reduce la ganancia en 0,5 dB 

MAYÚS con ← Reduce la frecuencia por 1/3 octava 

MAYÚS con → Aumenta la frecuencia por 1/3 octava 

CTRL con ← Reduce el ancho de banda de un filtro en intervalos pequeños 

CTRL con → Aumenta el ancho de banda de un filtro en intervalos pequeños 

MAYÚS con ↑ o  
AV PÁG 

Aumenta la ganancia en 3 dB 

MAYÚS con ↓ o  
RE PÁG 

Reduce la ganancia en 3 dB 

BARRA ESPACIADORA  
o clic con botón derecho Ajusta la ganancia a 0 dB 

Nota: Si se modifica la frecuencia por el equivalente de un pixel en la pantalla, el valor 
de la misma cambia en aproximadamente 1/100 de octava, ó 1%.  

Copiar, cortar y pegar 
Los filtros pueden copiarse, cortarse y pegarse entre dos ventanas de ecualizadores 
paramétricos, si se cumplen las condiciones siguientes: 

�� Hay un número suficiente de filtros disponibles en la ventana de parámetros en donde se 
desea pegar un filtro. 

�� Los valores de ajuste de filtros atenuadores/limitadores sólo pueden copiarse entre 
procesadores del tipo PEQ+CS. 

Nota: El comando de cortar no se encuentra disponible para los filtros 
atenuadores/limitadores. 

Para copiar y pegar filtros: 
1. Haga clic en un filtro para seleccionarlo, o seleccione varios filtros usando uno de los 

métodos siguientes: 
�� CTRL+clic. 
�� Utilice el comando [Edit>Select All] del menú. 
2. Seleccione el comando [Edit>Copy] del menú. 
3. Abra la ventana del ecualizador paramétrico en donde se desea pegar los valores del filtro. 
4. Seleccione el comando [Edit>Paste] del menú. 

Nota: Cuando varios filtros forman parte de un grupo seleccionado, se resaltan en 
rosado y los valores de sus parámetros quedan enclavados. Para quitar una 
selección de unidades múltiples seleccionadas, haga clic en cualquier control de 
la ventana de parámetros, o en un filtro que no forme parte del grupo 
seleccionado. 
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Atenuador automático (Ducker) 
El atenuador automático de música proporciona un medio fácil para usar el P4800 en un sistema de audio que 
requiere la función de buscapersonas. Cuando hay una señal de buscapersonas presente, el atenuador 
reduce el volumen de las otras señales.  

Nombre del bloque Descripción  
�� DUCK Atenuador automático (Ducker)  
 

 
Función  
Arrastre el atenuador automático y colóquelo en un canal de entrada para identificar dicho canal como el 
que lleva la señal de buscapersonas. Cuando la intensidad de la señal de buscapersonas excede el 
umbral, el atenuador reduce el volumen de las otras señales presentes en cada punto de la matriz 
mezcladora a la cual se envía. Envíe la señal de buscapersonas usando la matriz mezcladora o las 
casillas “Paging Channels” (canales de buscapersonas) en la ventanilla de parámetros del atenuador 
automático  
Nota: El atenuador automático sólo puede colocarse en un canal de entrada. No coloque más de un 
atenuador en cada canal de entrada. 
Para evitar que los ruidos extraños recibidos por el canal de buscapersonas se escuchen, coloque una 
compuerta delante del atenuador automático, en el diagrama de flujo de la señal. 

Características de la ventana de parámetros 
Gráfica de curva de transferencia  
La gráfica de la curva de transferencia muestra el nivel de umbral como un elemento gráfico cuya 
posición puede ajustarse con el mouse.  
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Medidor de curva de transferencia 
En el modo en vivo, este medidor muestra el nivel de entrada de la señal de buscapersonas, de modo 
que se puede fijar el umbral por encima del nivel del ruido ambiental. Esta característica puede 
desactivarse y activarse seleccionando la función [Options>Transfer Curve] del menú. Su valor por 
omisión es de activado. 

Nota: El rendimiento del software puede reducirse si se tiene un número grande de 
medidores activos. Se puede desactivar el medidor de umbral, el medidor de 
reducción de ganancia, o ambos, con el menú [Options]. 

Control de umbral 
La posición del control de umbral corresponde con el valor de ajuste del control de umbral. Utilice el 
Mouse para arrastrar este control hacia la izquierda o la derecha, a lo largo del borde superior de la 
gráfica de umbral. El umbral cambiará de modo correspondiente. 

Medidor de reducción de ganancia 
Este medidor indica la reducción total en la ganancia que se logra sobre las señales atenuadas con 
los valores de ajuste actuales del procesador. Esta característica puede desactivarse y activarse 
seleccionando la función [Options>Gain Reduction Meter] del menú. Su valor por omisión es de 
activado. 

Indicador de umbral excedido 

 El nivel de la señal ha excedido el umbral  

 El nivel de la señal no ha alcanzado el 
umbral 

Este indicador aparece iluminado en amarillo 
cuando la señal que entra al bloque 
procesador excede el umbral especificado. 

Attenuation 
Este control regula la cantidad de reducción aplicada a las señales afectadas por el atenuador 
automático cuando el nivel de la señal de buscapersonas excede el umbral. El valor puede cambiarse 
haciendo clic en los botones de flecha o escribiendo un valor específico de entre 1 dB y -INF. 

Umbral 
Esto regula el nivel de ganancia que la señal de buscapersonas debe alcanzar antes 
de que el procesador atenúe las señales afectadas por el atenuador automático. El 
valor puede cambiarse haciendo clic en los botones de flecha o escribiendo un valor 
específico de entre +20 dB y –60 dB. 

Ataque 
Regula el tiempo que el procesador necesita para reducir completamente la ganancia de 
las señales atenuadas, después de que el nivel de la señal de buscapersonas haya 
excedido el umbral. El tiempo de ataque puede cambiarse haciendo clic en los botones de 

flecha o escribiendo un valor específico. Los valores disponibles oscilan entre 1 y 5000 ms. 

 

Retención 
Regula el tiempo por el cual el procesador continúa atenuando las señales con el 
atenuador automático, una vez que el nivel de la señal de buscapersonas haya caído 
por debajo del umbral. Este valor puede cambiarse haciendo clic en los botones de 

flecha o escribiendo un valor específico. Los valores disponibles oscilan entre 1 ms y 10.000 ms. 
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Liberación 
Regula el tiempo que el procesador requiere para devolver las señales atenuadas a 
su nivel anterior una vez transcurrido el tiempo de retención. Este valor puede 
cambiarse haciendo clic en los botones de flecha o escribiendo un valor específico. 

Los valores disponibles oscilan entre 1 ms y 10.000 ms. 

Ajuste en fábrica 
Haga clic en este botón para reposicionar el procesador a sus valores de ajuste en la fabrica. 

Derivación 
Haga clic en este botón pasar la señal por el bloque procesador sin alterarla. Cuando la 
función de derivación está activada, el botón se ilumina en rojo. El valor por omisión es 
el de desactivado. 

 Derivación activada  

 Derivación desactivada  

Canales de buscapersonas 
Seleccione la casilla correspondiente a cada canal de salida al cual se 
desea enviar la señal de buscapersonas. Esto cumple la misma función 
que enviar la señal de entrada con el atenuador automático a los puntos 
de mezcla de salida en el diagrama de flujo de señales. 
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Importación de archivos ASCII del software SIA-Smaart o 
Gold Line TEF™  
Las ventanas del ecualizador gráfico, del ecualizador paramétrico y de los filtros limitadores/atenuadores 
pueden desplegar datos contenidos en un archivo ASCII exportado de una medición de función de 
transferencia de SIA-Smaart, o de una medición de TDS de Gold Line TEF. 

 

Función 
Utilice la función de importación de archivos ASCII para desplegar información de frecuencia en función de 
magnitud medida con los sistemas Smaart o TEF. Si se invierten los datos, se puede usar la 
representación gráfica como una guía visual para fijar los parámetros de los ecualizadores. La pantalla 
sólo muestra los valores de amplitud correspondientes a las frecuencias contenidas en el archivo. No 
interpola una línea entre los puntos medidos. En consecuencia, puede haber espacios vacíos en la vista, 
particularmente a frecuencias bajas. 
La función de importación de archivos ASCII es compatible con archivos generados por: 

�� Mediciones de función de transferencia hechas con SIA-Smaart Pro (versiones 2/x y 3.x) y 
SIA SmaartLive™. 

�� Mediciones de TDS en todas las versiones del software TEF™ para los entornos Windows y 
DOS. 

Guardado de archivos Smaart en formato ASCII 
Para exportar una medición usando el software Smaart, haga mediciones en el modo de función de 
transferencia. Después seleccione [File>ASCII Save] en el programa Smaart. 

Guardado de archivos TEF en formato  
Para exportar una medición usando el software TEF de TDS, proceda de la manera siguiente: 

1. Seleccione [File>Save] en el programa TEF de TDS.  
2. Introduzca la información del archivo y haga clic en “Save”. En la ventana “Save TDS File”, 

seleccione el tipo de archivo “ASCII”. 
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Características de la ventana de parámetros 
Importar 
Haga clic en este botón para importar archivos ASCII creados por los programas Smaart o TEF. 
Cuando aparece el cuadro de diálogo  [Open File], seleccione el archivo que se desea importar. Los 
datos del archivo importado se despliegan en la gráfica de respuesta. Cuando se importa un archivo 
TDS creado por TEF, el valor promedio de magnitud se representa como 0 dB y los otros valores de 
magnitud se gradúan de modo correspondiente. Por omisión, los archivos de función de transferencia 
creados por Smaart no se compensan. Los valores de magnitud se centran alrededor del eje de 0 dB, 
tal como ocurre con los datos generados por Smaart. 

Refrescar 
Haga clic en este botón para volver a importar el último archivo que se importó. Si se hacen 
mediciones nuevas con los programas Smaart o TEF y se guardan en un archivo con el mismo 
nombre, se puede pulsar el botón [Refresh] para importar la medición nueva sin tener que abrir el 
cuadro de diálogo de abrir archivos. 

Nota: El botón [Refresh] NO modifica el valor de compensación del archivo original. Si el valor 
promedio de magnitud de un archivo TDS creado por TEF varía, la vista refrescada todavía estará 
compensada según el valor promedio original. Además, la compensación añadida usando la caja de 
texto [Offset] no se altera cuando se hace clic en el botón [Refresh]. 

Mostrar 
Haga clic en este botón para ocultar o mostrar la vista del archivo importado. El botón 
[Show] se ilumina en verde cuando se despliega la imagen de un archivo. 

Compensación  
Indica la cantidad por la cual se ha compensado la vista respecto a los valores reales de 
amplitud contenidos en el archivo ASCII. Por omisión, la medición de TDS hecha con 
TEF estará compensada según su valor promedio de amplitud, de modo que éste quede 
centrado respecto al eje de 0 dB en la gráfica de respuesta. 

Invertir 
Haga clic en esta casilla para invertir los datos desplegados respecto al eje x. La vista 
invertida entonces puede usarse como guía visual para fijar los parámetros de 
ecualizadores. La función de inversión está activada por omisión. 

Ayuda  
Haga clic en este botón para acceder a la ayuda interactiva para la importación de 
archivos ASCII generados por los programas Smaart y TEF. 
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PINES DE CONTROL ________________________________________  
Los pines de conexión que están en la parte trasera del procesador de sistema ofrecen conexiones para controles 
externos de las señales de salida del dispositivo y de señales lógicas. Se pueden conectar equipos externos de control 
a los pines de entradas de control, tales como los paneles AMX, Crestron, o un panel de pared especializado. Este tipo 
de conexión sencilla para equipos permite al usuario cambiar de una configuración prefijada a otra, silenciar canales, o 
ajustar la ganancia sin necesidad de tener una computadora. Las señales lógicas de salida pueden conectarse a LED, 
relés o equipos lógicos de otros fabricantes, si la instalación requiere que dispositivos externos o pantallas de estado 
respondan a la configuración activa y silenciamiento del procesador de sistema. 

Descripción general de controles externos 
El control por dispositivos externos puede establecerse a tres niveles diferentes, según se ilustra a continuación en la 
Figura 49. En este ejemplo, la entrada para control externo se ha configurado para conmutar entre tres 
configuraciones prefijadas, para ajustar la ganancia total del sistema con un potenciómetro, y para silenciar un canal 
de entrada con un interruptor. La señal de salida lógica se ha configurado para accionar dispositivos externos, 
dependiendo de la configuración prefijada activa, y para indicar el estado de silenciamiento de un canal por medio de 
un LED. 

Para establecer el control por dispositivo externo: 
1. Conexiones externas 

Cuando el dispositivo se instala inicialmente, determine el tipo de señales de entrada de control y de 
salida lógica que se requieren en la instalación, y conecte los alambres a los bornes del bloque de 
conexión de modo correspondiente. Consulte la sección de Conexión de pines de control de la Guía de 
instalación de equipos para las instrucciones y los diagramas de alambrado. 

2. Configuración de pines 
Utilice la ventana de pines de control del software para configurar el procesador de sistema de modo que 
reconozca correctamente las conexiones de control del equipo físico. Esta configuración se almacena 
como un ajuste global en el dispositivo, y también puede guardarse como un archivo de computadora. 
Consulte la sección Configuración de pines en la página 85 para las instrucciones del caso. 

Figura 49 − Los tres niveles de control por dispositivos 

Nivel de instalación

Nivel de dispositivo

Nivel de configuración 

SALIDA LOGICAENTRADA DE CONTROL 

DDeessiiggnnaacciiónn  ddee  pprroocceessaaddoorr    

CCoonnffiigguurraacciiónn  ddee  ppiinneess    

CCoonneexxiioonneess  eexxtteerrnnaass    
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3. Designación de procesadoró 
Una vez que el dispositivo ha sido configurado para reconocer los controles externos, designe los 
canales de entrada y de salida de las conexiones de control usando la sección de designación de 
procesador de la ventana de pines de control. Cada configuración prefijada o archivo de escena se 
designa a una dirección específica de procesador. Consulte la sección Designación de procesador en la 
página 88 para las instrucciones del caso. 

La ventana de pines de control 
La ventana de pines de control es una interface que permite configurar los pines de control de modo general, a nivel 
de dispositivo, y designar procesadores para cada unidad de control de modo específico para cada configuración 
prefijada. Acceda a esta ventana seleccionando la función [Devices>Control Pins Configuration] del menú de la 
ventana principal.  

Vistas de configuración 
La ventana de pines de control tiene dos vistas de configuración diferentes: entradas de control y salidas 
lógicas. Haga clic en el texto [Control In] o [Control Out], o en los conectores de pines correspondientes, 
para conmutar entre las dos vistas, según el grupo de pines que se desee configurar.  

CONTROL IN (ENTRADA DE CONTROL) 
Utilice esta vista para configurar y designar los pines de entradas de control de modo que cumplan 
cualquiera de las funciones siguientes por un equipo externo de control: 

�� Conmutar entre configuraciones prefijadas almacenadas en el dispositivo. 
�� Activar y desactivar el silenciamiento de canales. 
�� Ajustar los niveles de ganancia. 

LOGIC OUT (SALIDA LÓGICA) 
Utilice esta vista para configurar y designar los pines de salidas lógicas para indicar cualquiera de las 
condiciones siguientes a pantallas o equipos externos: 

�� El número de la configuración prefijada activa. 
�� El estado de silenciamiento de un canal de entrada o de salida. 

Figura 50 – Ventana de pines de control: vista de entradas de control 

Sección de  
configuración  
de pines  

Vista de 
configuración 

Menu de bloque de conexiones

Conectores con pines  

Bloque de 
conexiones 

 Designación de 
Procesador  

Bloque de Control 
de configuraciones 

prefijadas 
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Ajuste de parámetros de codificación de configuración prefijada 
Estos cuadros para parámetros aparecen junto al texto [Control In] y [Logic Out] de la parte superior de la 
ventana de pines de control. La combinación de valores fijados en estos cuadros determina la configuración 
del bloque de control de la configuración prefijada. Escriba el número de configuraciones prefijadas primero, 
y después seleccione el tipo de codificación. 

Nota: Existen restricciones en cuanto a los tipos de codificación que pueden usarse en 
combinación con el número de configuraciones prefijadas que se especifican. Consulte 
la sección Tipos de codificación de configuraciones prefijadas en la página 86 para más 
información. 

Número de configuraciones prefijadas 
Aquí se especifica el número de configuraciones prefijadas del dispositivo que podrán 
seleccionarse por el equipo externo en una vista de configuración particular. Los valores 
disponibles oscilan de 0 a 128, y el valor por omisión es de cero. 

Tipo de codificación 
Aquí se especifica el tipo de codificación que se utilizará para el control de las 
configuraciones prefijadas. Los valores disponibles varían según el número que se 
ha especificado en el cuadro de valores [# Presets], como se explica en más detalle 

en la sección Tipos de codificación, más adelante. El valor por omisión es “None” (ninguna). 

Botón de más información 
Haga clic en este botón para acceder a temas de ayuda de las funciones de la ventana de 
pines de control. 

Sección de configuración de pines 
Utilice esta sección de la ventana para configurar el procesador de sistema de modo que reconozca 
correctamente los pines de control que están conectados a equipos externos. Cuando se abre la ventana 
inicialmente, todas las conexiones están desactivadas y no existe diferencia entre las funciones de los pines. 
Una vez que se definen cuántos pines se utilizarán para el control de configuraciones prefijadas, la pantalla 
distribuye esas conexiones al bloque de control de configuraciones prefijadas, y los pines restantes pueden 
designarse para control del procesador. 

Nota: Cuando se está en modo en vivo, no es posible hacer cambios a la configuración de 
pines, aparte de desactivar o activar conexiones. Hay que estar en modo de diseño 
para crear o modificar la configuración de los pines. 

Estos valores de ajuste se almacenan a nivel del dispositivo. No se almacenan con configuraciones prefijadas ni 
archivos de escena, y no cambian cuando se conmuta entre configuraciones prefijadas en el dispositivo. Esta 
configuración puede guardarse en un archivo de computadora si se está trabajando sin estar conectado al 
procesador de sistema, o como respaldo para fines de documentación. 

Bloque de control de configuraciones prefijadas 
La ventana inicialmente no despliega el bloque de control de configuraciones prefijadas. Una vez que se 
definen valores en los cuadros de parámetros [# Presets] y [Encoding Type], aparece en el lado izquierdo de 
la sección de pines de control de la ventana. Las conexiones de los pines pueden activarse y desactivarse 
de modo alternado haciendo clic en el bloque con el botón izquierdo del Mouse, o seleccionando la función 
[Disable] del menú que está en el lado derecho del bloque. Para más información sobre la codificación de 
configuraciones prefijadas, consulte la sección Tipos de codificación de configuraciones prefijadas en la 
página 86. 

Nota: Después de haber configurado el dispositivo para control de configuraciones prefijadas 
por medios externos, no es posible cambiar de configuración con la computadora sin 
antes desactivar la conexión de control de configuraciones prefijadas en la ventana de 
pines de control. 
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Bloques de conexión 
El número de bloques de conexión que aparece en la ventana depende de cuántos pines hay disponibles 
después de haber especificado el control de configuraciones prefijadas. Asigne diferentes unidades de 
control o salidas lógicas a un pin de conexión haciendo una selección del menú que aparece en el lado 
derecho del bloque. Las conexiones de los pines pueden activarse y desactivarse de modo alternado haciendo 
clic en el bloque con el botón izquierdo del Mouse, o seleccionando la función [Disable] del menú.  

Sección de designación de procesadores 
Utilice esta sección para definir, en cada configuración prefijada, los procesadores que serán controlados 
por el equipo externo. Los canales de entrada y salida de la configuración prefijada aparecen en una 
columna debajo de cada bloque de designación de pines que ha sido asignado a una unidad de control o 
salida lógica. Los procesadores pueden designarse en modo en vivo o en modo de diseño. Cuando se está 
en modo en vivo, la barra de títulos de esta sección de la ventana aparece en azul; en modo de diseño, 
aparece en negro. 

Nota: Toda designación de procesadores que se especifique se guarda con la configuración 
prefijada o el archivo de escena, por lo tanto hay que designar los procesadores de 
modo correspondiente a la configuración de pines del dispositivo para cada 
configuración prefijada que se almacenará en el dispositivo. 

Casillas de designación de procesadores 
Haga clic en una casilla para designar el canal de entrada o salida 
correspondiente al bloque de designación. La casilla se llena en azul para 
indicar que ha sido seleccionada. Es posible designar varios procesadores 
a unidades de control de entrada, pero sólo se puede designar uno a cada 
señal de salida lógica. Haga clic en la casilla para seleccionarla o 
deseleccionarla.  

 Casilla de procesador seleccionada para designación. 

 Casilla deseleccionada. 

Silenciamiento 
El silenciamiento de canales puede controlarse ya sea por medio de un 
interruptor con bloqueo, o uno de contacto momentáneo, y también puede indicarse por medio de los pines 
de señales de salida lógica. 

Figura 52 − Designación de 
silenciamiento  

Figura 51 − Bloques de conexiones 

Conexión activada 

Conexión  
desactivada  

Conexión 
desactivada 

Tipozs de unidad de control : ninguno Potenciómetro de 100k  Interruptor con bloqueo  Interruptor de contacto momentaneo  
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Ganancias (sólo para entradas de control) 
La ganancia puede controlarse por medios externos con un potenciómetro de 100 kΩ. Directamente debajo de un 
bloque de conexiones al cual se le ha designado un potenciómetro de control, aparece una escala de ganancia, la 
cual se representa por medio de una barra azul. Es posible especificar la gama de ajuste del potenciómetro entre 
–30 dB a un máximo de +30 dB. La gama ajustada en fábrica es –30 dB a 0 dB. 

Nota: Utilice un potenciómetro de 100k con variación para audio y una tolerancia de 5%. La mayoría de los 
potenciómetros tienen una tolerancia de 10% ó 20%. Si la resistencia abierta del potenciómetro es inferior a 
95 kilohmios (tolerancia mayor que -5%), éste no aumentará la ganancia de la señal a un nivel suficiente. 
Sin embargo, se puede usar un potenciómetro con tolerancia de 10% ó 20%, siempre y cuando su valor real 
de resistencia sea mayor que 95 kilohmios. 

Configuración de pines 
La configuración de pines constituye el segundo nivel de control por medios externos, y es necesario definirla antes 
de poder designar los procesadores. La sección de configuración de pines de la ventana de pines de control es un 
modelo de software de las conexiones físicas al equipo que el dispositivo requiere para reconocer dichas conexiones 
de modo correcto. La configuración puede guardarse directamente en el dispositivo, o guardarse en la computadora 
para transmitirla posteriormente al procesador de sistema. 

Nota: Hay que estar en modo de diseño para crear o modificar la configuración de los pines. 

Creación de una configuración de pines nueva 
1. Entre al modo de diseño. 

2. Seleccione [Devices>Control Pin Configuration] del menú principal. 

3. La ventana de pines de control se abre. 

4. Seleccione la vista [Control In] o [Logic Out]. 

5. Configure el control de configuraciones prefijadas. 
a) Escriba la cantidad de configuraciones en el cuadro de valores [# Presets]. 
b) Seleccione el tipo de codificación del menú [Encoding Type]. 
c) El bloque de pines de control de configuraciones prefijadas aparece en la sección de configuración de pines 

de la ventana. 
d) Si se utiliza codificación prioritaria como entrada de control, escriba el número correcto de configuraciones 

prefijadas bajo el bloque de control de configuraciones prefijadas (vea la Figura 55). 

6. Configure los pines restantes como unidades de control externas o salidas lógicas haciendo la selección 
correspondiente del menú que está a la derecha de cada bloque de designación de pines. 

7. Seleccione la función [Configuration>Store to Device] del menú. 

8. Se visualiza el cuadro de diálogo de selección de dispositivos. 

9. Seleccione un dispositivo y haga clic en [OK]. 

10. La configuración de los pines se guarda en el dispositivo. 

Figura 53 -
Designación de 

ganancia 

Para editar la gama de ajuste de ganancia del 
potenciometro 
1. Coloque el cursor en cualquier punto de la escala y haga 

clic con el botón izquierdo del Mouse. 
2. Se visualiza el cuadro de diálogo de editar gama. 
3. Escriba la gama apropiada de ajuste de ganancia del po- 

tenciometro conectado. 
4. Haga Clic [OK]. 
5. La gama nueva se indica por medio de la longitud de la 

barra azul.. Figura 54 − Cuadro de diálogo de 
edición de gamma  
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Guardado de una configuración en la computadora 
1. Efectúe los pasos 1-6 anteriores. 

2. Seleccione la función [Configuration>Save To PC] del menú. 

3. Se despliega el cuadro de diálogo “Save Config As” (Guardar configuración como...). 

4. Seleccione el directorio deseado, escriba el nombre que se desea dar al archivo y haga clic en [OK]. 

5. La configuración se guarda en la computadora en un archivo cuya extensión es “.PIN”. 

Edición de una configuración existente de pines 
1. Entre al modo de diseño. 

2. Seleccione [Devices>Control Pin Configuration] del menú principal. 

3. La ventana de pines de control se abre. 

4. Seleccione la función [Configuration>Recall From Device] del menú. 

5. Se visualiza el cuadro de diálogo de selección de dispositivos. 

6. Seleccione un dispositivo y haga clic en [OK]. 

7. La ventana de pines de control refleja la configuración actual de los pines. 

8. Haga las modificaciones que sean necesarias. 

9. Seleccione la función [Configuration>Store to Device] del menú. 

10. Se visualiza el cuadro de diálogo de selección de dispositivos. 

11. Seleccione un dispositivo y haga clic en [OK]. 

12. La configuración de los pines se guarda en el dispositivo. 

Tipos de codificación de configuraciones prefijadas 
En la actualidad se ofrecen tres tipos diferentes de codificación de configuraciones prefijadas para entradas 
de control, y dos para salidas de control. Seleccione el tipo de codificación según el tipo de equipo que se 
conectará a los pines de control, el número de configuraciones prefijadas entre las cuales se estará 
conmutando en el dispositivo, y el número de pines que se necesitarán para otras funciones. 

Codificación prioritaria o uno a uno 
Número máximo de configuraciones prefijadas: 8 
Número de pines requeridos:  1 a 8, uno por cada configuración prefijada 

La codificación prioritaria para entradas de control y uno a uno para salidas lógicas designa una conexión de 
pin al número de una configuración prefijada particular. Este es el tipo de codificación por omisión cuando se 
especifican hasta 8 configuraciones en el cuadro de valores [# 
Presets]. 

Para las entradas de control, el bloque de control de 
configuraciones prefijadas despliega un cuadro de valores debajo 
de cada pin que permite especificar el número de la configuración 
prefijada. Cuando el bloque aparece inicialmente, los valores por 
omisión empiezan por uno, y aumentan de izquierda a derecha. 
Estos valores pueden modificarse haciendo clic en cada cuadro y 
escribiendo un número de 1 a 128. En caso que el usuario pulse 
accidentalmente más de uno de los interruptores externos de 
control, el dispositivo cambia a la configuración prefijada cuyo nivel 
de prioridad sea el más alto. 

Figura 55 − Codificación   
 prioritaria 
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Codificación binaria 
Número máximo de configuraciones prefijadas: 128 
Número de pines requeridos:   
Consulte la tabla que aparece a la derecha 

La codificación binaria establece una correspondencia entre un número 
binario y el número de una configuración prefijada del procesador de 
sistema para tanto entradas de control como salidas lógicas. Este es el 
tipo de codificación por omisión cuando se especifican 9 ó más 
configuraciones en el cuadro de valores [# Presets]. 

El código binario corresponde a estados de voltaje en los pines de 
control de la parte trasera del dispositivo procesador de sistema. 

�� 0 lógico = pin desconectado de tierra 
�� 1 lógico = pin puesto a tierra 

Se puede calcular el código binario que el procesador de sistema utiliza para codificar las configuraciones 
prefijadas usando las instrucciones siguientes, o consultando Apéndice A, en la página 99, para tablas 
completas de codificación binaria de uno a siete pines. 

Para convertir el número de la configuración prefijada a código binario: 
1. Reste 1 al número de la configuración prefijada. 
2. Convierta ese número a su equivalente en notación binaria, observando la convención siguiente: 

El bit más significativo siempre corresponde al pin 1, y el menos significativo siempre corresponde al pin cuyo 
número es el más alto entre los que se han conectado para control de configuraciones prefijadas, como se 
ilustra en la Figura 56. 
Ejemplo – Configuración prefijada N° 7: 
�� 7 – 1 = 6 
�� 6 en notación binaria = 110 

Nota: Para la selección precisa de configuraciones prefijadas en la entrada de control, la 
codificación binaria de toda configuración debe contener el mismo número de bits 
como la cantidad de pines de control conectados para codificar las configuraciones 
prefijadas. Agregue tantos ceros como sea necesario a la izquierda del valor binario, 
hasta que se tenga el mismo número de dígitos como de pines de control conectados 
para codificar configuraciones prefijadas, como se ilustra en la Figura 56. 

Codificación personalizada de interruptores 
(sólo entradas de control) 
Número máximo de configuraciones prefijadas: 10 
Número de pines requeridos:  1 

La codificación personalizada de interruptores para entradas de control 
establece una correspondencia entre valores de resistencia y las 
configuraciones prefijadas números uno a diez. Este tipo de codificación se 
encuentra disponible solamente cuando se especifican 10 ó menos 
configuraciones en el cuadro de valores [# Presets]. Consulte la Tabla 3 en la 
sección Conexiones de pines de control de la Guía de instalación del equipo 
para más información sobre la correspondencia entre valores de resistencia 
y números de configuración prefijada.  

Nos. de 
prefijadas 

Nos. de pines 
requeridos 

2 1 

4 2 

8 3 

16 4 

32 5 

64 6 

128 7 

Figura 56 − Codificación binaria de la configuración prefijada N° 7 con tres, cuatro y cinco pines  

Figura 57 − Codificacion 
personalizada de 

interruptores  
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Tipos de conexión 
Los pines no usados para controlar configuraciones prefijadas pueden designarse para señales de control 
de procesador y señales lógicas de salida. La tabla siguiente ilustra las opciones disponibles para esas 
conexiones. Haga clic en el menú señalado por la flecha amarilla en el lado derecho del bloque de 
designación para seleccionar el tipo de unidad de control. 

Designación 
de pines Descripción ENTRADA/

SALIDA Funcionamiento 

 
Interruptor con 
bloqueo ENTRADA 

Silenciamiento de canales de entrada y de salida. Diseñado para uso 
con una unidad de control externo que se conmuta entre dos posiciones. 
También puede usarse con un interruptor de contacto momentáneo, en 
cuyo caso el canal permanece silenciado mientras se mantenga 
oprimido el interruptor y el silenciamiento se desactiva al soltarlo. 

 
Interruptor de 
contacto 
momentáneo 

ENTRADA 
Silenciamiento de canales de entrada y de salida. Diseñado para uso 
con un interruptor momentáneo externo. Activa o desactiva el 
silenciamiento cada vez que se oprima el interruptor. 

 
Potenciómetro de 
100 kΩ ENTRADA Ajusta la ganancia dentro de una gama que el usuario define, de –30 dB 

a +30 dB máximo. 

 
Salida lógica SALIDA Indica el estado de silenciamiento a dispositivos externos tales como 

LED, relés o equipo lógico binario. 

Designación de procesador 
La designación de procesadores es el tercer y último nivel de control externo. Para que los dispositivos externos 
puedan controlar la ganancia y el silenciamiento de canales del procesador de sistema, o para reconocer el estado 
de silenciamiento, cada configuración prefijada del dispositivo debe designarse a las conexiones de control. Las 
configuraciones de procesadores se guardan con cada configuración prefijada o archivo de escena. Utilice uno de 
los métodos siguientes para designar a cada configuración prefijada: 

�� Confeccione una plantilla que sirva de base para cada configuración prefijada. 
�� Recupere cada configuración prefijada del dispositivo y agréguele la designación de 

procesadores. 
�� Abra cada archivo de escena guardado en la computadora y agréguele la designación de 

procesadores. 

Nota: Antes de crear una designación de procesadores, es necesario configurar los pines 
de control. 

Creación de una plantilla de designación de procesadores 
Si se estarán almacenando varias configuraciones prefijadas en el dispositivo, se puede ahorrar algo de 
tiempo designando procesadores creando una plantilla que sirva de base para el grupo de configuraciones 
prefijadas. Esta plantilla puede contener los nombres de los canales, la designación de procesadores, y 
otras características de configuración del flujo de señales adecuadas para cada configuración prefijada 
almacenada en ese dispositivo particular. 

Para crear una plantilla de configuraciones prefijadas que incluya una designación de 
procesadores: 

1. En el modo de diseño, designe los canales de entrada y de salida de modo que reflejen al dispositivo 
particular. (Consulte la sección Rotulación de entradas y salidas en la página 18 para las instrucciones 
del caso.) 

2. Seleccione [Devices>Control Pin Configuration] del menú principal. 
3. La ventana de pines de control se abre. 
4. Cargue la configuración de pines apropiada usando uno de los métodos siguientes: 

�� Seleccione la función [Configuration>Open From PC] del menú. 
�� Si está conectado al procesador de sistema, seleccione la función [Configuration>Recall From 

Device] del menú. 
5. Los canales de entrada y salida aparecen en la sección de designación de procesadores de la ventana, 

debajo de los bloques de conexiones que han sido designados a unidades de control o salidas lógicas 
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6. Por cada bloque de conexiones designado, haga clic en las casillas de designación de procesadores, 
junto a los canales que serán seleccionados por la conexión. 

7. Cierre la ventana de pines de control. 
8. Guarde el archivo de escena en la computadora. (Consulte la sección Archivos de escena en la página 

28 para las instrucciones del caso.) 
9. Utilice este archivo de plantilla como la base de cada configuración prefijada creada para el dispositivo. 

Designación de una configuración prefijada existente o archivo de escena 
Las configuraciones prefijadas existentes pueden designarse después de haberlas guardado en el 
dispositivo, y los archivos de escena pueden designarse después de haberlos guardado en la computadora. 

Para designar una configuración existente en modo en vivo: 

1. Ponga el dispositivo en modo en vivo. 

2. Seleccione la configuración prefijada que se desea designar. 

3. La ventana principal cambia a modo de presentación preliminar. 

4. Verifique que se haya seleccionado la configuración prefijada correcta y haga clic en [Load]. 

5. La configuración prefijada se activa. 

6. Seleccione [Devices>Control Pin Configuration] del menú principal. 

7. La ventana de pines de control se abre con los canales de entrada y salida indicados bajo las 
conexiones designadas de pines. 

8. Por cada bloque de conexiones designado, haga clic en las casillas de designación de procesadores, 
junto a los canales que serán seleccionados por la conexión. 

9. Las designaciones se guardan con la configuración prefijada en el dispositivo.  

10. Seleccione otra configuración prefijada que designar (no es necesario cerrar la ventana de pines 
de control).  

Para designar un archivo de escena existente en modo de diseño: 
1. Compruebe que está en modo de diseño. 

2. Haga clic en el botón [Open] de la barra de control de la ventana principal. 

3. Se visualiza el cuadro de diálogo de abrir escena. 

4. Seleccione el archivo de escena que se desea designar y haga clic en [OK]. 

5. La configuración prefijada seleccionada se visualiza en el diagrama de flujo de señales. 

6. Seleccione [Devices>Control Pin Configuration] del menú principal. 

7. La ventana de pines de control se abre. 

8. Cargue la configuración de pines apropiada usando uno de los métodos siguientes: 
�� Seleccione la función [Configuration>Open From PC] del menú. 
�� Si está conectado al procesador de sistema, seleccione la función [Configuration>Recall From 

Device] del menú. 

9. Por cada bloque de conexiones designado, haga clic en las casillas de designación de procesadores, 
junto a los canales que serán seleccionados por la conexión. 

10. Retorne a la ventana principal (no es necesario cerrar la ventana de pines de control). 

11. Guarde el archivo de escena en la computadora. (Consulte la sección Archivos de escena en la página 
28 para las instrucciones del caso.) 

12. Abra el siguiente archivo de escena que se desee designar. 
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SEGURIDAD _______________________________________________  
La seguridad es una característica estándar que permite al instalador, o a otro administrador de seguridad, restringir 
el acceso que tiene el usuario a los ajustes del procesador de sistema a través de la computadora. El administrador 
es el individuo que fija la contraseña del dispositivo y el nivel de acceso al cual funcionará después de haberlo 
instalado. Hay tres niveles de acceso diferentes para los usuarios del dispositivo: 

Nivel uno 
Cuando el dispositivo se fija al nivel uno, el usuario tiene acceso sin restricciones a las funciones del 
procesador de sistema, salvo dos funciones que siempre están protegidas por la contraseña del 
administrador: 
1. Fijación del nivel de seguridad del dispositivo. 
2. Cambio de la contraseña del administrador. 

Nivel dos 
Cuando se fija el dispositivo en nivel dos, el usuario tiene acceso limitado a las funciones, según lo define el 
administrador de seguridad. Se puede permitir el acceso a las funciones siguientes del procesador de 
sistema en nivel dos: 

�� Cambios en la configuración prefijada por medio de la computadora. 
�� Cambios en el encaminamiento de señales de la matriz mezcladora. 
�� Acceso para modificar los ajustes de los procesadores que no han sido bloqueados por el 

administrador (vea la sección Seguridad de procesadores individuales en la página 92 para 
más información). 

Nivel tres 
Este nivel permite acceso de sólo lectura a los ajustes del procesador de sistema para la configuración en 
vivo actual. 

Nota: La función de seguridad sólo afecta el acceso a través del software. No restringe el 
control por dispositivo externo a través de los pines de control o de MIDI. 

Establecimiento de seguridad del dispositivo 
El establecimiento del nivel de seguridad debe ser la fase final de la configuración del dispositivo. Hay dos pasos 
principales para configurar la seguridad del dispositivo, descritos a continuación. 

Establezca una contraseña 
Antes de poder fijar el nivel de acceso de los usuarios en el 
dispositivo, es necesario establecer una contraseña que proteja su 
nivel de acceso como administrador de seguridad. 

Para crear una contraseña: 
1. Ponga el dispositivo en modo en vivo. 
2. Seleccione [Security>Set Password] del menú principal. 
3. El cuadro de diálogo de crear contraseña aparece. 
4. Escriba una contraseña en el campo [Administrator 

Password]. 
5. Pulse la tecla TAB para avanzar al campo [Confirm Password] 

y vuelva a escribir la contraseña. 
6. Llene los campos [Administrator Name] (nombre del 

administrador) y [Phone or Contact info] (teléfono o información de contacto). 

Nota: Todos los campos del cuadro de diálogo de crear contraseña tienen un límite de 
quince caracteres de largo. 

Figura 58 − Cuadro de diálogo para 
crear contraseña 
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Fije el nivel de acceso del usuario 
Una vez que se ha creado la contraseña, el dispositivo se fija 
automáticamente en el nivel uno de acceso del usuario. Si es 
necesario restringir el acceso al dispositivo, fije el nivel de 
acceso apropiado.  

Para fijar el nivel de acceso del usuario: 

1. Ponga el dispositivo en modo en vivo. 

2. Seleccione [Security>Level] del menú principal. 

3. Se visualiza el cuadro de diálogo de contraseña. 

4. Escriba la contraseña y haga clic en [OK]. 

5. Se visualiza el cuadro de diálogo de fijar nivel de 
seguridad. 

6. Haga clic en el botón que está a la izquierda del  
nivel deseado. 

7. Especifique las opciones personalizadas para el  
nivel dos, si corresponde. 

8. Haga clic en [OK]. 

Modificación de seguridad del dispositivo 
En caso tal que sea necesario hacer modificaciones a la configuración del 
dispositivo o a la seguridad después de haber restringido el acceso, primero es necesario volver a fijar el nivel de acceso 
de seguridad al nivel uno. 

Nota: Se requiere la contraseña del administrador para efectuar estas funciones. 

Cambio del nivel de acceso 
Siga las instrucciones anteriores para fijar el nivel de acceso. 

Cambio de la contraseña 
Para cambiar una contraseña existente: 

1. Ponga el dispositivo en modo en vivo. 
2. Seleccione [Security>Set Password] del menú principal. 
3. El cuadro de diálogo de fijar contraseña aparece. El 

cursor aparece en el campo [Old Password]. 
4. Introduzca la contraseña actual. 
5. Pulse la tecla TAB para avanzar al campo [Administrator 

Password] y escriba la contraseña nueva. 
6. Pulse la tecla TAB para avanzar al campo [Confirm 

Password] y vuelva a escribir la contraseña nueva. 
7. Llene los campos [Administrator Name] (nombre del 

administrador) y [Phone or Contact info] (teléfono o 
información de contacto), de ser necesario. 

8. Haga clic en [OK]. 

Nota: Todos los campos del cuadro de diálogo de fijar contraseña tienen un límite de quince 
caracteres de largo. 

Figura 59 − Cuadro de diálogo de 
contraseña requerida  

Figura 60 − Cuadro de diálogo para 
fijar nivel de seguridad  

Figura 61 − Cuadro de diálogo para 
fijar contraseña
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Eliminación de restricciones de seguridad 
Las funciones de seguridad del dispositivo pueden reposicionarse completamente a su estado de fábrica 
para permitir que otros individuos definan niveles de acceso de usuario. 

Para eliminar la protección por contraseña: 

1. Ponga el dispositivo en modo en vivo. 

2. Seleccione [Security>Set Password] del menú principal. 

3. Se despliega el cuadro de diálogo de fijar contraseña, ilustrado en la Figura 61 en la página anterior. 

4. Escriba la contraseña anterior en el campo [Old Password] y pulse INTR o haga clic en [OK]. 

5. Si se desea, borre el nombre del administrador y la información de contacto. 

6. Deje los campos [Administrator Password] y [Confirm Password] en blanco. 

7. Haga clic en [OK]. 

8. Se eliminan todas las restricciones de acceso. 

Nota: Los atributos de seguridad de los procesadores individuales permanecen 
inalterados, pero no se encuentran en efecto hasta que se ponga el dispositivo 
en nivel de acceso dos. 

Seguridad de procesadores individuales 
El sistema de seguridad de procesadores individuales bloquea el acceso a bloques procesadores específicos en una 
configuración prefijada. Se puede bloquear el acceso a un solo bloque, a bloques múltiples, o a todos los bloques de 
una configuración prefijada. Esta función se utiliza, por ejemplo, si se desea que el usuario pueda cambiar el ajuste 
de la ganancia, pero no los ajustes de un ecualizador paramétrico. Un procesador bloqueado puede abrirse para 
supervisar sus niveles o ver sus valores de ajuste. 

Si bien el nivel de acceso del usuario es específico según el dispositivo, el nivel de seguridad de los bloques 
procesadores individuales es específico para cada configuración prefijada. Además, el nivel de seguridad de cada 
procesador individual es un atributo independiente de cada bloque. Por ejemplo, se puede fijar el atributo de bloqueo 
de un bloque, y si se copia dicho bloque, el atributo de seguridad también se incluye en la copia. El atributo 
permanece sin importar si se está trabajando en modo de diseño o en modo en vivo. 

Para bloquear bloques procesadores: 

1. Ponga el dispositivo en modo en vivo. 

2. Verifique que el dispositivo ha sido fijado al nivel de seguridad 1. 

3. Haga clic sobre un bloque procesador para seleccionarlo, o mantenga pulsada la tecla CTRL y haga clic 
sobre varios bloques para seleccionarlos. 

4. Seleccione [Security>Level 2>Lock Selected] del menú principal. 

5. Aparece una marca de verificación junto a esta función del menú para indicar que el procesador 
seleccionado está bloqueado. 

6. Fije el dispositivo al nivel de acceso dos. 

Nota: Los bloques procesadores pueden bloquearse en modo de diseño, pero el bloqueo no 
se hace efectivo hasta que se guarde el archivo de escena en el dispositivo como 
configuración prefijada, y se fije la seguridad del dispositivo al nivel de acceso dos. 
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IMPRESIÓN DE INFORMES___________________________________  
El software del P4800 le permite imprimir informes que documentan todas las configuraciones prefijadas y valores de 
ajuste almacenados en el dispositivo. Estos informes han sido diseñados para los usos siguientes. 

1. Para documentar la configuración del dispositivo para el cliente y el usuario. 
2. Para proporcionar copias impresas de respaldo que permitan reconstruir la configuración del dispositivo, 

de ser necesario. 

Nota: Los informes se envían directamente a una impresora, en lugar de a un archivo, por lo 
cual es necesario estar conectado a una impresora para poder usar esta función. 

Para imprimir informes con el P4800: 
1. Seleccione [File>Print] del menú principal. 
2. El cuadro de diálogo de elegir informe aparece. 
3. Haga clic para seleccionar el tipo de informe que desea 

imprimir. 
4. Aparece un cuadro de diálogo que corresponde al tipo de 

informe elegido. 
5. Especifique la información que desea incluir en el informe, 

según se describe en la sección siguiente. 
6. Haga clic en [OK]. 
7. Se visualiza el cuadro de diálogo de Imprimir de Windows. 

Informes del P4800 
Información del dispositivo 

La información del dispositivo indica toda la información a nivel del dispositivo, salvo la contraseña de 
seguridad. Cuando se abre el cuadro de diálogo de información del dispositivo, seleccione el dispositivo 
para el cual se desea imprimir el reporte de la lista ofrecida por el menú [Device]. Introduzca la información 
pertinente al dispositivo seleccionado y haga clic en [OK]. La información que se introduce aquí aparece sólo 
en el reporte impreso; no se almacena para uso futuro. Vea la página 95 para una muestra de este informe. 

Figura 62 − Cuadro de diálogo para 
seleccionar informe  

Figura 63 − Cuadro de diálogo de 
información del dispositivo  
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Información de configuraciones prefijadas e información de configuración 
prefijada actual 

El informe de configuraciones prefijadas contiene los detalles de una configuración prefijada específica que 
ha sido almacenada en el dispositivo. Cuando se abre el cuadro de diálogo de información de 
configuraciones prefijadas, seleccione el dispositivo para el cual se desea imprimir el reporte de la lista 
ofrecida por el menú [Device]. Después seleccione la configuración prefijada para la cual se desea imprimir 
un informe y haga clic en [OK]. Vea las páginas 96 y 97 para una muestra de este informe. 

El informe de configuración prefijada actual es idéntico. Incluye los detalles de la configuración prefijada o 
escena desplegada en la pantalla en el momento. 

Información de procesadores 
El informe de procesadores contiene los valores de ajuste de uno o más bloques procesadores. El cuadro 
de diálogo de información de procesadores muestra una lista de todos los procesadores fijos y opcionales 
de la escena o configuración prefijada actual. Haga clic en un procesador para seleccionarlo, o mantenga 
pulsada la tecla MAYÚS y haga clic en varios procesadores para seleccionarlos, y luego haga clic en [OK]. 
Vea la página 98 para una muestra de este informe. 

Figura 64 − Cuadro de diálogo de información 
de configuraciones prefijadas  

Figura 65 −Cuadro de diálogo de información 
prefijada actual 

Figura 66 − Cuadro de diálogo de 
información de procesadores 
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Muestras de informes 
DEVICE INFORMATION 

Installation Information: 

Location: 4325 W. Division, Chicago 

Client: Sacred Heart School 

Designer: Bob Reiling 

Installer: RC Communications 

System Description: 

Main Gymnasium System Processor 

 

Hardware Information: 

ShureLink Device ID: 15 

Device Name: Gymnasium 

 

Control Input Pin Configuration: 
Pin-1: Encoding Type: Priority, Mapped to preset: 1 
Pin-2: Encoding Type: Priority, Mapped to preset: 2 
Pin-3: Encoding Type: Priority, Mapped to preset: 3 
Pin-4: Encoding Type: Priority, Mapped to preset: 4 
Pin-5: Switch 
Pin-6: Potentiometer 
Pin-7: Potentiometer 
Pin-8: NONE [DISABLED] 
 

Control Output Pin Configuration: 
Pin-1: Encoding Type: One to One, Mapped to preset: 1 
Pin-2: Encoding Type: One to One, Mapped to preset: 2 
Pin-3: Encoding Type: One to One, Mapped to preset: 3 
Pin-4: Encoding Type: One to One, Mapped to preset: 4 
Pin-5: Logic Control 
Pin-6: Logic Control [DISABLED] 
Pin-7: Logic Control [DISABLED] 
Pin-8: Logic Control [DISABLED]  
 

Preset Information: 

Total Presets: 4 

 Preset 1 Concert 

 Preset 2 Assembly 

 Preset 3 Game 

 Preset 4 Dance 

 

1 of 1 March 29, 2001, 11:11AM
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PRESET INFORMATION: 

 

Preset ID: 2 

Preset Name: Assembly 

Descripiton: Preliminary tuning. 

 

 
 

 
Control Input Pin Mapping: 
Pin-1: Reserved for Preset Control - See Device Information 
Pin-2: Reserved for Preset Control - See Device Information 
Pin-3: Reserved for Preset Control - See Device Information 
Pin-4: Reserved for Preset Control - See Device Information 
Pin-5: Mutes: Input: 2 
Pin-6: Gains: Input: 1 2 , Gain Range: -30.0 to 30.0 dB 
Pin-7: Gains: Output: 1 2 3 4 5 6 7 8 , Gain Range: -30.0 to 30.0 dB 
Pin-8: N/A 

 
Control Output Pin Mapping: 
Pin-1: Reserved for Preset Display - See Device Information 
Pin-2: Reserved for Preset Display - See Device Information 
Pin-3: Reserved for Preset Display - See Device Information 
Pin-4: Reserved for Preset Display - See Device Information 
Pin-5: Mutes: Input: 2 
Pin-6: Mutes: N/A 
Pin-7: Mutes: N/A 
Pin-8: Mutes: N/A 
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Drag and Drop Processors: 
 

Input-1, Slot-1, Processor: PEQ 10CS Input-3, Slot-1, Processor: N/A  
Input-1, Slot-2, Processor: N/A  Input-3, Slot-2, Processor: N/A  
Input-1, Slot-3, Processor: N/A  Input-3, Slot-3, Processor: N/A  
Input-1, Slot-4, Processor: N/A  Input-3, Slot-4, Processor: N/A  
Input-1, Slot-5, Processor: SFT LIM  Input-3, Slot-5, Processor: N/A 
 

Input-2, Slot-1, Processor: PEQ 10CS Input-4, Slot-1, Processor: N/A  
Input-2, Slot-2, Processor: GEQ30  Input-4, Slot-2, Processor: N/A  
Input-2, Slot-3, Processor: N/A  Input-4, Slot-3, Processor: N/A  
Input-2, Slot-4, Processor: N/A  Input-4, Slot-4, Processor: N/A  
Input-2, Slot-5, Processor: N/A  Input-4, Slot-5, Processor: N/A 
 

Output-1, Slot-1, Processor: PEQ 10CS Output 5, Slot-1, Processor: PEQ 5CS 
Output-1, Slot-2, Processor: CUT/SHELF  Output-5, Slot-2, Processor: N/A  
Output-1, Slot-3, Processor: N/A  Output-5, Slot-3, Processor: N/A  
Output-1, Slot-4, Processor: N/A  Output-5, Slot-4, Processor: N/A  
Output-1, Slot-5, Processor: N/A  Output-5, Slot-5, Processor: N/A 
Output-1, Slot-6, Processor: N/A  Output-5, Slot-6, Processor: DLY 150ms 
 

Output-2, Slot-1, Processor: PEQ 5CS Output-6, Slot-1, Processor: PEQ 5CS  
Output-2, Slot-2, Processor: N/A  Output-6, Slot-2, Processor: N/A  
Output-2, Slot-3, Processor: N/A  Output-6, Slot-3, Processor: N/A  
Output-2, Slot-4, Processor: N/A  Output-6, Slot-4, Processor: N/A  
Output-2, Slot-5, Processor: N/A  Output-6, Slot-5, Processor: N/A 
Output-2, Slot-6, Processor: N/A  Output-6, Slot-6, Processor: DLY 150ms 
 

Output-3, Slot-1, Processor: PEQ 5CS Output-7, Slot-1, Processor: N/A  
Output-3, Slot-2, Processor: N/A  Output-7, Slot-2, Processor: N/A  
Output-3, Slot-3, Processor: N/A  Output-7, Slot-3, Processor: AGC  
Output-3, Slot-4, Processor: N/A  Output-7, Slot-4, Processor: SFT LIM  
Output-3, Slot-5, Processor: N/A  Output-7, Slot-5, Processor: N/A 
Output-3, Slot-6, Processor: N/A  Output-7, Slot-6, Processor: DLY 150ms 
 

Output-4, Slot-1, Processor: PEQ 5CS Output-8, Slot-1, Processor: PEQ 3CS 
Output-4, Slot-2, Processor: N/A  Output-8, Slot-2, Processor: N/A  
Output-4, Slot-3, Processor: N/A  Output-8, Slot-3, Processor: AGC  
Output-4, Slot-4, Processor: N/A  Output-8, Slot-4, Processor: LIM  
Output-4, Slot-5, Processor: N/A  Output-8, Slot-5, Processor: N/A 
Output-4, Slot-6, Processor: DLY 150ms  Output-8, Slot-6, Processor: DLY 150ms 
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PROCESSOR INFORMATION: 
 
Input Gain Block 
Security: Unlocked 
Input-1:, Name: Main input, Operating Level: +4 dBu, Polarity: + , Gain: -4.5dB, Pad: On, Mute: Off, Link Group: N/A 
Input-2:, Name: Foyer, Operating Level: +4 dBu, Polarity: + , Gain: 8.5dB, Pad: On, Mute: Off, Link Group: N/A 
Input-3:, Name: Record AUX, Operating Level: +4 dBu, Polarity: + , Gain: 0.0dB, Pad: On, Mute: On, Link Group: N/A 
Input-4:, Name: Not used, Operating Level: +4 dBu, Polarity: + , Gain: -4.5dB, Pad: On, Mute: Off, Link Group: N/A 
 
 
 
 
 
 

Input-1, Slot-1, Processor: PEQ 10CS 
Name: PEQ with CS, Link Group: N/A, Security: Unlocked 
Bypass: Off 
Filter: L, Type: Shelf, Freq: 0.0kHz, Gain: 0.0dB, Width(oct): 
Filter: H, Type: Shelf, Freq: 20.0kHz, Gain: 0.0dB, Width(oct): 
Filter: 3, Freq: 0.1kHz, Gain: -2.0dB, Width(oct): 2/3  
Filter: 4, Freq: 2.2kHz, Gain: -6.0dB, Width(oct): 1/10 
Filter: 5, Freq: 0.3kHz, Gain: -4.5dB, Width(oct): 1/3 
Filter: 6, Freq: 5.0kHz, Gain: 2.5dB, Width(oct): 1 
Filter: 7, Freq: 2.7kHz, Gain: -3.0dB, Width(oct): 1/2  
  
 
 
 
  
  

Input-1, Slot-5, Processor: SFT LIM 
Name: Soft Limiter, Link Group: N/A, Security: Unlocked 
Bypass: Off 
Threshold: 9.5 VU, Attack: 2ms, Ratio: 100.0, Decay: 50ms 
Input Gain: 0.00, Output Gain: 0.00 
Knee Soft 
 
 
 
 
 
 

Input-2, Slot-1, Processor: PEQ 10CS 
Name: PEQ with CS, Link Group: N/A, Security: Unlocked 
Bypass: Off 
Filter: L, Type: Shelf, Freq: 0.1kHz, Gain: -18.5dB, Width(oct):  
Filter: H, Type: Shelf, Freq: 10.9kHz, Gain: -18.5dB, Width(oct):  
Filter: 3, Freq: 4.3kHz, Gain: -9.0dB, Width(oct): 2/3  
Filter: 4, Freq: 0.7kHz, Gain: 4.5dB, Width(oct): 1 
Filter: 5, Freq: 0.2kHz, Gain: -9.0dB, Width(oct): 1/6 
Filter: 6, Freq: 0.1kHz, Gain: -6dB, Width(oct): 1/3 
Filter: 7, Freq: 6.8kHz, Gain: -6.0dB, Width(oct): 1/6  
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APÉNDICE A: TABLAS DE CODIFICACIÓN BINARIA ______________  
Las tablas siguientes ilustran la codificación binaria para las configuraciones prefijadas del procesador de sistema. 
Utilice este sistema de codificación en los pines de las entradas de control para seleccionar la configuración prefijada 
deseada en el dispositivo. El procesador de sistema indica la configuración prefijada actualmente seleccionada en 
sus pines de salida lógica utilizando este mismo sistema de codificación. 

Codificación binaria con un pin 

 

 

 

Codificación binaria con dos pines 

# DE CONFIGURACION 
PREFIJADA PIN 1 PIN 2 

1 O O 

2 O I 

3 I O 

4 I I 

 

 

Codificación binaria con tres pines 

# DE CONFIGURACION 
PREFIJADA PIN 1 PIN 2 PIN 3 

1 O O O 

2 O O I 

3 O I O 

4 O I I 

5 I O O 

6 I O I 

7 I I O 

8 I I I 

 

# DE CONFIGURACION 
PREFIJADA PIN 1 

1 O 

2 I 
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Codificación binaria con cuatro pines 

 # DE CONFIGURACION 
PREFIJADA PIN 1 PIN 2 PIN 3 PIN 4 

1 O O O O 

2 O O O I 

3 O O I O 

4 O O I I 

5 O I O O 

6 O I O I 

7 O I I O 

8 O I I I 

9 I O O O 

10 I O O I 

11 I O I O 

12 I O I I 

13 I I O O 

14 I I O I 

15 I I I O 

16 I I I I 
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Codificación binaria con cinco pines 

# DE CINFIGURACION 
PREFIJADA PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 

1 O O O O O 

2 O O O O I 

3 O O O I O 

4 O O O I I 

5 O O I O O 

6 O O I O I 

7 O O I I O 

8 O O I I I 

9 O I O O O 

10 O I O O I 

11 O I O I O 

12 O I O I I 

13 O I I O O 

14 O I I O I 

15 O I I I O 

16 O I I I I 

17 I O O O O 

18 I O O O I 

19 I O O I O 

20 I O O I I 

21 I O I O O 

22 I O I O I 

23 I O I I O 

24 I O I I I 

25 I I O O O 

26 I I O O I 

27 I I O I O 

28 I I O I I 

29 I I I O O 

30 I I I O I 

31 I I I I O 

32 I I I I I 
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Codificación binaria con seis pines 

# DE CONFIGURACION 
PREFIJADA PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 

1 O O O O O O 

2 O O O O O I 

3 O O O O I O 

4 O O O O I I 

5 O O O I O O 

6 O O O I O I 

7 O O O I I O 

8 O O O I I I 

9 O O I O O O 

10 O O I O O I 

11 O O I O I O 

12 O O I O I I 

13 O O I I O O 

14 O O I I O I 

15 O O I I I O 

16 O O I I I I 

17 O I O O O O 

18 O I O O O I 

19 O I O O I O 

20 O I O O I I 

21 O I O I O O 

22 O I O I O I 

23 O I O I I O 

24 O I O I I I 

25 O I I O O O 

26 O I I O O I 

27 O I I O I O 

28 O I I O I I 

29 O I I I O O 

30 O I I I O I 

31 O I I I I O 

32 O I I I I I 

33 I O O O O O 

34 I O O O O I 

35 I O O O I O 

36 I O O O I I 

37 I O O I O O 

38 I O O I O I 

39 I O O I I O 

40 I O O I I I 

41 I O I O O O 

42 I O I O O I 

43 I O I O I O 
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# DE CONFIGURACION 
PREFIJADA PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 

44 I O I O I I 

45 I O I I O O 

46 I O I I O I 

47 I O I I I O 

48 I O I I I I 

49 I I O O O O 

50 I I O O O I 

51 I I O O I O 

52 I I O O I I 

53 I I O I O O 

54 I I O I O I 

55 I I O I I O 

56 I I O I I I 

57 I I I O O O 

58 I I I O O I 

59 I I I O I O 

60 I I I O I I 

61 I I I I O O 

62 I I I I O I 

63 I I I I I O 

64 I I I I I I 
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Codificación binaria con siete pines 
# DE CONFIGURACION 

PREFIJADA PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7 

1 O O O O O O O 

2 O O O O O O I 

3 O O O O O I O 

4 O O O O O I I 

5 O O O O I O O 

6 O O O O I O I 

7 O O O O I I O 

8 O O O O I I I 

9 O O O I O O O 

10 O O O I O O I 

11 O O O I O I O 

12 O O O I O I I 

13 O O O I I O O 

14 O O O I I O I 

15 O O O I I I O 

16 O O O I I I I 

17 O O I O O O O 

18 O O I O O O I 

19 O O I O O I O 

20 O O I O O I I 

21 O O I O I O O 

22 O O I O I O I 

23 O O I O I I O 

24 O O I O I I I 

25 O O I I O O O 

26 O O I I O O I 

27 O O I I O I O 

28 O O I I O I I 

29 O O I I I O O 

30 O O I I I O I 

31 O O I I I I O 

32 O O I I I I I 

33 O I O O O O O 

34 O I O O O O I 

35 O I O O O I O 

36 O I O O O I I 

37 O I O O I O O 

38 O I O O I O I 

39 O I O O I I O 

40 O I O O I I I 

41 O I O I O O O 

42 O I O I O O I 

43 O I O I O I O 

44 O I O I O I I 

45 O I O I I O O 

46 O I O I I O I 



Apéndice A 

0 = Pin desconectado de tierra   1 = Pin puesto a tierra    

Guía de software de procesador de sistema SHURE P4800 Página 105 de 112 

# DE CONFIGURACION 
PREFIJADA PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7 

47 O I O I I I O 

48 O I O I I I I 

49 O I I O O O O 

50 O I I O O O I 

51 O I I O O I O 

52 O I I O O I I 

53 O I I O I O O 

54 O I I O I O I 

55 O I I O I I O 

56 O I I O I I I 

57 O I I I O O O 

58 O I I I O O I 

59 O I I I O I O 

60 O I I I O I I 

61 O I I I I O O 

62 O I I I I O I 

63 O I I I I I O 

64 O I I I I I I 

65 I O O O O O O 

66 I O O O O O I 

67 I O O O O I O 

68 I O O O O I I 

69 I O O O I O O 

70 I O O O I O I 

71 I O O O I I O 

72 I O O O I I I 

73 I O O I O O O 

74 I O O I O O I 

75 I O O I O I O 

76 I O O I O I I 

77 I O O I I O O 

78 I O O I I O I 

79 I O O I I I O 

80 I O O I I I I 

81 I O I O O O O 

82 I O I O O O I 

83 I O I O O I O 

84 I O I O O I I 

85 I O I O I O O 

86 I O I O I O I 

87 I O I O I I O 

88 I O I O I I I 

89 I O I I O O O 

90 I O I I O O I 

91 I O I I O I O 

92 I O I I O I I 

93 I O I I I O O 

94 I O I I I O I 
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# DE CONFIGURACION 
PREFIJADA PIN 1 PIN 2 PIN 3 PIN 4 PIN 5 PIN 6 PIN 7 

95 I O I I I I O 

96 I O I I I I I 

97 I I O O O O O 

98 I I O O O O I 

99 I I O O O I O 

100 I I O O O I I 

101 I I O O I O O 

102 I I O O I O I 

103 I I O O I I O 

104 I I O O I I I 

105 I I O I O O O 

106 I I O I O O I 

107 I I O I O I O 

108 I I O I O I I 

109 I I O I I O O 

110 I I O I I O I 

111 I I O I I I O 

112 I I O I I I I 

113 I I I O O O O 

114 I I I O O O I 

115 I I I O O I O 

116 I I I O O I I 

117 I I I O I O O 

118 I I I O I O I 

119 I I I O I I O 

120 I I I O I I I 

121 I I I I O O O 

122 I I I I O O I 

123 I I I I O I O 

124 I I I I O I I 

125 I I I I I O O 

126 I I I I I O I 

127 I I I I I I O 

128 I I I I I I I 
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APÉNDICE B: UTILIZACIÓN DE RECURSOS DE DSP 
POR CADA PROCESADOR ___________________________________  
La tabla siguiente indica el porcentaje de recursos de DSP que cada procesador utiliza. Los recursos de DSP se 
determinan según: 

�� La combinación de procesadores que se está utilizando 
�� La posición de los procesadores en el diagrama de flujo de señales 

La primera columna de [% de DSP] indica el porcentaje de recursos de DSP que cada procesador utiliza en un 
P4800 cuyo número de serie empieza con la letra N o una mayor. 

La segunda columna de [% de DSP] indica el porcentaje de recursos de DSP que cada procesador utiliza en un 
P4800 cuyo número de serie empieza con las letras L o M. 

Nota: No es posible calcular con precisión la cantidad de recursos de DSP que una configuración utiliza con sólo 
sumar los porcentajes indicados en esta tabla. 

CATEGORÍA No. DEL 
BLOQUE DESCRIPCIÓN 

% de DSP, 
número de 
serie N o 

mayor 

%de DSP, 
número de 

serie 
L o M 

GEQ 10 Ecualizador gráfico de 10 bandas 3,5 3,9 Ecualizador 
gráfico GEQ 30 Ecualizador gráfico de 30 bandas 7,7 8,5 

PEQ 3 Ecualizador paramétrico de 3 bandas 2,1 2,3 
PEQ 5 Ecualizador paramétrico de 5 bandas 2,5 2,8 
PEQ 7 Ecualizador paramétrico de 7 bandas 2,9 3,3 
PEQ 10 Ecualizador paramétrico de 10 bandas 3,5 3,9 
PEQ 3 + C/S Ecualizador paramétrico de 3 bandas con filtros atenuadores/limitadores 2,5 2,8 
PEQ 5 + C/S Ecualizador paramétrico de 5 bandas con filtros atenuadores/limitadores 2,9 3,3 
PEQ 7 + C/S Ecualizador paramétrico de 7 bandas con filtros atenuadores/limitadores 3,3 3,7 
PEQ 10 + C/S Ecualizador paramétrico de 10 bandas con filtros atenuadores/limitadores 4,0 4,4 

Ecualizador 
paramétrico 

CUT/SHELF Filtros atenuadores/limitadores de frecuencias altas y bajas 2,7 3,0 
DFR5 Reductor digital de realimentación de 5 bandas 11,1 12,4 Reductor de 

realimentación DFR10 Reductor digital de realimentación de 10 bandas 12,4 13,8 
DLY 5ms Retardo de 5 ms máximo 3,3 3,7 
DLY 150ms Retardo de 150 ms máximo 3,3 3,7 
DLY 500ms Retardo de 500 ms máximo 3,3 3,7 

Retardo 

DLY 2s Retardo de 2 segundos máximo 3,3 3,7 
COMP Compresor 2,1 2,3 
SFT COMP Compresor de articulación suave opcional 2,3 2,6 
ST COMP Compresor estereofónico 4,2 4,6 
SFT ST COMP Compresor estereofónico de articulación suave opcional 5,6 6,2 
LIM Limitador 2,1 2,3 
SFT LIM Limitador de articulación suave opcional 2,3 2,6 
ST LIM Limitador estereofónico 4,2 4,6 
SFT ST LIM Limitador estereofónico de articulación suave opcional 5,6 6,2 
AGC Control automático de ganancia 2,9 3,2 
GATE Compuerta 2,4 2,2 

Rango dinámico 

DOWN EXP Expansor de atenuación 2,4 2,7 
XOVER 2 Red de cruce de 2 vías 2,8 3,2 
XOVER 3 Red de cruce de 3 vías 3,5 3,9 
XOVER 4 Red de cruce de 4 vías 3,7 4,1 
XOVER 5 Red de cruce de 5 vías 4,7 5,2 
SPLIT 2 Bifurcador de 2 vías 5,7 6,4 
SPLIT 3 Bifurcador de 3 vías 6,7 7,5 
SPLIT 4 Bifurcador de 4 vías 0,9 1,0 

 Red de cruce 

SPLIT 5 Bifurcador de 5 vías 1,0 1,1 
   1,2 1,3 
   1,4 1,5 
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APÉNDICE C: EXTENSIONES DE ARCHIVOS ____________________  
La tabla siguiente indica las extensiones de los nombres de los archivos de diferentes tipos creados por el 
software del procesador de sistema. 

Extensión de archivo Fuente 
.agc Control automático de ganancia 
.backup Respaldo de todo el dispositivo 
.cdk Ganancias de entrada y salida 
.comp Compresor 
.cutshf Filtros atenuadores/limitadores de frecuencias altas y bajas 
.dfr10 Reductor digital de realimentación de 10 bandas 
.dfr5 Reductor digital de realimentación de 5 bandas 
.dly150ms Retardo de 150 ms máximo 
.dly2s Retardo de 2 segundos máximo 
.dly500ms Retardo de 500 ms máximo 
.dly5ms Retardo de 5 ms máximo 
.duck Atenuador automático 
.exp Expansor de atenuación 
.gate Compuerta 
.geq10 Ecualizador gráfico de 10 bandas 
.geq30 Ecualizador gráfico de 30 bandas 
.lim Limitador 
.mix Matriz mezcladora 
.peq10 Ecualizador paramétrico de 10 bandas 
peaklim Limitador de tope de picos 
.peq10cs Ecualizador paramétrico de 10 bandas con filtros atenuadores/limitadores 
.peq3 Ecualizador paramétrico de 3 bandas 
.peq3cs Ecualizador paramétrico de 3 bandas con filtros atenuadores/limitadores 
.peq5 Ecualizador paramétrico de 5 bandas 
.peq5cs Ecualizador paramétrico de 5 bandas con filtros atenuadores/limitadores 
.peq7 Ecualizador paramétrico de 7 bandas 
.peq7cs Ecualizador paramétrico de 7 bandas con filtros atenuadores/limitadores 
.pin Configuración de pines 
.scn Archivo de escena 
.softcomp Compresor de articulación suave opcional 
.softlim Limitador de articulación suave opcional 
.softstcomp Compresor estereofónico de articulación suave opcional 
.softstlim Limitador estereofónico de articulación suave opcional 
.stcomp Compresor estereofónico 
.stlim Limitador estereofónico 
.xover2 Red de cruce de 2 vías 
.xover3 Red de cruce de 3 vías 
.xover4 Red de cruce de 4 vías 
.xover5 Red de cruce de 5 vías 
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APÉNDICE D: GUÍA PARA LA LOCALIZACIÓN DE AVERÍAS _______  

Falla de comunicaciones entre la computadora y el P4800: 
Los mensajes siguientes se despliegan en la pantalla cuando el software P4800 pierde comunicaciones con 
el dispositivo.  

“COM(port) is already in use or does not exist...” 
Este mensaje aparece bajo las condiciones siguientes: 

• Existe otro programa que está utilizando el puerto COM especificado. 

Si el puerto COM está siendo utilizado por otro programa, si se sale de dicho programa, se resuelve el 
problema. Un ejemplo de programa que mantiene un puerto COM ocupado es HotSync Manager y otros 
programas similares utilizados para sincronizar la computadora y dispositivos de mano tales como el Palm 
Pilot™. Puede ser difícil cerrar estos programas puesto que generalmente funcionan en el fondo. Consulte el 
manual del usuario del programa. Las computadoras de escritorio generalmente tienen más de un puerto 
serial físico en su equipo. En tal caso, si se selecciona un puerto COM diferente y se conecta el cable de 
comunicaciones del P4800 a un puerto serial diferente, se puede resolver el problema. 

• El puerto serial de la computadora ha sido desactivado. 

Ejecute el programa de configuración de la BIOS para activar el puerto serial. Al hacerlo, observe los valores 
de ajuste del puerto serial (IRQ y dirección de E/S) y verifique que Windows tenga un puerto COM 
configurado con esos mismos valores. Después, elija ese puerto COM con el software P4800. 

“Network not ready...” 
Esto indica que el software del P4800 abrió el puerto COM con éxito, pero no halló ningún dispositivo 
conectado al mismo. Verifique que el P4800 se encuentre encendido y que haya terminado su secuencia de 
arranque antes de intentar comunicarse con la máquina. Si la computadora tiene más de un puerto COM, 
verifique que se haya conectado el cable de la red al mismo puerto COM seleccionado en el cuadro de diálogo 
"Select COM Port" (selección de puerto COM). 

Verifique que se está utilizando un cable de comunicaciones DB9 estándar y que está bien conectado a 
tanto la computadora como al P4800. Además, cerciórese que se ha conectado el cable al puerto correcto 
del dispositivo: el puerto utilizado más frecuentemente es el RS232. 

“No devices detected.” 
El software del P4800 ha detectado un dispositivo distinto al P4800 conectado al puerto COM seleccionado. 
Este dispositivo puede ser un módem u otro dispositivo de comunicaciones en serie, tal como un DFR11EQ. 
Si se selecciona el puerto COM al cual se ha conectado el P4800, se resuelve este problema. 

El panel delantero del P4800 muestra un patrón estático con sus LED: 
El panel delantero puede mostrar un patrón de LED extraño cuando ha ocurrido un error interno en el 
P4800, como en los ejemplos siguientes: 

• La corriente de alimentación del pin de control (5 V, 100 mA máx.) ha excedido sus niveles máximos o está 
en cortocircuito a tierra – Desconecte todas las conexiones de los pines de control y desconecte y vuelva a 
conectar la alimentación del dispositivo. 

• Hay un archivo de escena dañado en la memoria del dispositivo, el cual debe ser eliminado. Si el problema 
continúa después de haber seguido las instrucciones dadas a continuación, comuníquese con el 
Applications Group de Shure. 

Para eliminar una configuración prefijada dañada: 
1. Abra el software del P4800, active el modo de diseño y seleccione la función [File>Delete Preset]. 
2. Elimine todas las configuraciones prefijadas que se visualicen como “Corrupted”. Si la configuración 

prefijada activa resulta ser la causante del problema, haga clic en [Cancel]. 
3. Seleccione [File>New] para generar una escena en blanco, y luego seleccione [File>Store Preset] 

para sobreescribir la configuración prefijada activa con esta escena en blanco. 

• El proceso de actualización del firmware ha sido interrumpido. Esta condición puede resolverse siguiendo las 
instrucciones dadas a continuación. Si el problema continúa, comuníquese con el Applications Group de Shure. 
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Para completar la actualización del firmware: 
1. Apague el dispositivo y vuélvalo a encender. 
2. Del menú [File], seleccione [Firmware Upgrade]. 
3. Cuando el software le presenta el indicativo de actualizar el código, haga clic en [Continue]. 

No es posible seleccionar configuraciones prefijadas desde la computadora: 
• Revise el nivel de seguridad del dispositivo. Para poder seleccionar configuraciones prefijadas desde la 

computadora, el dispositivo deberá estar fijado en nivel de seguridad 1, o nivel personalizado 2. Para más 
información, consulte la sección Seguridad en la página 90. 

• Si se ha activado la función de cambio de configuraciones prefijadas con pines de control, la unidad no 
responde a comandos de cambiar de configuración del software. Para resolver este problema, desactive los 
pines de control de cambio de configuraciones prefijadas en la ventana de pines de control. Para más 
información, consulte la sección Bloque de control de configuraciones prefijadas en la página 83. 

El software cambia inesperadamente de modo en vivo a modo de diseño: 
Cuando se trabaja en modo en vivo y se usan dispositivos conectados a las entradas de control para 
cambiar de una configuración prefijada a otra, silenciar canales, o ajustar el volumen, el software puede 
cambiar a modo de diseño. Esto constituye funcionamiento normal. La supervisión del control por medios 
externos no es una función incluida en la versión actual del software. Esta situación tiene menor 
probabilidad de ocurrir si se usan computadoras más veloces. 
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APÉNDICE E: ACTUALIZACIONES DEL FIRMWARE ______________  
Cuando se conecta a un P4800 por primera vez, posiblemente se reciba un indicativo de actualización del 
firmware. Si se recibe este indicativo, es necesario efectuar una actualización antes de poder utilizar las 
características nuevas y mejoras del software del procesador de sistema P4800 versión 4.0. 

Antes de continuar con la actualización, es necesario desconectar todos los cables de Shure Link y todos los 
dispositivos externos de control. También se deben cerrar todos los demás programas en ejecución. 
Conéctese directamente al P4800 utilizando un cable tipo RS-232. 

Entonces se puede hacer una copia de respaldo de todos los datos guardados en el P4800 haciendo clic en 
el botón [Backup Device] y siguiendo las instrucciones que se indican. Una vez terminada la copia de 
respaldo, se inicia la actualización del firmware. ¡No interrumpa la actualización luego que la misma haya 
comenzado! 

Nota: Si la actualización del firmware falla por cualquier motivo (tal como un corte de energía o la 
desconexión de un cable), será necesario seleccionar la función [Firmware Upgrade] del menú [File] para 
volver a iniciar el proceso de actualización. 
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SIA-Smaart es una marca registrada de SIA Software Company, Inc., y Smaart y SmaartLive son marcas 
comerciales de SIA Software Company, Inc. TEF es una marca de Gold Line Connector, Inc. 

 
SHURE Incorporated Web Address: http://www.shure.com
222 Hartrey Avenue, Evanston, IL 60202-3696, U.S.A. 
Phone: 847-866-2200   Fax: 847-866-2279 
In Europe, Phone 49-7131-72140  Fax: 49-7131-721414 
In Asia, Phone: 852-2893-4290  Fax: 852-2893-4055 
Elswhere, Phone: 847-866-2200  Fax: 847-866-2585 


	CONTENIDO
	DESCRIPCIÓN GENERAL
	Estructura de este documento
	Características del procesador de sistema
	Interface de software con funciones de arrastrar y colocar
	Procesadores modulares de señales
	Control por dispositivo externo
	Seguridad

	Requisitos mínimos del software del P4800
	Modos de interface
	Modo de diseño
	Modo en vivo
	Modo de presentación preliminar

	La ventana principal
	La caja de herramientas de procesadores
	Mostrar y ocultar
	Botones de menús desplegables
	Bloques procesadores


	GUÍA PARA EL USO INICIAL
	Instalación del software
	Establecimiento de comunicaciones
	Configure los controles externos
	Confeccione una plantilla de flujo de señales
	Establezca los controles de seguridad

	CÓMO CREAR UNA CONFIGURACIÓN
	Configuración del flujo de señales
	Estructura de ganancia
	Silenciamiento de canales
	Rotulación de entradas y salidas
	Encaminamiento de señales
	Designación de una configuración prefijada o archivo de escena

	Configuración de procesadores
	Tipos de procesador
	Adición de procesadores
	Administración de recursos de DSP
	Copiar y pegar
	Eliminación de bloques
	Enlace
	Derivación


	CÓMO GUARDAR UNA CONFIGURACIÓN
	Archivos de escena
	Cómo guardar una escena nueva
	Uso del campo de descripción
	Modificación de archivos de escena

	Administración de configuraciones prefijadas
	Cómo guardar una configuración prefijada en el dispositivo
	Redesignación de una configuración prefijada
	Eliminación de una configuración prefijada

	Copias de respaldo del dispositivo

	CARACTERÍSTICAS DEL PROCESADOR
	Controles de nivel
	Selección
	Ajuste del nivel
	Cuadro de valores
	Botones de flecha

	Cómo guardar y recuperar valores de ajuste
	Designación de ventanas de procesador
	Imágenes instantáneas

	PROCESADORES FIJOS
	Ganancia de entrada
	Matriz mezcladora
	Ganancia de salida

	PROCESADORES MODULARES
	Control automático de ganancia/nivel (AGC)
	Función
	Características de la ventana de parámetros

	Compresor/Limitador
	Función
	Características de la ventana de parámetros
	Procesadores de articulación suave
	Procesadores estereofónicos

	Red de cruce/bifurcador
	Función
	Características de la ventana de parámetros

	Filtros atenuadores y limitadores
	Función
	Características de la ventana de parámetros

	Retardo
	Función
	Características de la ventana de parámetros

	Reductor digital de realimentación (DFR)
	Función
	Características de la ventana de parámetros
	Configuración básica del DFR
	Modo de retención
	Designación de filtros
	Filtros de factor Q alto vs. factor Q bajo
	Adición, modificación y eliminación de filtros
	Copiar y pegar

	Compuerta/expansor de atenuación
	Función
	Características de la ventana de parámetros

	Ecualizador gráfico
	Función
	Características de la ventana de parámetros

	Ecualizador paramétrico
	Función
	Características de la ventana de parámetros
	Trabajando con filtros

	Atenuador automático (Ducker)
	Función
	Características de la ventana de parámetros

	Importación de archivos ASCII del software SIA-Smaart? o�Gold Line TEF™
	Función
	Guardado de archivos Smaart en formato ASCII
	Guardado de archivos TEF en formato
	Características de la ventana de parámetros


	PINES DE CONTROL
	Descripción general de controles externos
	La ventana de pines de control
	Vistas de configuración
	Ajuste de parámetros de codificación de configuración prefijada
	Botón de más información
	Sección de configuración de pines
	Sección de designación de procesadores

	Configuración de pines
	Creación de una configuración de pines nueva
	Guardado de una configuración en la computadora
	Edición de una configuración existente de pines
	Tipos de codificación de configuraciones prefijadas
	Tipos de conexión

	Designación de procesador
	Creación de una plantilla de designación de procesadores
	Designación de una configuración prefijada existente o archivo de escena


	SEGURIDAD
	Establecimiento de seguridad del dispositivo
	Establezca una contraseña
	Fije el nivel de acceso del usuario

	Modificación de seguridad del dispositivo
	Cambio del nivel de acceso
	Cambio de la contraseña
	Eliminación de restricciones de seguridad

	Seguridad de procesadores individuales

	IMPRESIÓN DE INFORMES
	Informes del P4800
	Información del dispositivo
	Información de configuraciones prefijadas e información de configuración prefijada actual
	Información de procesadores

	Muestras de informes

	APÉNDICE A: TABLAS DE CODIFICACIÓN BINARIA
	Codificación binaria con un pin
	Codificación binaria con dos pines
	Codificación binaria con tres pines

	APÉNDICE B: UTILIZACIÓN DE RECURSOS DE DSP�POR CADA PROCESADOR
	APÉNDICE C: EXTENSIONES DE ARCHIVOS
	APÉNDICE D: GUÍA PARA LA LOCALIZACIÓN DE AVERÍAS
	
	Falla de comunicaciones entre la computadora y el P4800:
	El panel delantero del P4800 muestra un patrón estático con sus LED:
	No es posible seleccionar configuraciones prefijadas desde la computadora:
	El software cambia inesperadamente de modo en vivo a modo de diseño:


	APÉNDICE E: ACTUALIZACIONES DEL FIRMWARE

